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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.

Note: Use the handholds located on both sides of the printer to lift it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

Use only the telecommunications (RJ‑11) cord provided with this product or a 26 AWG or larger replacement when
connecting this product to the public switched telephone network.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.

Refer service or repairs, other than those described in the user documentation, to a service representative.

Safety information 6
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CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before proceeding.

CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

SAVE THESE INSTRUCTIONS.

Safety information 7
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Learning about the printer

Finding information about the printer
What are you looking for? Find it here

Initial setup instructions:

• Connecting the printer

• Installing the printer software

Setup documentation—The setup documentation came
with the printer and is also available at
http://support.lexmark.com.

Additional setup and instructions for using the printer:

• Selecting and storing paper and specialty media

• Loading paper

• Configuring printer settings

• Viewing and printing documents and photos

• Setting up and using the printer software

• Configuring the printer on a network

• Caring for and maintaining the printer

• Troubleshooting and solving problems

User's Guide and Quick Reference Guide—The guides may
be available on the Software and Documentation CD.

For more information, visit
http://support.lexmark.com.

Instructions for:

• Connecting the printer to an Ethernet network

• Troubleshooting printer connection problems

Networking Guide—Open the Software and
Documentation CD, and then navigate to:

Documentation > User’s Guide and other publications >
Networking Guide

Help using the printer software Windows or Mac Help—Open a printer software program
or application, and then click Help.

Click ?  to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.

Learning about the printer 8
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What are you looking for? Find it here

The latest supplemental information, updates, and customer
support:

• Documentation

• Driver downloads

• Live chat support

• E‑mail support

• Voice support

Lexmark support Web site—
http://support.lexmark.com

Note: Select your country or region, and then select
your product to view the appropriate support site.

Support telephone numbers and hours of operation for
your country or region can be found on the support Web
site or on the printed warranty that came with your
printer.

Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

• Machine Type number

• Serial number

• Date purchased

• Store where purchased

Warranty information Warranty information varies by country or region:

• In the U.S.—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

• In other countries and regions—See the printed
warranty that came with your printer.

Selecting a location for the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, then leave enough room for them also. It is important to:

• Set up the printer near a properly grounded and easily accessible electrical outlet.

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical Committee
156 standard.

• Provide a flat, sturdy, and stable surface.

• Keep the printer:

– Clean, dry, and free of dust.

– Away from stray staples and paper clips.

– Away from the direct airflow of air conditioners, heaters, or ventilators.

– Free from direct sunlight and humidity extremes.

• Observe the recommended temperatures and avoid fluctuations:

Ambient temperature 15.6 to 32.2°C (60 to 90°F)

Storage temperature -40 to 43°C (-40 to 110°F)

• Allow the following recommended amount of space around the printer for proper ventilation:
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1 Right side 304.8 mm (12 in.)

2 Front 508 mm (20 in.)

3 Left side 76.2 (3 in.)

4 Rear 101.6 mm (4 in.)

5 Top 291.7 mm (11.5 in.)

Printer configurations
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using multiple input options. If you purchased a
multifunction printer (MFP) that scans, copies, and faxes, then you may need additional furniture. For more
information, see www.lexmark.com/multifunctionprinters.
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Basic models

1 Printer control panel

2 Automatic document feeder (ADF)

3 Standard bin

4 Top door latch

5 Right side cover

6 Standard 250-sheet tray (Tray 1)

7 Manual feeder

8 Optional 650-sheet duo tray with integrated multipurpose feeder (Tray 2)

Understanding the basic functions of the scanner
• Make quick copies or set the printer to perform specific copy jobs.

• Scan documents and send them to your computer, an e-mail address, or an FTP destination.

• Scan documents and send them to another printer (PDF through an FTP).

Learning about the printer 11
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Using the ADF and scanner glass
Automatic document feeder (ADF) Scanner glass

ABC

Use the ADF for multiple‑page documents.

Note: The ADF scans only one side of the page.

Use the scanner glass for single‑page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Using the ADF
• Load the document into the ADF tray faceup, short edge first.

• Load up to 50 sheets of plain paper into the ADF tray.

• Scan sizes from 105 x 148 mm (4.1 x 5.8 inches) wide to 216 x 368 mm (8.5 x 14.5 inches) long.

• Scan media weights from 52 to 120 g/m2 (14–32 lb).

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF tray. Place these items on the scanner glass.

Using the scanner glass
When using the scanner glass:

• Place the document facedown on the scanner glass in the corner with the green arrow.

• Scan or copy documents up to 216 x 296.9 mm (8.5 x 11.69 inches).

• Copy books up to 12.7 mm (0.5 inch) thick.

Learning about the printer 12
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Using the printer control panel
1 2 3 4 5

678910

Use the To

1 Display • View printing, copying, e‑mailing, and scanning options.

• View printer status and error messages.

2 Select button • Select menu options.

• Save settings.

3 Arrow buttons Scroll through menus or settings on the display.

4 Keypad Enter numbers, letters, or symbols.

5 Sleep button Enable Sleep mode or Hibernate mode.

6 Cancel button Stop all printer activity.

7 Start button Start a job, depending on which mode is selected.

8 Back button Return to the previous screen.

9 Home button Go to the home screen.

10 Indicator light Check the status of the printer.

Understanding the colors of the Sleep button and indicator
lights
The colors of the Sleep button and indicator lights on the printer control panel signify a certain printer status or condition.

Indicator light Printer status

Off The printer is off or in Hibernate mode.

Blinking green The printer is warming up, processing data, or printing.

Solid green The printer is on, but idle.

Blinking red The printer requires user intervention.

Sleep button light Printer status

Off The printer is off, idle or in Ready state.

Solid amber The printer is in Sleep mode.

Blinking amber The printer is entering or waking from Hibernate mode.

Learning about the printer 13
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Sleep button light Printer status

Blinking amber for 0.1 second, then goes
completely off for 1.9 seconds in a slow,
pulsing pattern

The printer is in Hibernate mode.

Learning about the printer 14
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Additional printer setup

Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any controller board electronic components or connectors.

Available internal options
• Memory card

– DDR3 DIMM

• Flash memory

– Fonts

– Firmware

• Forms and Barcode

• Prescribe

• IPDS

Additional printer setup 15
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Accessing the controller board
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Access the controller board at the back of the printer.

Note: This task requires a flat‑head screwdriver.

2 Turn the screws counterclockwise to remove them.

3 Slightly open the controller board access cover, and then shift to the right to remove it.

4 Locate the appropriate connector on the controller board.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any controller board electronic components or
connectors.

Additional printer setup 16
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1 2

1 Memory card connector

2 Option card connector

5 Reattach the cover.

Additional printer setup 17
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6 Turn the screws clockwise to lock the cover.

Installing a memory card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 16.

2 Unpack the memory card.

Warning—Potential Damage: Do not touch the connection points along the edge of the card. Doing so may
cause damage.

Additional printer setup 18
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3 Align the notch (1) on the memory card with the ridge (2) on the connector.

2 1

4 Push the memory card straight into the connector, and then push the card toward the controller board wall until
it clicks into place.

1

2

5 Close the controller board access cover.

Additional printer setup 19
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Installing an optional card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have other devices attached to the printer, then turn them
off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static electricity.
Touch a metal surface on the printer before touching any controller board electronic components or connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 16.

2 Unpack the optional card.

Warning—Potential Damage: Avoid touching the connection points along the edge of the card.

3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

Additional printer setup 20
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4 Push the card firmly into place as shown in the illustration.

Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.

Note: The entire length of the connector on the card must touch and be flushed against the controller board.

5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, it may be necessary to manually add
the options in the printer driver to make them available for print jobs. For more information, see “Updating
available options in the printer driver” on page 25.

Installing hardware options

Order of installation
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

Additional printer setup 21
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CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

Install the printer and any optional tray in the following order:

• Optional 650‑sheet duo tray with integrated multipurpose feeder (Tray 2)

• Printer

Installing a 650‑sheet duo tray
The printer supports an optional 650‑sheet duo tray (Tray 2) with an integrated multipurpose feeder.

CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power cord
from the electrical outlet before continuing. If you have any other devices attached to the printer, then turn
them off as well, and unplug any cables going into the printer.

1 Unpack the optional 650‑sheet duo tray, and then remove all packing material and the dust cover.

2 Place the tray in the location chosen for the printer.

Additional printer setup 22
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3 Align the printer with the 650‑sheet duo tray, and then lower the printer into place.

4 Install the dust cover.

Note: When the printer software and any options are installed, it may be necessary to manually add the options in
the printer driver to make them available for print jobs. For more information, see “Updating available options in the
printer driver” on page 25.

Attaching cables
Connect the printer to the computer using a USB cable or to the network using an Ethernet cable.

Make sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer

• The appropriate Ethernet cable to the Ethernet port

Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the area shown
while actively printing. Loss of data or a malfunction can occur.

Additional printer setup 23
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Use the To

1 USB printer port Connect the printer to a computer.

2 Ethernet port Connect the printer to an Ethernet network.

3 USB wireless port Attach an optional wireless network adapter.

4 Security lock port Lock the system controller board.

5 Printer power cord socket Connect the printer to a properly grounded electrical outlet.

Setting up the printer software

Installing the printer software

Notes:

• If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

• Close all open software programs before installing the printer software.

1 Obtain a copy of the software installer package.

• From the Software and Documentation CD that came with your printer.

• From our Web site:
Go to www.lexmark.com, and then navigate to:
SUPPORT & DOWNLOADS > select your printer > select your operating system > download your software
installer package

Additional printer setup 24
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2 Do either of the following:

• If you are using the Software and Documentation CD, then insert the CD and wait for the installation dialog to
appear.
If the installation dialog does not appear, then do the following:

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type D:\setup.exe > OK.

In Windows 7 or earlier

a Click , or click Start and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter, or click OK.

Note: D is the letter of your CD or DVD drive.

In Macintosh
Click the CD icon on the desktop.

• If you are using the downloaded software installer from the Web, then double‑click the installer that you have
saved in your computer. Wait for the Select Installation Type dialog to appear, and then click Install.

Note: If you are prompted to run your software installation package, then click Run.

3 Click Install, and then follow the instructions on the computer screen.

Updating available options in the printer driver
When any hardware options are installed, you may need to manually add the options in the printer driver to make
them available for use.

For Windows users

1 Open the printers folder.

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type control printers > OK

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Depending on your device, do either of the following:

• Press and hold the printer you want to update.

• Right‑click the printer you want to update.

Additional printer setup 25
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3 From the menu that appears, do either of the following:

• For Windows 7 or later, select Printer properties.

• For earlier versions, select Properties.

4 Click the Configuration tab.

5 Do either of the following:

• Click Update Now ‑ Ask Printer.

• Under Configuration Options, manually add any installed hardware options.

6 Click Apply.

For Macintosh users

1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan > select your printer > Options & Supplies > Driver

• System Preferences > Print & Fax > select your printer > Options & Supplies > Driver

2 Add any installed hardware options, and then click OK.

Networking
Notes:

• Purchase a MarkNetTM N8352 wireless network adapter first before setting up the printer on a wireless network.
For information on installing the wireless network adapter, see the instruction sheet that came with the
adapter.

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP), Wi-Fi
Protected Access (WPA), WPA2, and 802.1X - RADIUS are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you begin:

Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing the
printer.

• A valid, unique IP address for the printer to use on the network

• The network gateway

• The network mask

• A nickname for the printer (optional)

Note: A printer nickname can make it easier for you to identify your printer on the network. You can choose to
use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer can
physically connect to the network. Use a new network cable when possible to avoid potential problems caused by a
damaged cable.

Additional printer setup 26
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Installing the printer on an Ethernet network

For Windows users

1 Obtain a copy of the software installer package.

• From the Software and Documentation CD that came with your printer.

• From our Web site:
Go to www.lexmark.com, and then navigate to:
SUPPORT & DOWNLOADS > select your printer > select your operating system > download your software
installer package

2 Do either of the following:

• If you are using the Software and Documentation CD, then insert the CD and wait for the installation dialog to
appear.
If the installation dialog does not appear, then do the following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier

a Click , or click Start and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter, or click OK.

Note: D is the letter of your CD or DVD drive.

• If you are using the downloaded software installer from the Web, then double‑click the installer that you have
saved in your computer. Wait for the Select Installation Type dialog to appear, and then click Install.

Note: If you are prompted to run your software installation package, then click Run.

3 Click Install, and then follow the instructions on the computer screen.

4 Select Ethernet connection, and then click Continue.

5 Attach the Ethernet cable when instructed to do so.

6 Select the printer from the list, and then click Continue.

Note: If the configured printer does not appear in the list, then click Modify Search.

7 Follow the instructions on the computer screen.

For Macintosh users

1 Allow the network DHCP server to assign an IP address to the printer.

2 Obtain the printer IP address either:

• From the printer control panel

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then finding the TCP/IP section

Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.
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3 Install the printer driver on the computer.

a Insert the Software and Documentation CD, and then double‑click the installer package for the printer.

b Follow the instructions on the computer screen.

c Select a destination, and then click Continue.

d From the Easy Install screen, click Install.

e Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when installation is complete.

4 Add the printer.

• For IP printing:
a From the Apple menu, navigate to either of the following:

– System Preferences > Print & Scan

– System Preferences > Print & Fax
b Click +.
c If necessary, click Add Printer or Scanner or Add Other Printer or Scanner.
d Click the IP tab.
e Type the printer IP address in the address field, and then click Add.

• For AppleTalk printing:

Notes:

– Make sure AppleTalk is activated on your printer.

– This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:

System Preferences > Print & Fax
b Click +, and then navigate to:

AppleTalk > select your printer > Add

Preparing to set up the printer on a wireless network

Notes:

• Make sure your wireless network adapter is installed in your printer and working properly. For more
information, see the instruction sheet that came with the wireless network adapter.

• Make sure your access point (wireless router) is turned on and is working properly.

Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.

• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.

• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.

Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.
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• Security Method—There are four basic options for Security Method:

– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS

If you are installing the printer on an 802.1X network, then you may need the following:

• Authentication type

• Inner authentication type

• 802.1X user name and password

• Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: We do not recommend using an unsecured wireless network.

Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point, or contact
your system support person.

– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation that
came with the access point, see the Embedded Web Server associated with the access point, or consult your
system support person.

Connecting the printer using the Wireless Setup Wizard
Before you begin, make sure that:

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

• An Ethernet cable is disconnected from the printer.

• Active NIC is set to Auto. To set this to Auto, navigate to:

 > Settings >  > Network/Ports >  > Active NIC >  > Auto > 

Note: Make sure to turn off the printer, then wait for at least five seconds, and then turn the printer back on.

1 From the printer control panel, navigate to:

 > Settings >  > Network/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >  >

Wireless Connection Setup > 

2 Select a wireless connection setup.
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Use To

Search for networks Show available wireless connections.

Note: This menu item shows all broadcast secured or unsecured SSIDs.

Enter a network name Manually type the SSID.

Note: Make sure to type the correct SSID.

Wi‑Fi Protected Setup Connect the printer to a wireless network using Wi‑Fi Protected Setup.

3 Press , and then follow the instructions on the printer display.

Connecting the printer to a wireless network using Wi-Fi Protected Setup
Before you begin, make sure that:

• The access point (wireless router) is Wi‑Fi Protected Setup (WPS) certified or WPS‑compatible. For more
information, see the documentation that came with your access point.

• A wireless network adapter is installed in the printer and is working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

Using the Push Button Configuration (PBC) method

1 From the printer control panel, navigate to:

 > Settings >  >Network/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >  >

Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start Push Button Method > 

2 Follow the instructions on the printer display.

Using the Personal Identification Number (PIN) method

1 From the printer control panel, navigate to:

 > Settings >  >Network/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless >  >

Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start PIN Method > 

2 Copy the eight‑digit WPS PIN.

3 Open a Web browser, and then type the IP address of your access point in the address bar.

Notes:

• The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

4 Access the WPS settings. For more information, see the documentation that came with your access point.

5 Enter the eight‑digit PIN, and then save the setting.
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Connecting the printer to a wireless network using the Embedded Web Server
Before you begin, make sure that:

• Your printer is connected temporarily to an Ethernet network.

• A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with the wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Network/Ports > Wireless.

3 Modify the settings to match the settings of your access point (wireless router).

Note: Make sure to enter the correct SSID, security method, preshared key or passphrase, network mode, and
channel.

4 Click Submit.

5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then turn the
printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is Connected.

Verifying printer setup
When all hardware and software options are installed and the printer is turned on, verify that the printer is set up
correctly by printing the following:

• Menu settings page—Use this page to verify that all printer options are installed correctly. If an option you installed
is not listed, then it is not installed correctly. Remove the option, and then install it again.

• Network setup page—If your printer has networking support, then use this page to verify that the network
connection is working. This page also provides important information that aids network printing configuration.

Printing a menu settings page
Print a menu settings page to view the current menu settings and to verify if the printer options are installed correctly.

From the printer control panel, navigate to:

 > Settings > Reports >  > Menu Settings Page > 

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default settings.
Settings saved from the menus replace the factory default settings as user default settings. A user default setting
remains in effect until you access the menu again, select another value, and save it.

Additional printer setup 31

http://www.manualsbase.com


More user manuals on ManualsBase.com

Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:

 > Settings > Reports >  > Network Setup Page > 

Note: If an optional internal print server is installed, then Print Network [x] Setup Page appears.

2 Check the first section of the network setup page, and confirm that the status is Connected.

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be malfunctioning.
Consult your system support person for a solution, and then print another network setup page.
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Loading paper and specialty media
Proper selection and loading of media can improve how reliably documents print. For more information, see “Avoiding
jams” on page 163 and “Storing paper” on page 49.

Setting the paper size and type
1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Paper Size/Type > 

2 Press the up or down arrow button to select the tray or feeder, and then press .

3 Press the up or down arrow button to select the paper size, and then press .

4 Press the up or down arrow button to select the paper type, and then press  to change the settings.

Configuring Universal paper settings
The Universal paper size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus.

Notes:

• The smallest supported Universal size is 76 x 127 mm (3 x 5 inches) and is loaded only in the multipurpose
feeder and manual feeder.

• The largest supported Universal size is 215.9 x 359.9 mm (8.5 x 14.17 inches) and is loaded only in the
multipurpose feeder and manual feeder.

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Universal Setup > 

2 Press the up or down arrow buttons to scroll to Units of Measure, Portrait Height, or Portrait

Width, and then press .

3 Enter the preferred settings using the keypad, and then press .

4 Press .

Loading the 250‑sheet tray
The printer has a 250-sheet tray (Tray 1) with an integrated manual feeder. The 250-sheet tray and the 650-sheet duo
tray support the same paper sizes and types and are loaded in the same way.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.

1 Pull out the tray completely.
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Note: Do not remove trays while a job is printing or while Busy appears on the display. Doing so may cause a
jam.

2 If the paper is longer than letter‑size paper, then squeeze and then slide the length guide at the back of the tray to
extend it.

3 Squeeze, and then slide the length guide tab to the correct position for the size of the paper being loaded.

Note: Use the paper size indicators on the bottom of the tray to help position the guide.
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4 Squeeze, and then slide the width guide tab to the correct position for the size of the paper being loaded.

Note: Use the paper size indicators on the bottom of the tray to help position the guides.

5 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.
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6 Load the paper stack with the recommended printable side faceup.

7 Place the paper guides securely against the edges of the paper.

8 Insert the tray.

9 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper loaded in
the tray.

Note: Mixing paper sizes or paper types in a tray may cause jams.

Loading the manual feeder
The standard 250‑sheet tray has an integrated manual feeder that can be used to print on different types of paper one
sheet at a time.

1 Load a sheet of paper into the manual feeder:

• Printable side facedown for one-sided printing

• Printable side faceup for two‑sided (duplex) printing

Note: There are different ways for loading letterhead depending on the mode of printing.
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One‑sided printing using a letterhead Two‑sided printing using a letterhead

• Load envelope with the flap side up and against the right side of the paper guide.

2 Feed paper into the manual feeder only to the point where its leading edge can contact the paper guides.

Note: To achieve the best possible print quality, use only high‑quality media designed for laser printers.

3 Adjust the paper guides to the width of the paper loaded.

Warning—Potential Damage: Do not force the paper into the feeder. Forcing the paper may cause jams.

Loading the 650‑sheet duo tray
The 650‑sheet duo tray (Tray 2) consists of a 550‑sheet tray and an integrated 100‑sheet multipurpose feeder. The tray
is loaded in the same way as the 250‑sheet tray and supports the same paper types and sizes. The only differences are
the look of the guide tabs and the location of the paper size indicators.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately. Keep all
other trays closed until needed.
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1 Length guide tab

2 Paper size indicator

3 Width guide tab

Loading the multipurpose feeder
1 Push the multipurpose feeder latch to the left.
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2 Open the multipurpose feeder.

3 Pull the multipurpose feeder extender.

Note: Guide the extender gently so that the multipurpose feeder is fully extended and open.

4 Prepare the paper for loading.

• Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper.
Straighten the edges on a level surface.

• Hold transparencies by the edges, and then fan them. Straighten the edges on a level surface.

Note: Avoid touching the printable side of transparencies. Be careful not to scratch them.

• Flex a stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a level
surface.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated linings, or
self‑stick adhesives. These envelopes may severely damage the printer.
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5 Locate the maximum paper fill indicator and tab.

Note: Make sure the paper or specialty media is below the maximum paper fill indicator located on the paper
guides.

1 Width guide tab

2 Maximum paper fill indicator

3 Width guide

4 Feeder extender

5 Paper size indicator

6 Load the paper, and then adjust the width guide to lightly touch the edge of the paper stack.

• Load paper, card stock, and transparencies with the recommended printable side facedown and the top edge
entering the printer first.
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• Load envelopes with the flap side up and against the right side of the paper guide.

Notes:

• Do not load or close the multipurpose feeder while a job is printing.

• Load only one size and type of paper at a time.

• Paper should lie flat in the multipurpose feeder. Make sure the paper fits loosely in the multipurpose feeder
and is not bent or wrinkled.

7 From the printer control panel, set the paper size and type in the Paper menu to match the paper loaded in the
tray.

Linking and unlinking trays
When the paper size and paper type for any trays are the same, the printer will link those trays. When one linked tray
becomes empty, paper will feed from the next linked tray. We recommend giving all unique paper, such as letterhead
and different colored plain papers, a different custom type name so that the trays they are in will not automatically
link.

Linking and unlinking trays
Note: This feature applies only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu.

3 Change the tray settings to specify the paper size and type for the tray.

• To link trays, make sure the paper size and type for the tray match with that of the other tray.

• To unlink trays, make sure the paper size or type for the tray does not match with that of the other tray.

4 Click Submit.

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the printer.
The temperature of the fuser varies according to the specified paper type. Printing issues may occur if settings are
not properly configured.

Loading paper and specialty media 41

http://www.manualsbase.com


More user manuals on ManualsBase.com

Creating a custom name for a paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Select a custom name, and then type a new custom paper type name.

4 Click Submit.

5 Click Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Select a custom name, and then type a new custom paper type name.

3 Press .

4 Press Custom Types, and then verify if the new custom paper type name has replaced the custom name.

Assigning a custom paper type name

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Names.

3 Type a name for the paper type, and then click Submit.

4 Select a custom type, and then verify that the correct paper type is associated with the custom name.

Note: Plain Paper is the factory default paper type for all user‑defined custom names.
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Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Names

2 Type a name for the paper type, and then press .

Assigning a custom paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Types.

3 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Types

2 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

3 Press .
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Paper and specialty media guide

Using specialty media

Tips on using letterhead
• Use letterhead designed specifically for laser printers.

• Print a test page on the letterhead being considered for use before buying large quantities.

• Before loading letterhead, flex, fan, and straighten the stacks to prevent sheets from sticking together.

• Page orientation is important when printing on letterhead.

Source Printing Printable side Paper orientation

Trays One‑sided Faceup Load the sheet
with the top edge
entering the
printer first.

Trays Two‑sided Facedown Load the sheet
with the bottom
edge entering the
printer first.

Manual feeder One‑sided Facedown Load the sheet
with the top edge
entering the
printer first.

Note: Check with the manufacturer or vendor to determine whether or not the preprinted letterhead is acceptable
for laser printers.
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Source Printing Printable side Paper orientation

Manual feeder Two‑sided Faceup Load the sheet
with the bottom
edge entering the
printer first.

Multipurpose feeder One‑sided Facedown Load the sheet
with the top edge
entering the
printer first.

Multipurpose feeder Two‑sided Faceup Load the sheet
with the bottom
edge entering the
printer first.

Note: Check with the manufacturer or vendor to determine whether or not the preprinted letterhead is acceptable
for laser printers.

Tips on using transparencies
Print a test page on the transparencies being considered for use before buying large quantities.

• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the
transparencies loaded in the tray.

• Print a test page on the transparencies being considered for use before buying large quantities.

• Feed transparencies from the 250-sheet tray, manual feeder, or multipurpose feeder.

• Use transparencies designed specifically for laser printers.

• Avoid getting fingerprints on the transparencies to prevent print quality problems.

• Before loading transparencies, flex, fan, and straighten the stacks to prevent sheets from sticking together.

Paper and specialty media guide 45

http://www.manualsbase.com


More user manuals on ManualsBase.com

Tips on using envelopes
• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the

envelopes loaded in the tray.

• Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers.

• For best performance, use envelopes made from 90‑g/m2 (24‑lb) paper or 25% cotton.

• Use only new envelopes from undamaged packages.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist.

– Are stuck together or damaged in any way.

– Have windows, holes, perforations, cutouts, or embossing.

– Have metal clasps, string ties, or folding bars.

– Have an interlocking design.

– Have postage stamps attached.

– Have any exposed adhesive when the flap is in the sealed or closed position.

– Have bent corners.

– Have rough, cockle, or laid finishes.

• Adjust the width guides to fit the width of the envelopes.

• Before loading the envelopes on the tray, flex and fan the envelopes to loosen them. Straighten the edges on a
level surface.

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal envelopes.

Tips on using labels
• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the labels

loaded in the tray.

• Print samples on labels being considered for use before buying large quantities.

• For more information on label printing, characteristics, and design, see the Card Stock & Label Guide at
http://support.lexmark.com.

• Use labels designed specifically for laser printers.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and toner cartridge
warranties.

• Do not use labels with exposed adhesive.

• Before loading labels on the tray, flex and fan labels to loosen them. Straighten the edges on a level surface.
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Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly affect print quality.

• From the printer control panel, set the paper size, type, texture, and weight in the Paper menu to match the card
stock loaded in the tray.

• Print samples on the card stock being considered for use before buying large quantities.

• Specify the paper texture and weight from the tray settings to match the paper loaded in the tray.

• Preprinting, perforation, and creasing may significantly affect the print quality and cause jams or other paper feed
problems.

• Before loading the card stock on the tray, flex and fan the card stock to loosen them. Straighten the edges on a
level surface.

Paper guidelines
Select the correct paper or specialty media to reduce printing problems. For the best print quality, try a sample of the
paper or specialty media before buying large quantities.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight

The printer trays can automatically feed paper weights up to 176‑g/m2 (47‑lb) bond grain long paper. The multipurpose
feeder can automatically feed paper weights up to 176‑g/m2 (47‑lb) bond grain long paper. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75‑g/m2 (20‑lb)
bond grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 inches), we recommend 90 g/m2 (24 lb) or
heavier paper.

Note: Duplex printing is supported from 60–105‑g/m2 (16–28‑lb) bond grain long paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If paper is
too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield
points; smoothness between 150 and 250 Sheffield points produces the best print quality.
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Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.

Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing. Extend
the time to several days if the storage or transportation environment is very different from the printer environment.
Thick paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.

For 60–90‑g/m2 (16–24‑lb) bond paper, grain long paper is recommended.

Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:

• Chemically‑treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless
copy paper (CCP), or no carbon required (NCR) paper

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise print location on the page) greater than ±2.4 mm
(±0.9 inch), such as optical character recognition (OCR) forms

In some cases, registration can be adjusted with a software application to successfully print on these forms:

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough‑edged, rough or heavily textured surface papers, or curled papers

• Recycled papers that fail EN12281:2002 (European)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple‑part forms or documents

Selecting paper
Using the appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid paper jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended printable side of the paper. This information is usually indicated on
the paper package.

• Do not use paper that has been cut or trimmed by hand.
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• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60–90‑g/m2 (16–24‑lb) paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid paper with rough or heavily textured surfaces.

Use inks that are not affected by the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these
requirements; latex inks might not.

When in doubt, contact your paper supplier.

Using recycled paper and other office papers
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser (electrophotographic) printers. In 1998, Lexmark presented to the US government a study demonstrating
that recycled paper produced by major mills in the US fed as well as non-recycled paper. However, no blanket statement
can be made that all recycled paper will feed well.

Lexmark consistently tests its printers with recycled paper (20–100% post-consumer waste) and a variety of test paper
from around the world, using chamber tests for different temperature and humidity conditions. Lexmark has found no
reason to discourage the use of today's recycled office papers, but generally the following property guidelines apply
to recycled paper.

• Low moisture content (4–5%)

• Suitable smoothness (100–200 Sheffield units, or 140–350 Bendtsen units, European)

Note: Some much smoother papers (such as premium 24 lb laser papers, 50–90 Sheffield units) and much
rougher papers (such as premium cotton papers, 200–300 Sheffield units) have been engineered to work very
well in laser printers, despite surface texture. Before using these types of paper, consult your paper supplier.

• Suitable sheet-to-sheet coefficient of friction (0.4–0.6)

• Sufficient bending resistance in the direction of feed

Recycled paper, paper of lower weight (<60 g/m2 [16 lb bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and paper
that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is required for
reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing, consult your paper
supplier. Remember that these are general guidelines only and that paper meeting these guidelines may still cause
paper feeding problems in any laser printer (for example, if the paper curls excessively under normal printing
conditions).

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent. Most
label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) with relative humidity
between 40 and 60 percent.

• Store paper in cartons, on a pallet or shelf, rather than on the floor.
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• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

• Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and wrapper
help keep the paper clean, dry, and flat.

Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the sizes, types, and weights of
paper they support.

Note: For an unlisted paper size, select the closest larger listed size.

Supported paper sizes
Note: Your printer model may have a 650‑sheet duo tray, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

Paper size and
dimension

Standard
250‑sheet tray

Manual
feeder

650‑sheet duo tray ADF Scanner
glass

Duplex
mode

550‑sheet tray Multipurpose
feeder

A4

210 x 297 mm
(8.3 x 11.7 in.)

1 1 1

A5

148 x 210 mm
(5.83 x 8.3 in.)

1 2 1 X

A6

105 x 148 mm
(4.1 x 5.8 in.)

X X 1 X X

JIS B5

182 x 257 mm
(7.2 x 10.1 in.)

1 1 1 X

Letter

216 x 279 mm
(8.5 x 11 in.)

1 1 1

1 The paper source supports paper size without size sensing.
2 Universal is supported in the standard 250‑sheet tray only if the paper size is from 148 x 215.9 mm (5.83 x 8.5 in.) to
215.9 x 355.6 mm (8.5 x 14 in.).
3 Universal is supported in the multipurpose feeder and manual feeder only if the paper size is from 76.2 x 127 mm (3 x 5 in.)
to 215.9 x 359.9 mm (8.5 x 14.17 in.).
4 Universal is supported in duplex mode only if the width is from 210 mm (8.27 in.) to 215.9 mm (8.5 in.), and the length is
from 279.4 mm (11 in.) to 355.6 mm (14 in.).
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Paper size and
dimension

Standard
250‑sheet tray

Manual
feeder

650‑sheet duo tray ADF Scanner
glass

Duplex
mode

550‑sheet tray Multipurpose
feeder

Legal

216 x 356 mm
(8.5 x 14 in.)

1 1 1 X

Executive

184 x 267 mm
(7.3 x 10.5 in.)

1 1 1 X

Oficio (Mexico)

216 x 340 mm
(8.5 x 13.4 in.)

1 1 1 X

Folio

216 x 330 mm
(8.5 x 13 in.)

1 1 1 X

Statement

140 x 216 mm
(5.5 x 8.5 in.)

X X 1 X

Universal

76 x 127 mm (3 x 5 in.)
to 216 x 356 mm
(8.5 x 14 in.)

X 1,3 X 1,3 X

Universal

148 x 210 mm
(5.8 x 8.3 in) to
216 x 356 mm (8.5 x 14
in).

1,2 1,2 X X 4

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X X 1 X X X

9 Envelope

98 x 225 mm
(3.9 x 8.9 in.)

X X 1 X X X

10 Envelope

105 x 241 mm
(4.1 x 9.5 in.)

X X 1 X X X

1 The paper source supports paper size without size sensing.
2 Universal is supported in the standard 250‑sheet tray only if the paper size is from 148 x 215.9 mm (5.83 x 8.5 in.) to
215.9 x 355.6 mm (8.5 x 14 in.).
3 Universal is supported in the multipurpose feeder and manual feeder only if the paper size is from 76.2 x 127 mm (3 x 5 in.)
to 215.9 x 359.9 mm (8.5 x 14.17 in.).
4 Universal is supported in duplex mode only if the width is from 210 mm (8.27 in.) to 215.9 mm (8.5 in.), and the length is
from 279.4 mm (11 in.) to 355.6 mm (14 in.).
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Paper size and
dimension

Standard
250‑sheet tray

Manual
feeder

650‑sheet duo tray ADF Scanner
glass

Duplex
mode

550‑sheet tray Multipurpose
feeder

DL Envelope

110 x 220 mm
(4.3 x 8.7 in.)

X X 1 X X X

C5 Envelope

162 x 229 mm
(6.4 x 9 in.)

X X 1 X X X

B5 Envelope

176 x 250 mm
(6.9 x 9.8 in.)

X X 1 X X X

Other Envelope

98 x 162 mm
(3.9 x 6.3 in.) up to
176 x 250 mm
(6.9 x 9.8 in.)

X X 1 X X X

1 The paper source supports paper size without size sensing.
2 Universal is supported in the standard 250‑sheet tray only if the paper size is from 148 x 215.9 mm (5.83 x 8.5 in.) to
215.9 x 355.6 mm (8.5 x 14 in.).
3 Universal is supported in the multipurpose feeder and manual feeder only if the paper size is from 76.2 x 127 mm (3 x 5 in.)
to 215.9 x 359.9 mm (8.5 x 14.17 in.).
4 Universal is supported in duplex mode only if the width is from 210 mm (8.27 in.) to 215.9 mm (8.5 in.), and the length is
from 279.4 mm (11 in.) to 355.6 mm (14 in.).

Supported paper types and weights

Notes:

• Your printer model may have a 650‑sheet duo tray, which consists of a 550‑sheet tray and an integrated
100‑sheet multipurpose feeder. The integrated multipurpose feeder supports different paper sizes, types, and
weights.

• Labels, transparencies, envelopes, and card stock always print at reduced speed.
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Paper type 250‑sheet
tray

Manual
feeder

650‑sheet duo tray ADF Scanner
glass

Duplex
mode

550‑sheet
tray

Multipurpose
feeder

Paper

• Plain

• Recycled

• Glossy

• Bond

• Letterhead

• Preprinted

• Colored

• Light

• Heavy

• Rough/Cotto
n

• Custom
Type [x]

Card stock X

Transparencies X X

Labels

• Paper

X

Envelope X X X
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Printing

Printing a document

Printing a document
1 From the Paper menu on the printer control panel, set the paper type and size to match the paper loaded.

2 Send the print job:

For Windows users

a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup.

c Adjust the settings, if necessary.

d Click OK > Print.

For Macintosh users

a Customize the settings in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 Choose a paper size or create a custom size to match the paper loaded.
3 Click OK.

b Customize the settings in the Print dialog:
1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the Print dialog and pop‑up menus, adjust the settings if necessary.

Note: To print on a specific paper type, adjust the paper type setting to match the paper loaded, or
select the appropriate tray or feeder.

3 Click Print.

Printing in black and white
From the printer control panel, navigate to:

 > Settings >  > Print Settings >  > Quality Menu >  > Print Mode >  > Black Only > 

Adjusting toner darkness

Using the Embedded Web Server

1 Open a Web browser, and then type the IP address of the printer in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Quality Menu > Toner Darkness.

3 Adjust the toner darkness, and then click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Print Settings >  > Quality Menu >  > Toner Darkness

2 Adjust the toner darkness, and then press .

Using Max Speed and Max Yield
Max Speed and Max Yield let you choose between a faster print speed and a higher toner yield. Max Yield is the factory
default setting.

• Max Speed—This lets you print in either black or color depending on the setting in the printer driver. The printer
prints in color unless Black Only is selected in the printer driver.

• Max Yield—This lets you switch from black to color based on the color content found on each page.

Note: Frequent color mode switching can result to slower printing if the content of the pages is mixed.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Setup Menu.

3 From the Printer Usage list, select Max Speed or Max Yield.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > Print Settings >  > Setup Menu >  > Printer Usage > 

2 Select Max Speed or Max Yield, and then press .

Printing from a mobile device
To download a compatible mobile printing application, visit www.lexmark.com/mobile.
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Note: Mobile printing applications may also be available from your mobile device manufacturer.

Printing confidential and other held jobs

Storing print jobs in the printer
1 From the printer control panel, navigate to:

 > Settings >  > Security >  > Confidential Print > select the print job type

Print job type Description

Max Invalid PIN Limits the number of times an invalid PIN can be entered.

Note: When the limit is reached, the print jobs for that user name and PIN are
deleted.

Confidential Job Expiration Lets you hold print jobs in the computer until you enter the PIN from the printer
control panel.

Note: The PIN is set from the computer. It must be four digits, using the
numbers 0–9.

Repeat Job Expiration Lets you print and store print jobs in the printer memory for reprinting.

Verify Job Expiration Lets you print one copy of a print job while the printer holds the remaining
copies. It allows you to examine if the first copy is satisfactory. The print job is
automatically deleted from the printer memory once all copies are printed.

Reserve Job Expiration Lets you store print jobs for printing at a later time. The print jobs are held until
deleted from the Held Jobs menu.

Notes:

• Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

• You can set the printer to store print jobs in the printer memory until you start the print job from the printer
control panel.

• All print jobs that can be initiated by the user at the printer are called held jobs.

2 Press .

Printing confidential and other held jobs
Note: Confidential and Verify print jobs are automatically deleted from memory after printing. Repeat and Reserve
jobs are held in the printer until you delete them.

For Windows users

1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Click Print and Hold.
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4 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

5 Click OK or Print.

6 From the printer home screen, release the print job.

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

For Macintosh users

1 With a document open, choose File > Print.

If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.

3 Select the print job type (Confidential, Repeat, Reserve, or Verify), and then assign a user name. For a confidential
print job, also enter a four‑digit PIN.

4 Click OK or Print.

5 From the printer home screen, release the print job.

• For confidential print jobs, navigate to:
Held jobs > select your user name > Confidential Jobs > enter the PIN > Print

• For other print jobs, navigate to:
Held jobs > select your user name > select the print job > specify the number of copies > Print

Modifying confidential print settings
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer home screen. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Security > Confidential Print Setup.

3 Modify the settings:

• Set a maximum number of PIN entry attempts. When a user exceeds that number, all of the jobs for that user
are deleted.

• Set an expiration time for confidential print jobs. When a user has not printed the jobs within that time, all of
the jobs for that user are deleted.

4 Click Submit to save the modified settings.
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Printing information pages

Printing a font sample list
1 From the printer control panel, navigate to:

 > Settings >  > Reports >  > Print Fonts

2 Press the up or down arrow button to select the font setting.

3 Press .

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Canceling a print job

Canceling a print job from the printer control panel

1 From the printer control panel, press .

2 When a list of print jobs appears, select the job to cancel, and then press .

3 Press  to go back to the home screen.

Canceling a print job from the computer

For Windows users

1 Open the printers folder.

In Windows 8
From the Search charm, type run, and then navigate to:

Apps list > Run > type control printers > OK

In Windows 7 or earlier

a Click  or click Start, and then click Run.

b In the Start Search or Run dialog, type control printers.

c Press Enter, or click OK.

2 Double‑click the printer icon.

3 Select the print job you want to cancel.

4 Click Delete.
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For Macintosh users

1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan > select your printer > Open Print Queue

• System Preferences > Print & Fax > select your printer > Open Print Queue

2 From the printer window, select the print job you want to cancel, and then delete it.
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Copying

Automatic document feeder (ADF) Scanner glass

ABC

Use the ADF for multiple‑page documents.

Note: The ADF scans only one-side of the page.

Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

Making copies

Making a quick copy
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

Note: To avoid a cropped image, make sure the size of the original document and the size of the copy paper are
the same.

3 From the printer control panel, press .

Copying using the ADF
1 Load an original document faceup, short edge first into the ADF tray.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.
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• The ADF indicator light comes on when the paper is loaded properly.

2 Adjust the paper guides.

3 From the printer control panel, use the keypad to enter the number of copies, and then press .

Copying using the scanner glass
1 Place an original document facedown on the scanner glass in the upper left corner.

2 From the printer control panel, use the keypad to enter the number of copies, and then press .

Note: If you want to scan another document, then place the next document on the scanner glass, press the left

or right arrow button to scroll to Scan the Next Page, and then press .

3 Press the left or right arrow button to scroll to Finish the Job, and then press .

Copying photos
1 Place a photo facedown on the scanner glass in the upper left corner.

2 From the printer control panel, navigate to:

 > Copy >  > Content Type > Photo

3 From the Content Source menu, choose a setting that best describes the original photo your are copying, and then

press .

Note: If you want to copy another photo, then place it on the scanner glass, press the left or right arrow button

to scroll to Scan the Next Page, and then press .

4 Press the left or right arrow button to scroll to Finish the Job, and then press .

Copying on specialty media

Copying on transparencies
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Copy from > select the size of the original document
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4 Navigate to:

Copy to >  > select the tray containing the transparencies >  > select the number of copies or enter a number

on the keypad > 

5 If there are no trays that contain transparencies, then do the following:

a Navigate to:

Copy to >  > Manual Feeder >  > select the size of the transparencies >  > Transparency > 

b Load transparencies into the multipurpose feeder, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .

Copying on letterhead
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Copy from > select the size of the original document

4 Navigate to:

Copy to >  > select the tray containing the letterhead >  > select the number of copies or enter a number

on the keypad > 

5 If there are no trays that contain letterhead, then do the following:

a Navigate to:

Copy to >  > Manual Feeder >  > select the size of the letterhead > Letterhead

b Place the letterhead faceup, top edge first into the multipurpose feeder, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .
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Customizing copy settings

Copying to a different size
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Copy from > select the size of the original document

4 Navigate to:

Copy to >  > select a new size for the copy > select the number of copies or enter a number on the keypad >

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

5 Press the left or right arrow button to scroll to Finish the Job, and then press .

Making copies using paper from a selected tray
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Copy from > select the size of the original document

4 Navigate to:

Copy to >  > select the tray containing the paper size and type you want to use >  > select the number of

copies or enter a number on the keypad > 
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5 If there are no trays that contain the paper size and type you want to use, then do the following:

a Navigate to:

Copy to >  > Manual Feeder >  > select the paper size >  > select the paper type > 

b Load the size and type of paper into the multipurpose feeder, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow button

to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .

Reducing or enlarging copies
Copies can be scaled from 25% to 400% of the original document size.

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Scale > adjust the scale setting > select the number of copies or enter a number on the keypad >

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

4 Press the left or right arrow button to scroll to Finish the Job, and then press .

Making a copy lighter or darker
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass in the upper

left corner.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 From the printer control panel, navigate to:

 > Copy >  > Darkness > adjust the darkness setting > select the number of copies or enter a number on the

keypad > 

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

4 Press the left or right arrow button to scroll to Finish the Job, and then press .

Adjusting copy quality
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Content Type > select the content type of the original document

4 Press the left or right arrow button to scroll to one of the following:

• Text—The content of the original document is mostly text or line art.

• Text/Photo—The original document is a mixture of text and graphics or photos.

• Photo—The original document is mostly a photo or an image.

• Graphics—The original document is mostly business‑type graphics, such as pie charts, bar charts, and
animations.

5 Press the up or down arrow button until Content Source appears, and then press the left or right arrow button
to scroll to one of the following:

• Color Laser—The original document was printed using a color laser printer.

• Inkjet—The original document was printed using an inkjet printer.

• Magazine—The original document is from a magazine.

• Press—The original document is from an offset press.

• Black/White Laser—The original document was printed using a mono laser printer.

• Photo/Film—The original document is a photo from a film.

• Newspaper—The original document is from a newspaper.

• Other—The original document was printed using an alternate or unknown printer.
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6 Select the number of copies or enter a number on the keypad, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

7 Press the left or right arrow button to scroll to Finish the Job, and then press .

Collating copies
If you print multiple copies of a document, then you can choose to print each copy as a set (collated) or to print the
copies as groups of pages (not collated).

Collated Not collated

To select a Collate setting:

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Collate > select the collate setting you want > select the number of copies or enter a number

on the keypad > 

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

4 Press the left or right arrow button to scroll to Finish the Job, and then press .

Placing separator sheets between copies
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.
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3 From the printer control panel, navigate to:

 > Copy >  > Separator Sheets

4 Select Between Copies, Between Jobs, Between Pages, or Off.

5 Select the number of copies or enter a number on the keypad, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .

Copying multiple pages onto a single sheet
To save paper, you can copy either two or four consecutive pages of a multiple‑page document onto a single sheet of
paper.

Notes:

• Make sure the paper size is set to letter, legal, A4, or JIS B5.

• The copy size must be set to 100%.

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Paper Saver > select the setting that you want

4 Select Off, 2‑up Portrait, 2‑up Landscape, 4‑up Portrait, or 4‑up Landscape.

5 Select the number of copies or enter a number on the keypad, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .

Placing information on copies

Placing an overlay message on each page
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
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Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, navigate to:

 > Copy >  > Overlay > select an overlay message you want

4 Select Off, Confidential, Copy, Draft, Urgent, or Custom.

5 Select the number of copies or enter a number on the keypad, and then press .

Note: If you want to copy another document, then place it on the scanner glass, press the left or right arrow

button to scroll to Scan the Next Page, and then press .

6 Press the left or right arrow button to scroll to Finish the Job, and then press .

Canceling a copy job

Canceling a copy job from the printer control panel

1 From the printer control panel, press .

2 When a list of copy jobs appears, select the job to cancel, and then press .

3 Press  to go back to the home screen.

Understanding the copying options

Copies
This option lets you set the number of copies to be printed.

Copy from
This option opens a screen where you can select the paper size of the original document.

• To scroll to the paper size that matches the original document, press the left or right arrow button, and then press

.

• To copy an original document that contains mixed paper sizes with the same width, press the left or right arrow

button to scroll to Mixed Sizes, and then press .
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Copy to
This option lets you select the paper size and type on which your copies will be printed.

• To scroll to the paper size and type that matches the paper loaded in the tray or feeder, press the left or right arrow

button, and then press .

• If the settings for “Copy from” and “Copy to” are different, then the printer automatically adjusts the Scale setting
to accommodate the difference.

• If the paper type or size you want to use is not loaded in one of the trays, then press the left or right arrow button

to scroll to Manual Feeder, press , and then manually load the paper in the manual feeder or multipurpose
feeder.

• To match each copy to the paper size of the original document, set “Copy to” to Auto Size Match. If a matching
paper size is not in one of the trays, then Paper size not found appears and prompts to load a paper in a
tray, manual feeder, or multipurpose feeder.

Scale
This option lets you scale the document from 25% to 400% of the original document size. You can also set automatic
scaling.

• When copying to a different paper size, such as from legal‑size to letter‑size paper, set the “Copy from” and “Copy
to” paper sizes automatically to scale the scan image to fit the size of the paper onto which you are copying.

• To decrease or increase the value by 1%, press the left or right arrow button on the printer control panel. To make
a continuous decrease or increase in value, press and hold the button for two or more seconds.

Darkness
This option lets you adjust how light or dark the copies are in relation to the original document.

Collate
This option keeps the pages of a print job stacked in sequence when printing multiple copies of the document.

Content Type
This option lets you set the original document type.

Select from the following content types:

• Graphics—The original document is mostly business‑type graphics, such as pie charts, bar charts, and animations.

• Photo—The original document is mostly a photo or an image.

• Text—The content of the original document is mostly text or line art.

• Text/Photo—The original document is a mixture of text, graphics, and photos.

Content Source
This option lets you set the original document source.
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Select from the following content sources:

• Color Laser—The original document was printed using a color laser printer.

• Black/White Laser—The original document was printed using a mono laser printer.

• Inkjet—The original document was printed using an inkjet printer.

• Photo/Film—The original document is a photo from a film.

• Magazine—The original document is from a magazine.

• Newspaper—The original document is from a newspaper.

• Press—The original document was printed using a printing press.

• Other—The original document was printed using an alternate or unknown printer.

Color
This option lets you set the output to either color or monochrome for the scanned image.

Overlay
This option lets you create a watermark (or message) that overlays the content of your copy. You can choose from
Confidential, Copy, Draft, Urgent, and Custom. You can type a custom message in the ”Enter the Custom Text Overlay
and press OK” field. The message will appear, faintly, in large print across each page.

Separator Sheets
This option lets you place a blank sheet of paper between copies, prints, pages, print jobs or copy jobs. The separator
sheets can be drawn from a tray that contains a type or color of paper that is different from the paper your copies are
printed on.

Paper Saver
This option lets you print two or more pages of an original document on the same page. Paper Saver is also called N-
up printing where N stands for the number of pages. For example, 2-up would print two pages of your document on a
single page, and 4-up would print four pages of your document on a single page.
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E-mailing

Automatic document feeder (ADF) Scanner glass

ABC

Use the ADF for multiple‑page documents.

Note: The ADF scans only one-side of the page.

Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

You can use the printer to e‑mail scanned documents to one or more recipients. You can type the e‑mail address or
use a shortcut number to send an e-mail from the printer.

Setting up the printer to e-mail

Setting up the e-mail function
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > E-mail/FTP Settings > E-mail Settings.

3 Enter the appropriate information, and then click Submit.

Configuring e‑mail settings
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > E-mail/FTP Settings > E-mail Settings.

3 Enter the appropriate information, and then click Submit.

Creating an e-mail shortcut

Creating an e-mail shortcut using the Embedded Web Server
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Manage Shortcuts > E-mail Shortcut Setup.

3 Type a name for the shortcut, and then enter the e-mail address.

Note: If you are entering multiple addresses, then separate each address with a comma (,).

4 Adjust the scan settings, if necessary.

5 Enter a shortcut number, and then click Add.

If you enter a number that is already in use, then you are prompted to select another number.

E-mailing a document

Sending an e‑mail using a shortcut number
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 Press #, then enter the shortcut number using the keypad, and then press .

4 Press .

Sending an e‑mail using the printer control panel
1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
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Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is properly loaded.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, press the up or down arrow button to scroll to Shortcuts, and then press .

4 Press Email Shortcuts >  > select the name of the recipient >  or .

Note: Shortcuts can be created only from the Embedded Web Server.

Canceling an e-mail

From the printer control panel, press .
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Scanning

Scanning to an FTP address

Automatic document feeder (ADF) Scanner glass

ABC

Use the ADF for multiple‑page documents.

Note: The ADF scans only one-side of the page.

Use the scanner glass for single-page documents, book pages, small items
(such as postcards or photos), transparencies, photo paper, or thin media
(such as magazine clippings).

The scanner lets you scan documents directly to a File Transfer Protocol (FTP) server. Only one FTP address may be
sent to the server at a time.

When an FTP destination has been configured by your system support person, the name of the destination becomes
available as a shortcut number, or it is listed as a profile under the Held Jobs icon. An FTP destination could also be
another PostScript printer.

Creating shortcuts
Instead of entering the entire FTP site address on the printer control panel each time you want to send a document to
an FTP server, you can create a permanent FTP destination and assign a shortcut number. There are two methods for
creating shortcut numbers: using the Embedded Web Server and using the printer control panel.

Creating an FTP shortcut using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Navigate to:

Settings > Other Settings area > Manage Shortcuts > FTP Shortcut Setup
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3 Enter the appropriate information.

Note: A password may be required. If you do not have an ID and password, then contact your system support
person.

4 Enter a shortcut number.

If you enter a number that is already in use, then you are prompted to select another number.

5 Click Add.

Scanning to an FTP address

Scanning to an FTP address using a shortcut number

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is loaded properly.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, press #, and then enter the FTP shortcut number.

4 Press .

Scanning to an FTP address using the printer control panel

1 Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.

Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light comes on when the paper is properly loaded.

2 If you are loading a document into the ADF tray, then adjust the paper guides.

3 From the printer control panel, press the up or down arrow button to scroll to Shortcuts, and then press .

4 Press FTP Shortcuts >  > select the name of the recipient >  or .

Note: Shortcuts can be created only from the Embedded Web Server.
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Scanning to a computer

Automatic document feeder (ADF) Scanner glass

ABC

Use the ADF for multiple‑page documents.

Note: The ADF scans only one-side of the page.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

The scanner lets you scan documents directly to a computer. The computer does not have to be directly connected to
the printer for you to receive images when scanning. You can scan the document back to the computer over the network
by creating a scan profile on the computer and then downloading the profile to the printer.

Scanning to a computer
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Scan Profile > Create Scan Profile.

3 Select your scan settings, and then click Next.

4 Select a location on your computer where you want to save the scanned output file.

5 Type a scan name.

The scan name is the name that appears in the Scan Profile list on the display.

6 Click Submit.

7 Review the instructions on the Scan Profile screen.

A shortcut number is automatically assigned when you click Submit. You can use this shortcut number when you
are ready to scan your documents.

a Load an original document faceup, short edge first into the ADF tray or facedown on the scanner glass.
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Notes:

• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as
magazine clippings) into the ADF tray. Place these items on the scanner glass.

• The ADF indicator light turns on when the paper is loaded properly.

b If you are loading a document into the ADF tray, then adjust the paper guides.

c From the printer control panel, press #, and then type the shortcut number using the keypad, or press the up
or down arrow button to scroll to Held Jobs, and then press the up or down arrow button to scroll to Profiles.
After entering the shortcut number, the scanner scans and sends the document to the directory or program
you specified. If you selected Profiles on the printer control panel, then locate your shortcut on the list.

8 View the file from the computer.

The output file is saved in the location or launched in the program you specified.
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Understanding the printer menus

Menus list
Supplies Menu Paper Menu Reports Network/Ports

Cyan Cartridge

Magenta Cartridge

Yellow Cartridge

Black Cartridge

Waste Toner Bottle

Maintenance Kit

Default Source

Paper Size/Type

Substitute Size

Paper Texture

Paper Weight

Paper Loading

Custom Types

Custom Scan Sizes

Universal Setup

Menu Settings Page

Device Statistics

Network Setup Page

Network [x] Setup Page

Shortcut List

Copy Shortcuts

E‑mail Shortcuts

FTP Shortcuts

Profiles List

Print Fonts

Print Directory

Print Demo

Asset Report

Active NIC

Standard Network or
Network [x]

Standard USB

SMTP Setup

Security Settings Help Option Card Menu

Confidential Print

Security Audit Log

Set Date and Time

General Settings

Copy Settings

E‑mail Settings

FTP Settings

Print Settings

Print All Guides

Copy Guide

E‑mail Guide

FTP Guide

Color Quality

Print Defects Guide

Information Guide

Supplies Guide

[index of each installed
DLE]
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Supplies menu
Use To

Cyan, Magenta, Yellow, or Black Toner Cartridge
Nearly Low
Low
Very Low
Replace
Missing
Defective
Missing or Unresponsive
Unsupported
Invalid Region
OK
Non‑genuine Lexmark Cartridge

Show the status of the cyan, magenta, yellow, or black toner
cartridge.

Black or Color Imaging Kit
Nearly Low
Low
Very Low
Replace
Missing
Defective
Missing or Unresponsive
Unsupported
OK
Non‑genuine Lexmark Imaging Kit

Show the status of the black or color imaging kit.

Waste Toner Bottle
Near Full
Replace
Missing
OK

Show the status of the waste toner bottle.

Maintenance Kit
Nearly Low
Low
Very Low
Replace
OK

Show the status of the maintenance kit.

Understanding the printer menus 79

http://www.manualsbase.com


More user manuals on ManualsBase.com

Paper menu

Default Source menu

Use To

Default Source
Tray [x]
Multipurpose Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Notes:

• The 650‑sheet duo tray must be installed in order for Multipurpose
Feeder to appear as a menu setting in the Paper menu.

• Tray 1 (standard tray) is the factory default setting.

• Only installed paper sources will appear as menu settings.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one tray
is empty, the print job continues using the linked tray.

Paper Size/Type menu

Use To

Tray [x] Size
A4
A5
JIS‑B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Universal

Specify the paper size loaded in each tray.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory
default setting.

• If two trays contain paper of the same size and type, and the trays have
the same settings, then the trays are automatically linked. When one
tray is empty, the print job continues using the linked tray.

Tray [x] Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Glossy
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of paper loaded in each tray.

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type [x] is
the factory default setting for all other trays.

• If available, a user‑defined name appears instead of Custom Type [x].

• Use this menu to configure automatic tray linking.

• Transparency is supported only in the 250‑sheet tray.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Multipurpose Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the paper size loaded in the multipurpose feeder.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory
default setting.

• The menu item applies only when the multipurpose feeder is installed.

• The multipurpose feeder does not automatically detect paper size. The
paper size value must be set.

Multipurpose Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Glossy
Labels
Bond
Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type loaded in the multipurpose feeder.

Note: Custom Type [x] is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the size of the paper being manually loaded.

Note: Letter is the U.S. factory default setting. A4 is the international factory
default setting.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Glossy
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type being manually loaded.

Note: Plain Paper is the factory default setting.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the envelope size being manually loaded.

Note: 10 Envelope is the U.S. factory default setting. DL Envelope is the
international factory default setting.

Manual Envelope Type
Envelope
Custom Type [x]

Specify the envelope type being manually loaded.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Substitute Size menu

Use To

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitute a specified paper size if the requested paper size is not available.

Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• Off indicates that no size substitutions are allowed.

• Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu

Use To

Plain Texture
Smooth
Normal
Rough

Specify the relative texture of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Texture
Smooth
Normal
Rough

Specify the relative texture of the card stock loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if card stock is supported.

Transparency Texture
Smooth
Normal
Rough

Specify the relative texture of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Texture
Smooth
Normal
Rough

Specify the relative texture of the recycled paper loaded.

Note: Normal is the factory default setting.

Glossy Texture
Smooth
Normal
Rough

Specify the relative texture of the glossy paper loaded.

Note: Normal is the factory default setting.

Heavy Glossy Texture
Smooth
Normal
Rough

Specify the relative texture of the heavy glossy paper loaded.

Note: Normal is the factory default setting.

Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the labels loaded.

Note: Normal is the factory default setting.
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Use To

Bond Texture
Smooth
Normal
Rough

Specify the relative texture of the bond paper loaded.

Note: Rough is the factory default setting.

Envelope Texture
Smooth
Normal
Rough

Specify the relative texture of the envelopes loaded.

Note: Normal is the factory default setting.

Letterhead Texture
Smooth
Normal
Rough

Specify the relative texture of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Texture
Smooth
Normal
Rough

Specify the relative texture of the preprinted paper loaded.

Note: Normal is the factory default setting.

Colored Texture
Smooth
Normal
Rough

Specify the relative texture of the colored paper loaded.

Note: Normal is the factory default setting.

Light Texture
Smooth
Normal
Rough

Specify the relative texture of the light paper loaded.

Note: Normal is the factory default setting.

Heavy Texture
Smooth
Normal
Rough

Specify the relative texture of the heavy paper loaded.

Note: Normal is the factory default setting.

Rough/Cotton Texture
Rough

Specify the relative texture of the cotton paper loaded.

Custom [x] Texture
Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if custom type is supported.
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Paper Weight menu

Use To

Plain Weight
Light
Normal
Heavy

Specify the relative weight of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Weight
Light
Normal
Heavy

Specify the relative weight of the card stock loaded.

Note: Normal is the factory default setting.

Transparency Weight
Light
Normal
Heavy

Specify the relative weight of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Weight
Light
Normal
Heavy

Specify the relative weight of the recycled paper loaded.

Note: Normal is the factory default setting.

Glossy Weight
Light
Normal
Heavy

Specify the relative weight of the glossy paper loaded.

Note: Normal is the factory default setting.

Heavy Glossy Weight
Light
Normal
Heavy

Specify the relative weight of the heavy glossy paper loaded.

Note: Normal is the factory default setting.

Labels Weight
Light
Normal
Heavy

Specify the relative weight of the labels loaded.

Note: Normal is the factory default setting.

Bond Weight
Light
Normal
Heavy

Specify the relative weight of the bond paper loaded.

Note: Normal is the factory default setting.

Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the envelope loaded.

Note: Normal is the factory default setting.

Rough Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the rough envelope loaded.

Note: Heavy is the factory default setting.
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Use To

Letterhead Weight
Light
Normal
Heavy

Specify the relative weight of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Weight
Light
Normal
Heavy

Specify the relative weight of the preprinted paper loaded.

Note: Normal is the factory default setting.

Colored Weight
Light
Normal
Heavy

Specify the relative weight of the colored paper loaded.

Note: Normal is the factory default setting.

Light Weight
Light

Specify that the relative weight of the paper loaded is light.

Heavy Weight
Heavy

Specify that the relative weight of the paper loaded is heavy.

Rough/Cotton Weight
Light
Normal
Heavy

Specify the relative weight of the rough or cotton paper loaded.

Note: Normal is the factory default setting.

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only when the custom type is supported.

Paper Loading menu

Use To

Cardstock Loading
Off

Determine and set two‑sided printing for all print jobs that specify
Cardstock as the paper type.

Recycled Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Recycled as the paper type.

Glossy Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Glossy as the paper type.

Notes:

• Duplex sets the printer default to two‑sided printing for every print job unless one‑sided printing is selected from
Printing Preferences or the Print dialog.

• Off is the factory default setting for all the menus.
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Use To

Heavy Glossy Loading
Off

Determine and set two‑sided printing for all print jobs that specify
Heavy Glossy as the paper type.

Labels Loading
Off

Determine and set two‑sided printing for all print jobs that specify
Labels as the paper type.

Bond Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Bond as the paper type.

Letterhead Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Letterhead as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Preprinted as the paper type.

Colored Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Colored as the paper type.

Light Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Light as the paper type.

Heavy Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Heavy as the paper type.

Rough/Cotton Loading
Off

Determine and set two‑sided printing for all print jobs that specify
Rough/Cotton as the paper type.

Custom [x] Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Custom [x] as the paper type.

Note: Custom [x] Loading is available only when the custom type is
supported.

Notes:

• Duplex sets the printer default to two‑sided printing for every print job unless one‑sided printing is selected from
Printing Preferences or the Print dialog.

• Off is the factory default setting for all the menus.
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Custom Types menu

Use To

Custom Type [x]
Paper
Card Stock
Transparency
Glossy
Rough/Cotton
Labels
Envelope

Associate a paper or specialty media type with a factory default Custom Type [x]
name or a user‑defined custom name created in the Embedded Web Server or
MarkVisionTM Professional.

Notes:

• Paper is the factory default setting for Custom Type [x].

• The custom media type must be supported in the selected tray or feeder
in order to print from that source.

Recycled
Paper
Card Stock
Transparency
Glossy
Rough/Cotton
Labels
Envelope

Specify a paper type when Recycled is selected.

Notes:

• Paper is the factory default setting.

• The Recycled paper type must be supported in the selected tray or
feeder in order to print from that source.

Custom Scan Sizes menu

Use To

Custom Scan Size [x]
Scan Size Name
Width

1–8.5 inches (25–215.9 mm)
Height

1–14 inches (25–355.6 mm)
Orientation

Portrait
Landscape

2 scans per side
Off
On

Specify a custom scan size name, scan sizes, and options.

Notes:

• The custom scan size name replaces Custom Scan Size [x] in the printer
menus.

• 8.5 inches is the U.S. factory default setting for Width. 210 millimeters is
the international factory default setting.

• 14 inches is the U.S. factory default setting for Height. 297 millimeters is
the international factory default setting.

• Portrait is the factory default setting for Orientation.

• Off is the factory default setting for “2 scans per side.”

Universal Setup menu

Use To

Units of Measure
Inches
Millimeters

Specify the unit of measure.

Note: Inches is the U.S. factory default setting. Millimeters is the
international factory default setting.
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Use To

Portrait Width
3–8.5 inches
76–215.9 mm

Set the width for portrait orientation.

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the U.S. factory default setting. You can increase the
width in 0.01‑inch increments.

• 215.9 mm is the international factory default setting. You can
increase the width in 1‑mm increments.

Portrait Height
3–14.17 inches
76–360 mm

Set the height for portrait orientation.

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the U.S. factory default setting. You can increase the
height in 0.01‑inch increments.

• 356 mm is the international factory default setting. You can increase
the height in 1‑mm increments.

Reports menu

Reports menu

Use To

Menu Settings Page Print a report containing information about the paper loaded into trays, installed
memory, total page count, alarms, timeouts, printer control panel language,
TCP/IP address, status of supplies, status of the network connection, and other
information.

Device Statistics Print a report containing printer statistics such as supply information and details
about printed pages.

Network Setup Page Print a report containing information about the network printer settings, such as
the TCP/IP address information.

Note: This menu item appears only in printers connected to an Ethernet
network or printers connected to print servers.

Network [x] Setup Page Print a report containing information about the network printer settings, such as
the TCP/IP address.

Note: This menu item appears only in printers connected to a wireless network
or printers with a wireless network adapter installed.

Shortcut List Print a report containing information about configured shortcuts.

E‑mail Shortcuts Print a report containing information about e‑mail shortcuts.

FTP Shortcuts Print a report containing information about FTP shortcuts.

Profiles List Print a list of profiles stored in the printer.
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Use To

Print Fonts Print a report of all the fonts available for the printer language currently set in
the printer.

Asset Report Print a report containing asset information including the printer serial number
and model name. The report contains text and UPC bar codes that can be scanned
into an asset database.

Network/Ports

Active NIC menu

Use To

Active NIC
Auto
[list of available network cards]

Allow the printer to connect to a network.

Notes:

• Auto is the factory default setting.

• This menu item appears only if an optional network adapter is installed.

Standard Network or Network [x] menu
Note: Only active ports appear in this menu.

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• If PCL SmartSwitch is enabled, then the printer uses PostScript emulation.

• If PCL SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job requires it,
regardless of the default printer language.

Notes:

• On is the factory default setting.

• If PS SmartSwitch is enabled, then the printer uses PostScript emulation.

• If PS SmartSwitch is disabled, then the printer does not examine incoming
data and it uses the default printer language specified in the Setup menu.
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Use To

NPA Mode
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Network Buffer
Disabled
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.

Notes:

• Auto is the factory default setting.

• The value can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

Standard Network Setup OR
Network [x] Setup

Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Display and set the printer network settings.

Note: The Wireless menu appears only when the printer is connected to a wireless
network.

Reports menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Reports

• Network/Ports > Network [x] > Network [x] Setup > Reports

Use To

Print Setup Page Print a report containing information about the network printer settings, such as the TCP/IP address.
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Network Card menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > Network Card

• Network/Ports > Network [x] > Network [x] Setup > Network Card

Use To

View Card Status
Connected
Disconnected

View the connection status of the network card.

View Card Speed View the speed of an active network card.

Network Address
UAA
LAA

View the network addresses.

Job Timeout

0, 10–225 seconds

Set the amount of time it takes for a network print job to be canceled.

Notes:

• 90 seconds is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value between 1 and 9 is selected, then Invalid appears on the
display, and the value is not saved.

TCP/IP menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > TCP/IP

• Network/Ports > Network [x] > Network [x] Setup > TCP/IP

Note: This menu is available only in network printers or printers attached to print servers.

Use To

Set Hostname Set the current TCP/IP host name.

Note: This can be changed only from the Embedded Web Server.

IP Address View or change the current TCP/IP address.

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask View or change the current TCP/IP netmask.

Gateway View or change the current TCP/IP gateway.

Enable DHCP
On
Off

Specify the DHCP address and parameter assignment.

Note: On is the factory default setting.

Enable RARP
On
Off

Specify the RARP address assignment setting.

Note: Off is the factory default setting.

Understanding the printer menus 92

http://www.manualsbase.com


More user manuals on ManualsBase.com

Use To

Enable BOOTP
On
Off

Specify the BOOTP address assignment setting.

Note: On is the factory default setting.

Enable AutoIP
Yes
No

Specify the Zero Configuration Networking setting.

Note: Yes is the factory default setting.

Enable FTP/TFTP
Yes
No

Enable the built-in FTP server, which lets you send files to the printer using File Transfer
Protocol.

Note: Yes is the factory default setting.

Enable HTTP Server
Yes
No

Enable the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a Web browser.

Note: Yes is the factory default setting.

WINS Server Address View or change the current WINS server address.

Enable DDNS
Yes
No

View or change the current DDNS setting.

Note: Yes is the factory default setting.

Enable mDNS
Yes
No

View or change the current mDNS setting.

Note: Yes is the factory default setting.

DNS Server Address View or change the current DNS server address.

Backup DNS Server Address View or change the backup DNS server addresses.

Backup DNS Server Address 2

Backup DNS Server Address 3

Enable HTTPS
Yes
No

View or change the current HTTPS setting.

Note: Yes is the factory default setting.

IPv6 menu
To access the menu, navigate to any of the following:

• Network/Ports menu > Standard Network > Standard Network Setup >IPv6

• Network/Ports menu > Network [x] > Network [x] Setup > IPv6

Note: This menu is available only in network printers or printers that are attached to print servers.

Use To

Enable IPv6
On
Off

Enable IPv6 in the printer.

Note: On is the factory default setting.
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Use To

Auto Configuration
On
Off

Specify whether or not the network adapter accepts the automatic IPv6
address configuration entries provided by a router.

Note: On is the factory default setting.

Set Hostname Set the host name.

Note: These settings can be changed only from the Embedded Web
Server.

View Address

View Router Address

Enable DHCPv6
On
Off

Enable DHCPv6 in the printer.

Note: On is the factory default setting.

Wireless menu
Note:  This menu is available only in printers connected to a wireless network or printer models that have a wireless
network adapter.

To access the menu, navigate to:

Network/Ports > Network [x] > Network [x] Setup > Wireless

Use To

Wi‑Fi Protected Setup
Start Push Button Method
Start PIN Method

Establish a wireless network and enable network security.

Notes:

• Start Push Button Method connects the printer to a wireless
network when buttons on both the printer and the access point
(wireless router) are pressed within a given period of time.

• Start PIN Method connects the printer to a wireless network when
a PIN on the printer is entered into the wireless settings of the
access point.

Enable/Disable WPS Auto‑detection
Enable
Disable

Automatically detect the connection method that an access point with
WPS uses—Start Push Button Method or Start PIN Method.

Note: Disable is the factory default setting.

Network Mode

BSS Type
Infrastructure
Ad hoc

Specify the network mode.

Notes:

• Infrastructure is the factory default setting. This lets the printer
access a network using an access point.

• Ad hoc configures wireless connection directly between the printer
and a computer.

Compatibility
802.11b/g
802.11b/g/n

Specify the wireless standard for the wireless network.

Note: 802.11b/g/n is the factory default setting.

Choose Network Select an available network for the printer to use.

View Signal Quality View the quality of the wireless connection.
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Use To

View Security Mode View the encryption method for the wireless network.

AppleTalk menu
Note: This menu appears only in printer models that are connected to an Ethernet network or when an optional
wireless network adapter is installed.

To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > AppleTalk

• Network/Ports > Network [x] > Network [x] Setup > AppleTalk

Use To

Activate
Yes
No

Enable or disable AppleTalk support.

Note: Yes is the factory default setting.

View Name Show the assigned AppleTalk name.

Note: The AppleTalk name can be changed only from the Embedded Web
Server.

View Address Show the assigned AppleTalk address.

Note: The AppleTalk address can be changed only from the Embedded Web
Server.

Set Zone
[list of zones available on the network]

Provide a list of AppleTalk zones available on the network.

Note: The default zone for the network is the factory default setting.

Standard USB menu

Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PostScript emulation if the PS SmartSwitch is set to On. It uses the default
printer language specified in the Setup menu if the PS SmartSwitch is set to
Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer uses
PCL emulation if the PCL SmartSwitch is set to On. It uses the default printer
language specified in the Setup menu if the PCL SmartSwitch is set to Off.
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Use To

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then process it appropriately.

• The printer automatically restarts when changing the setting from the printer
control panel. The menu selection is then updated.

USB Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the USB input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering.

• The USB buffer size value can be changed in 1-KB increments.

• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for USB Buffer, disable or reduce the size
of the parallel, serial, and network buffers.

• The printer automatically restarts when the setting is changed from the printer
control panel. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• On processes raw binary PostScript print jobs.

• Off filters print jobs using the standard protocol.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu is available only when the printer is attached to an external print
server through the USB port.
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SMTP Setup menu

Use To

Primary SMTP Gateway Specify SMTP server gateway and port information.

Note: 25 is the default SMTP gateway port.Primary SMTP Gateway Port

Secondary SMTP Gateway

Secondary SMTP Gateway Port

SMTP Timeout
5–30

Specify the amount of time in seconds before the server stops trying to
send an e‑mail.

Note: 30 seconds is the factory default setting.

Reply Address Specify a reply address of up to 128 characters in the e-mail sent by the
printer.

Use SSL
Disabled
Negotiate
Required

Set the printer to use SSL for increased security when connecting to the
SMTP server.

Notes:

• Disabled is the factory default setting.

• When the Negotiate setting is used, the SMTP server determines if
SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specify the type of user authentication required for scan to e‑mail
privileges.

Note: “No authentication required” is the factory default setting.

Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specify what credentials will be used when communicating to the SMTP
server.

Notes:

• None is the factory default setting for Device‑Initiated E‑mail.

• Device Userid and Device Password are used to log in to the SMTP
server when Use Device SMTP Credentials is selected.

Device Userid

Device Password
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Security menu

Confidential Print menu

Use To

Confidential Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a limit on how long the printer stores confidential print jobs in the printer memory.

Notes:

• If the Confidential Job Expiration setting is changed while confidential print jobs reside
in the printer memory, then the expiration time for those print jobs does not change to
the new default value.

• If the printer is turned off, then all confidential jobs held in the printer memory are
deleted.

Repeat Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a limit on how long the printer stores print jobs.

Verify Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a limit on how long the printer stores print jobs needing verification.

Reserve Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a limit on how long the printer stores print jobs for printing at a later time.

Note: Off is the factory default setting.

Security Audit Log menu

Use To

Export Log Let an authorized user export the security audit log.

Note: The log can be downloaded from the Embedded Web Server and saved on a
computer.

Delete Log
Yes
No

Specify whether audit logs are deleted.

Note: Yes is the factory default setting.
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Use To

Configure Log
Enable Audit

Yes
No

Enable Remote Syslog
No
Yes

Remote Syslog Facility
0–23

Severity of events to log
0–7

Specify how audit logs are configured.

Notes:

• Enable Audit determines if events are recorded in the secure audit log and
remote syslog. No is the factory default setting.

• Enable Remote Syslog determines if logs are sent to a remote server. No is the
factory default setting.

• Remote Syslog Facility determines the value used to send logs to the remote
syslog server. 4 is the factory default setting.

• If the security audit log is activated, then the severity value of each event is
recorded. 4 is the factory default setting.

Set Date and Time menu

Use To

Current Date and Time View the current date and time settings for the printer.

Manually Set Date and Time
[input date/time]

Enter the date and time.

Notes:

• Manually setting the date and time sets Enable NTP to No.

• The wizard lets you set the date and time in YYYY‑MM‑DD‑HH:MM format.

Time Zone
[list of time zones]

Select the time zone.

Note: GMT is the factory default settings.

Automatically observe DST
On
Off

Set the printer to use the applicable daylight saving time (DST) start and end times
associated with the printer Time Zone setting.

Note: On is the factory default setting.

Enable NTP
On
Off

Enable Network Time Protocol, which synchronizes the clocks of devices on a
network.

Notes:

• On is the factory default setting.

• This setting is turned off if you manually set the date and time.
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Settings menu

General Settings menu

Use To

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Set the language of the text appearing on the printer display.

Note: Not all languages are available for all printers, and you may
need to install special hardware for those languages to appear.

Show Supply Estimates
Show estimates
Do not show estimates

Display the estimates of the supplies on the printer control panel,
Embedded Web Server, menu settings, and device statistics
reports.

Note: “Show estimates” is the factory default setting.

Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimize the use of energy, paper, or specialty media.

Notes:

• Off is the factory default setting. This resets the printer to its
factory default settings.

• Energy minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• Energy/Paper minimizes the use of power and of paper and
specialty media.

• Paper minimizes the amount of paper and specialty media
needed for a print job. Performance may be affected, but
print quality is not.
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Use To

ADF Loaded Beep
Enabled
Disabled

Specify a custom beep when paper is loaded in the ADF.

Note: Enabled is the factory default setting.

Quiet Mode
Off
On

Reduce the amount of noise produced by the printer.

Notes:

• Off is the factory default setting. This supports the
performance specifications for your printer.

• On configures the printer to produce as little noise as
possible. This is best suited for printing text and line art.

• For optimal printing of color‑rich documents, set Quiet Mode
to Off.

• Selecting Photo from the printer driver may disable Quiet
Mode and provide better print quality and full‑speed
printing.

Run Initial setup
Yes
No

Run the setup wizard.

Notes:

• Yes is the factory default setting.

• After completing the setup wizard by selecting Done at the
country or region selection screen, the default becomes No.

Paper Sizes
US
Metric

Specify the default system of measurement for paper sizes.

Notes:

• US is the factory default setting.

• The initial setting is determined by your country or region
selection in the initial setup wizard.

Scan to PC Port Range
[port range]

Specify a valid port range for printers behind a port blocking
firewall. The valid ports are specified by two sets of numbers
separated by a semicolon.

Note: 9751:12000 is the factory default setting.

Home screen customization
Change Language
Copy
E‑mail shortcuts
FTP shortcuts
Search Held Jobs
Held jobs
Bookmarks
Jobs by user

Change the icons and buttons that appear on the home screen.

For each icon or button, select from the following options:
Display
Do not display

Notes:

• Display is the factory default setting for Copy, E‑mail, FTP,
Search Held Jobs, and Held jobs.

• “Do not display” is the factory default setting for Change
Language, E‑mail shortcuts, FTP shortcuts, Bookmarks, and
Jobs by user.

One Page Copy
Off
On

Set copies from the scanner to one page at a time.

Note: Off is the factory default setting.
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Use To

Allow Background Removal
On
Off

Specify whether image background removal is allowed in copy,
e‑mail, or FTP jobs.

Note: On is the factory default setting. The background of the
image will be removed.

Scanner Jam Recovery
Job Level
Page Level

Specify how a scan job should be reloaded if a paper jam occurs in
the ADF.

Note: Job Level is the factory default setting.

Alarms
Alarm Control
Cartridge Alarm

Set an alarm when the printer requires operator intervention.
When activated, Alarm Control lets you set the number of times
that the alarm sounds, while Cartridge Alarm lets you stop printing
when a cartridge‑low condition occurs.

For each alarm type, select from the following options:

• Off

• Single

• Continuous

Notes:

• Single is the factory default setting for Alarm Control. This
sounds three quick beeps.

• Off is the factory default setting for Cartridge Alarm. This
means no alarm will sound.

• Continuous repeats three beeps every 10 seconds.

Timeouts
Sleep Mode

Disabled
1–60 min

Set the amount of time the printer waits after a job is printed before
it goes into a reduced power state.

Notes:

• “30 min” is the factory default setting.

• Disabled appears only when Energy Conserve is set to Off.

• Lower settings conserve more energy, but may require
longer warm‑up times.

• Select a high setting if the printer is in constant use. Under
most circumstances, this keeps the printer ready to print
with minimum warm‑up time.

Timeouts
Hibernate Timeout

Disabled
1–3 hours
6 hours
1–3 days
1–2 weeks
1 month

Set the printer to operate at a low power state.

Notes:

• Disabled is the factory default setting for Class A and Class B
printers except in European Union countries, Canada, and
Switzerland.

• “3 days” is the factory default setting for Class B printers in
all European Union countries and Switzerland.

Timeouts
Screen Timeout

15–300 sec

Set the amount of time in seconds the printer waits before
returning the display to the Ready state.

Note: “30 sec” is the factory default setting.
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Timeouts
Print Timeout

Disabled
1–255 sec

Set the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print
job.

Notes:

• “90 sec” is the factory default setting.

• When the timer expires, any partially printed page still in the
printer is printed, and then the scanner checks to see if any
new print jobs are waiting.

• Print Timeout is available only when using PCL emulation.
This setting has no effect on PostScript emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535 sec

Set the amount of time in seconds the printer waits for additional
data before canceling a print job.

Notes:

• “40 sec” is the factory default setting.

• Wait Timeout is available only when the scanner is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.

Error Recovery
Auto Reboot

Reboot when idle
Reboot always
Reboot never

Set the printer to restart when an error is encountered.

Note: “Reboot always” is the factory default setting.

Error Recovery
Max Auto Reboots

1–20

Determine the number of automatic reboots the printer can
perform.

Notes:

• 5 is the factory default setting.

• If the printer performs a number of automatic reboots that is
the same as the menu setting within a certain amount of
time, then the printer shows the applicable error instead of
restarting.

Print Recovery
Auto Continue

Disabled
5–255

Let the printer automatically continue printing from certain offline
situations when these are not resolved within the specified time
period.

Note: Disabled is the factory default setting.

Print Recovery
Jam Recovery

On
Off
Auto

Specify whether the printer reprints jammed pages.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.

Understanding the printer menus 103

http://www.manualsbase.com


More user manuals on ManualsBase.com

Use To

Print Recovery
Page Protect

Off
On

Let the printer successfully print a page that may not have printed
otherwise.

Notes:

• Off is the factory default setting. This prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.

Hibernate Timeout on Connection
Hibernate
Do Not Hibernate

Set the printer to hibernate mode even when there is an active
Ethernet connection.

Note: Do Not Hibernate is the factory default setting.

Press Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a short
press of the Sleep button.

Note: Sleep is the factory default setting.

Press and Hold Sleep Button
Do Nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a long press
of the Sleep button.

Note: Do Nothing is the factory default setting.

Factory Defaults
Do Not Restore
Restore Now

Restore printer settings to its factory defaults.

Notes:

• Do Not Restore is the factory default setting. This keeps the
user‑defined settings.

• Restore Now returns all scanner settings to the factory
default settings except Network/Ports menu settings. All
downloads stored in the RAM are deleted.

Custom Home Message
Off
IP Address
Hostname
Contact Name
Location
Zero Configuration Name
Custom Text [x]

Show information pertaining to the selected Custom Home
Messages on the printer display.

Copy Settings menu

Use To

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.

Note: Text/Photo is the factory default setting.
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Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document is produced.

Note: Color Laser is the factory default setting.

Color
On
Off

Specify whether copies are printed in color.

Note: On is the factory default setting.

Allow color copies
On
Off

Enable color in copies.

Notes:

• On is the factory default setting.

• Setting this to Off will hide all color‑specific menus.

• This setting overrides the Color setting.

Sides (Duplex)
1 sided to 1 sided
1 sided to 2 sided
2 sided to 1 sided
2 sided to 2 sided

Specify whether an original document is two‑sided (duplex) or one‑sided, and then
specify whether the copy should be two‑sided or one‑sided.

Notes:

• 1 sided to 1 sided—The original document has print on one side, and the copy
will also have print on one side.

• 1 sided to 2 sided—The original document has print on one side, while the
copy will have print on both sides.

• 2 sided to 1 sided—The original document has print on both sides, while the
copy will have print on just one side.

• 2 sided to 2 sided—The original document has print on both sides, and the
copy will also have print on both sides.

Paper Saver
Off
2‑up Portrait
4‑up Portrait
2‑up Landscape
4‑up Landscape

Allow copying of two or four sheets of a document on one page.

Note: Off is the factory default setting.

Print Page Borders
On
Off

Allow page borders in printed copies.

Note: Off is the factory default setting.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Keep the pages of a print job stacked in sequence when printing multiple copies.

Note: “(1,2,3) (1,2,3)” is the factory default setting.
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Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Mixed Sizes
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.
ID Card

Specify the paper size of the original document.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory default
setting.

• Legal, Folio, and Oficio (Mexico) paper sizes are supported only in the ADF.

Copy To Source
Tray [x]
MP Feeder
Manual Feeder

Specify the paper source for copy jobs.

Note: Tray 1 is the factory default setting.

Transparency Separators
On
Off

Place a sheet of paper between transparencies.

Note: On is the factory default setting.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Place a sheet of paper between pages, copies, or jobs.

Note: Off is the factory default setting.

Separator Sheet Source
Tray [x]
MP Feeder

Specify the paper source for the separator sheet.

Note: Tray 1 is the factory default setting.

Darkness
1–9

Specify the level of darkness for the copy job.

Note: 5 is the factory default setting.

Number of Copies
1–999

Specify the number of copies for the copy job.

Note: 1 is the factory default setting.
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Overlay
Confidential
Copy
Draft
Urgent
Custom
Off

Specify the overlay text printed on each page of the copy job.

Note: Off is the factory default setting.

Allow priority copies
On
Off

Allow interruption of a print job to copy a page or document.

Note: On is the factory default setting.

Background Removal
‑4 to 4

Adjust the amount of background visible on a copy.

Note: 0 is the factory default setting.

Auto Center
Off
On

Automatically center the content on the page.

Note: Off is the factory default setting.

Color Dropout
Color Dropout

None
Red
Green
Blue

Default Red Threshold
0–255

Default Green Threshold
0–255

Default Blue Threshold
0–255

Specify which color to drop during scanning and to adjust the dropout setting for each
color threshold.

Notes:

• None is the factory default setting for Color Dropout.

• 128 is the factory default setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast used for the copy job.

Note: “Best for content” is the factory default setting.

Mirror Image
Off
On

Create a mirror image of the original document.

Note: Off is the factory default setting.

Negative Image
Off
On

Create a negative image of the original document.

Note: Off is the factory default setting.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a copy.

Note: 0 is the factory default setting.

Scan edge to edge
Off
On

Allow edge-to-edge scanning of the original document.

Note: Off is the factory default setting.
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Sharpness
1–5

Adjust the amount of sharpness of a copy.

Note: 3 is the factory default setting.

Temperature
‑4 to 4

Enable the user to specify “warm” or “cool” outputs.

Note: "Cool” values generate a bluer output than the default, while “warm” values
generate a redder output than the default.

E‑mail Settings menu

Use To

E‑mail Server Setup
Send me a copy

Never appears
On by default
Off by default
Always On

Send a copy of the e-mail to the sender.

Note: “Never appears” is the factory default setting.

E‑mail Server Setup
Max E‑mail size

0–65535 KB

Specify the maximum e-mail size in kilobytes (KB).

Note: E-mails greater than the specified maximum size are not sent.

Format
PDF (.pdf)
Secure PDF
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)

Specify the format of the scanned file.

Note: “PDF (.pdf)” is the factory default setting.

PDF Version
1.2–1.6
A–1a

Set the version of the PDF file that will be scanned for e‑mailing.

Note: 1.5 is the factory default setting.

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.

Note: Text/Photo is the factory default setting.

Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document is produced.

Note: Color Laser is the factory default setting.

Understanding the printer menus 108

http://www.manualsbase.com


More user manuals on ManualsBase.com

Use To

Color
Off
On

Specify whether to print copies in color.

Note: On is the factory default setting.

Resolution
75 dpi
150 dpi
200 dpi
300 dpi
400 dpi
600 dpi

Specify the resolution of the scan in dots per inch.

Note: “150 dpi” is the factory default setting.

Darkness
1–9

Adjust the darkness of the output.

Note: 5 is the factory default setting.

Orientation
Portrait
Landscape

Specify the orientation of the scanned image.

Note: Portrait is the factory default setting.

Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Mixed Sizes
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.

Specify the paper size of the document being scanned.

Notes:

• A4 is the international factory default setting. Letter is the U.S. factory default
setting.

• Legal, Folio, and Oficio (Mexico) paper sizes are supported only in the ADF.

Sides (Duplex)
Off
Long edge
Short edge

Specify how the text and graphics are oriented on the page.

Notes:

• Off is the factory default setting.

• “Long edge” assumes binding along the long edge of the page (left edge for
portrait and top edge for landscape).

• “Short edge” assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).
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JPEG Quality
Best for content
5–90

Set the quality of a JPEG photo image in relation to file size and quality of the image.

Notes:

• “Best for content” is the factory default setting.

• 5 reduces the file size and quality of the image.

• 90 provides the best image quality, but the file size is very large.

• This menu item applies to all scan functions.

Text Default
5–90

Set the quality of a text image in relation to file size and quality of the image.

Note: 75 is the factory default setting.

Text/Photo Default
5–90

Set the quality of a text or photo image in relation to file size and quality of the image.

Note: 75 is the factory default setting.

Photo Default
5–90

Set the quality of a photo image in relation to file size and quality of the image.

Note: 50 is the factory default setting.

E‑mail images sent as
Attachment
Web Link

Specify how the images are sent.

Note: Attachment is the factory default setting.

Use Multi‑Page TIFF
On
Off

Provide a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan‑to‑e-mail job, either one TIFF file is created containing all the
pages, or multiple TIFF files are created with one file for each page of the job.

Notes:

• On is the factory default setting.

• This menu item applies to all scan functions.

Transmission Log
Print log
Do not print log
Print only for error

Specify whether or not the transmission log prints.

Note: “Print log” is the factory default setting.

Log Paper Source
Tray [x]
Manual Feeder

Specify the paper source for printing e-mail logs.

Note: Tray 1 is the factory default setting.

E‑mail Bit Depth
1 bit
8 bit

Enable the Text/Photo mode to produce smaller file sizes by using 1‑bit images when
Color is set to Off.

Note: “8 bit” is the factory default setting.

Allow Save as Shortcut
On
Off

Save e-mail addresses as shortcuts.

Notes:

• On is the factory default setting.

• When set to Off, the “Save as Shortcut” button does not appear on the e-mail
destination screen.

Background Removal
‑4 to 4

Adjust the amount of background visible on a scanned image.

Note: 0 is the factory default setting.
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Color Dropout
Color Dropout

None
Red
Green
Blue

Default Red Threshold
0–255

Default Green Threshold
0–255

Default Blue Threshold
0–255

Specify which color to drop during scanning, and how much the dropout is increased
or decreased.

Notes:

• None is the factory default setting for Color Dropout.

• 128 is the factory default setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast of the output.

Note: “Best for content” is the factory default setting.

Mirror Image
Off
On

Create a mirror image of the original document.

Note: Off is the factory default setting.

Negative Image
Off
On

Create a negative image of the original document.

Note: Off is the factory default setting.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a scanned image.

Note: 0 is the factory default setting.

Scan edge to edge
Off
On

Allow edge-to-edge scanning of the original document.

Note: Off is the factory default setting.

Sharpness
1–5

Adjust the amount of sharpness on a scanned image.

Note: 3 is the factory default setting.

Temperature
‑4 to 4

Enable the user to specify “warm” or “cool” outputs.

Note: "Cool” values generate a bluer output than the default while “warm” values
generate a redder output than the default.

Use cc:/bcc:
Off
On

Enable the use of the “cc” and “bcc” fields.

Note: Off is the factory default setting.
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Use To

Format
PDF (.pdf)
Secure PDF
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)

Specify the format of the file for FTP sending.

Note: “PDF (.pdf)” is the factory default setting.

PDF Version
1.2–1.6
A–1a

Set the version level of the PDF file for FTP sending.

Note: 1.5 is the factory default setting.

Content Type
Text
Graphics
Text/Photo
Photo

Specify the content of the original document.

Note: Text/Photo is the factory default setting.

Content Source
Black/White Laser
Color Laser
Inkjet
Photo/Film
Magazine
Newspaper
Press
Other

Specify how the original document is produced.

Note: Color Laser is the factory default setting.

Color
Off
On

Specify whether to print copies in color.

Note: On is the factory default setting.

Resolution
75 dpi
150 dpi
200 dpi
300 dpi
400 dpi
600 dpi

Specify the quality of the scan in dots per inch (dpi).

Note: “150 dpi” is the factory default setting.

Darkness
1–9

Adjust the darkness of the output.

Note: 5 is the factory default setting.

Orientation
Portrait
Landscape

Specify the orientation of the scanned image.

Note: Portrait is the factory default setting.
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Original Size
Letter
Legal
Executive
Folio
Statement
Oficio (Mexico)
Universal
Mixed Sizes
A4
A5
A6
JIS B5
Custom Scan Size [x]
Book Original
Business Card
3 x 5 in.
4 x 6 in.

Specify the paper size of the original document.

Notes:

• Letter is the U.S. factory default setting. A4 is the international factory default
setting.

• Legal, Folio, and Oficio (Mexico) paper sizes are supported only in the ADF.

Sides (Duplex)
Off
Long edge
Short edge

Specify how the text and graphics are oriented on the page.

Notes:

• Off is the factory default setting.

• “Long edge” sets binding along the long edge of the page (left edge for
portrait and top edge for landscape).

• “Short edge” sets binding along the short edge of the page (top edge for
portrait and left edge for landscape).

JPEG Quality
Best for content
5–90

Set the quality of a JPEG photo image in relation to file size and the quality of the
image.

Notes:

• “Best for content” is the factory default setting.

• 5 reduces the image quality and the file size.

• 90 produces the best image quality at an increased file size.

• This menu item applies to all scan functions.

Text Default
5–90

Set the quality of the text in relation to the size and quality of the image.

Note: 75 is the factory default setting.

Text/Photo Default
5–90

Set the quality of a text or photo image in relation to the size and quality of the image.

Note: 75 is the factory default setting.

Photo Default
5–90

Set the quality of a photo image in relation to the size and quality of the image.

Note: 50 is the factory default setting.
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Use Multi‑Page TIFF
On
Off

Choose between single-page TIFF files and multiple‑page TIFF files.

For a multiple-page scan‑to‑FTP job, either one TIFF file is created containing all the
pages, or multiple TIFF files are created with one file for each page of the job.

Notes:

• On is the factory default setting.

• This menu item applies to all scan functions.

Transmission Log
Print log
Do not print log
Print only for error

Specify whether or not the transmission log prints.

Note: “Print log” is the factory default setting.

Log Paper Source
Tray [x]
Manual Feeder

Specify a paper source when printing FTP logs.

Note: Tray 1 is the factory default setting.

FTP bit Depth
8 bit
1 bit

Enable the Text/Photo mode to have smaller file sizes by using 1‑bit images when
Color is set to Off.

Note: “8 bit” is the factory default setting.

Custom Job Scanning
On
Off

Copy a document that contains mixed paper sizes into a single scan job.

Note: Off is the factory default setting.

Allow Save as Shortcut
On
Off

Enable shortcut creation for FTP addresses.

Note: On is the factory default setting.

Background Removal
‑4 to 4

Adjust the amount of background visible on a copy.

Note: 0 is the factory default setting.

Color Dropout
Color Dropout

None
Red
Green
Blue

Default Red Threshold
0–255

Default Green Threshold
0–255

Default Blue Threshold
0–255

Specify which color to drop during scanning, and how much the dropout is increased
or decreased.

Notes:

• None is the factory default setting for Color Dropout.

• 128 is the factory default setting for each color threshold.

Contrast
0–5
Best for content

Specify the contrast of the output.

Note: “Best for content” is the factory default setting.
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Mirror Image
Off
On

Create a mirror image of the original document.

Note: Off is the factory default setting.

Negative Image
Off
On

Create a negative image of the original document.

Note: Off is the factory default setting.

Shadow Detail
‑4 to 4

Adjust the amount of shadow detail visible on a scanned image.

Note: 0 is the factory default setting.

Scan edge to edge
Off
On

Allow edge-to-edge scanning of the original document.

Note: Off is the factory default setting.

Sharpness
1–5

Adjust the amount of sharpness of a scanned image

Note: 3 is the factory default setting.

Print Settings

Setup menu

Use To

Printer Language
PCL Emulation
PS Emulation

Set the default printer language.

Notes:

• PS Emulation is the factory default setting. PS Emulation uses
a PS interpreter for processing print jobs.

• PCL Emulation uses a PCL interpreter for processing print
jobs.

• Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.

Print Area
Normal
Fit To Page
Whole Page

Set the logical and physical printable area.

Notes:

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image.

• Fit To Page fits the page content into the selected paper size.

• Whole Page allows the image to be moved into the
non‑printable area defined by the Normal setting, but the
printer clips the image at the Normal setting boundary. This
setting affects only pages printed using a PCL 5e interpreter
and has no effect on pages printed using the PCL XL or
PostScript interpreter.
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Printer Usage
Max Yield
Max Speed

Set color toner use in printing.

Note: Max Yield is the factory default setting.

Black Only Mode
On
Off

Set the printer to print text and graphics using only the black toner
cartridge.

Note: Off is the factory default setting.

Resource Save
On
Off

Specify how the printer handles temporary downloads, such as
fonts and macros stored in the RAM, when the printer receives a
job that requires more than the available memory.

Notes:

• Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• On sets the printer to retain downloads during language
changes and printer resets. If the printer runs out of
memory, then Memory full [38] appears, but
downloads are not deleted.

Finishing menu

Use To

Sides (Duplex)
1 sided
2 sided

Specify whether two‑sided (duplex) printing is set as the default for all print jobs.

Notes:

• “1 sided” is the factory default setting.

• You can set two‑sided printing from the printer software.
For Windows users:

Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:

Choose File > Print, and then adjust the settings from the Print dialog and pop‑up
menus.

Duplex Binding
Long Edge
Short Edge

Define binding for duplexed pages in relation to page orientation.

Notes:

• Long Edge is the factory default setting. This assumes binding along the long
edge of the page (left edge for portrait and top edge for landscape).

• Short Edge assumes binding along the short edge of the page (top edge for
portrait and left edge for landscape).

Copies
1–999

Specify the default number of copies for each print job.

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify whether blank pages are inserted in a print job.

Note: Do Not Print is the factory default setting.
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Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Note: “(1,2,3) (1,2,3)” is the factory default setting.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether blank separator sheets are inserted.

Notes:

• Off is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to “(1,2,3) (1,2,3).” If Collate is set to “(1,1,1) (2,2,2),” then a
blank page is inserted between each set of printed pages, such as after all
page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of a print job. This
setting is useful when printing transparencies or when inserting blank pages in
a document.

Separator Source
Tray [x]
Multipurpose Feeder

Specify the paper source for the separator sheet.

Note: Tray 1 (standard tray) is the factory default setting.

Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Print multiple pages on a single sheet of paper.

Notes:

• Off is the factory default setting.

• When the number of pages per sheet is selected, each page is scaled so that
the number of pages you want can be displayed on the sheet.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the order in which pages are printed on a single sheet when using Paper Saver.

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they are in
portrait or in landscape orientation.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation in which pages are printed on a single sheet.

Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.

Paper Saver Border
None
Solid

Print a border when using Paper Saver.

Note: None is the factory default setting.
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Quality menu

Use To

Print Mode
Color
Black Only

Specify whether images are printed in black and white or in color.

Notes:

• Color is the factory default setting.

• The printer driver is capable of overriding this setting.

Color Correction
Auto
Off
Manual

Adjust the color output on the printed page.

Notes:

• Auto is the factory default setting. This applies different color conversion tables
to each object on the printed page.

• Off turns off color correction.

• Manual allows customization of the color tables using the settings available from
the Manual Color menu.

• Due to the differences in additive and subtractive colors, certain colors that
appear on computer monitors are impossible to duplicate on the printed page.

Print Resolution
1200 dpi
4800 CQ

Specify the printed output resolution in dots per inch or in color quality (CQ).

Note: 4800 CQ is the factory default setting.

Toner Darkness
1–5

Lighten or darken the printed output.

Notes:

• 4 is the factory default setting.

• Selecting a smaller number can help conserve toner.

Enhance Fine Lines
On
Off

Enable a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts.

Notes:

• Off is the factory default setting.

• To set this option using the Embedded Web Server, type the network printer IP
address in the Web browser address field.

• You can set this option from the software program.
For Windows users:

Click File > Print, and then click Properties, Preferences, Options, or Setup.
For Macintosh users:

Choose File > Print, and then adjust the settings from the Print dialog and pop‑up
menus.

Color Saver
On
Off

Reduce the amount of toner used for graphics and images. The amount of toner used
for text is not reduced.

Notes:

• Off is the factory default setting.

• On overrides Toner Darkness settings.
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RGB Brightness
‑6 to 6

Adjust the printed output either by lightening or darkening it. You can conserve toner
by lightening the output.

Note: 0 is the factory default setting.

RGB Contrast
0–5

Adjust the contrast of printed objects.

Note: 0 is the factory default setting.

RGB Saturation
0–5

Adjust saturation in color outputs.

Note: 0 is the factory default setting.

Color Balance
Cyan
‑5 to 5

Magenta
‑5 to 5

Yellow
‑5 to 5

Black
‑5 to 5

Reset Defaults

Adjust color in printed output by increasing or decreasing the amount of toner being
used for each color.

Note: 0 is the factory default setting.

Color Samples
sRGB Display
sRGB Vivid
Display—True Black
Vivid
Off—RGB
US CMYK
Euro CMYK
Vivid CMYK
Off—CMYK

Print sample pages for each of the RGB and CMYK color conversion tables used in the
printer.

Notes:

• Selecting any setting prints the sample.

• Color samples consist of a series of colored boxes along with the RGB or CMYK
combination that creates the color observed. These pages can be used to help
decide which combinations to use to get the printed output you want.

• To access a complete list of color sample pages using the Embedded Web Server,
type the network printer IP address in the Web browser address field.
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Use To

Manual Color
RGB Image
RGB Text
RGB Graphics

Customize the RGB color conversions.

Select from the following options:
Vivid
sRGB Display
Display—True Black
sRGB Vivid
Off

Notes:

• sRGB Display is the factory default setting for RGB Image. This applies a color
conversion table to an output that matches the colors displayed on a computer
monitor.

• sRGB Vivid is the factory default setting for RGB Text and RGB Graphics. This
applies a color table that increases saturation. This is preferred for business
graphics and text.

• Vivid applies a color conversion table that produces brighter, more saturated
colors.

• “Display—True Black” applies a color conversion table that uses only black toner
for neutral gray colors.

• Off turns off color conversion.

Manual Color (continued)
CMYK Image
CMYK Text
CMYK Graphics

Customize the CMYK color conversions.

Select from the following options:
US CMYK
Euro CMYK
Vivid CMYK
Off

Notes:

• US CMYK is the factory default setting. This applies a color conversion table that
tries to produce output that matches SWOP color output.

• Euro CMYK is the international factory default setting. This applies a color
conversion table that tries to produce output that matches Euroscale color
output.

• Vivid CMYK increases color saturation for the US conversion table.

• Off turns off color conversion.

Spot Color Replacement Assign specific CMYK values to named spot colors.

Note: This menu is available only in the Embedded Web Server.

Color Adjust Initiate a recalibration of color conversion tables and allow the printer to make
adjustments for color variations in output.

Notes:

• Adjusting color starts when the menu is selected. Adjusting color appears
on the display until the process is finished.

• Color variations in output sometimes result from changeable conditions such as
room temperature and humidity. Color adjustments are made on printer
algorithms. Color alignment is also recalibrated in this process.
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Utilities menu

Use To

Activate Hex Trace Assist in isolating the source of a print job problem.

Notes:

• When activated, all data sent to the printer is printed in hexadecimal and
character representation, and control codes are not executed.

• To exit or deactivate Hex Trace, turn off or reset the printer.

Coverage Estimator
Off
On

Provide an estimate of the percentage coverage of toner on a page. The estimate is
printed on a separate page at the end of each print job.

Note: Off is the factory default setting.

XPS menu

Use To

Print Error Pages
Off
On

Print a page containing information on errors, including XML markup errors.

Note: Off is the factory default setting.

PDF menu

Use To

Scale to Fit
Yes
No

Scale page content to fit the selected paper size.

Note: No is the factory default setting.

Annotations
Do Not Print
Print

Print annotations in a PDF.

Note: Do Not Print is the factory default setting.

PostScript menu

Use To

Print PS Error
On
Off

Print a page containing the PostScript error.

Note: Off is the factory default setting.

Lock PS Startup Mode
On
Off

Allow users to disable the SysStart file.

Note: Off is the factory default setting.
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Use To

Image Smoothing
On
Off

Enhance the contrast and sharpness of low‑resolution images and smoothen
their color transitions.

Notes:

• Off is the factory default setting.

• Image Smoothing has no effect on images that are 300 dpi or higher in
resolution.

PCL Emul menu

Use To

Font Source
Resident
Download
All

Specify the set of fonts used in the Font Name menu.

Notes:

• “Resident” is the factory default setting. It shows the factory default set
of fonts downloaded in the RAM.

• “Download” shows all the fonts downloaded in the RAM.

• “All” shows all fonts available to any option.

Font Name
Courier 10

Identify a specific font and where it is stored.

Note: Courier 10 is the factory default setting.

Symbol Set
10U PC‑8
12U PC‑850

Specify the symbol set for each font name.

Notes:

• 10U PC‑8 is the U.S. factory default setting. 12U PC‑850 is the
international factory default setting.

• A symbol set is a set of alphabetical and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs, such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Point Size

1.00–1008.00

Change the point size for scalable typographic fonts.

Notes:

• 12 is the factory default setting.

• Point size refers to the height of the characters in the font. One point
equals approximately 0.014 of an inch. This can be increased or decreased
in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100.00

Specify the font pitch for scalable monospaced fonts.

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi). This
can be increased or decreased in 0.01‑cpi increments.

• For non‑scalable monospaced fonts, the pitch appears on the display but
cannot be changed.
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Use To

PCL Emulation Settings
Orientation

Portrait
Landscape

Specify the orientation of text and graphics on a page.

Notes:

• Portrait is the factory default setting. It prints text and graphics parallel to
the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the page.

PCL Emulation Settings
Lines per Page

1–255

Specify the number of lines that print on each page.

Notes:

• 60 is the U.S. factory default setting. 64 is the international default
setting.

• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the paper size
and orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Set the printer to print on A4‑size paper.

Notes:

• 198 mm is the factory default setting.

• The 203‑mm setting sets the width of the page to allow the printing of
eighty 10‑pitch characters.

PCL Emulation Settings
Auto CR after LF

On
Off

Specify whether the printer automatically performs a carriage return (CR) after
a line feed (LF) control command.

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Note: Off is the factory default setting.

Tray Renumber
Assign Multipurpose Feeder

Off
None
0–199

Assign Tray [x]
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Manual Envelope
Off
None
0–199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Notes:

• “Off” is the factory default setting.

• “None” ignores the Select Paper Feed command. This option appears only
when it is selected by the PCL 5e interpreter.

• “0–199” allows a custom setting to be assigned.
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Use To

Tray Renumber
View Factory Defaults

MPF Default = 8
T1 Default = 1
T2 Default = 4
T3 Default = 5
T4 Default = 20
T5 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Show the factory default setting assigned to each tray or feeder.

Tray Renumber
Restore Defaults

Yes
No

Restore all tray and feeder assignments to the factory default settings.

HTML menu

Use To

Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text
Intl CG Times
Intl Courier
Intl Univers

Joanna MT
Letter Gothic
Lubalin Graph
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery
NewSansMTCS
NewSansMTCT
New SansMTJA
NewSansMTKO

Set the default font for HTML documents.

Note: The Times font is used in HTML documents that do not
specify a font.
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Use To

Font Size
1–255 pt

Set the default font size for HTML documents.

Notes:

• 12 pt is the factory default setting.

• Font size can be increased in 1‑point increments.

Scale
1–400%

Scale the default font for HTML documents.

Notes:

• 100% is the factory default setting.

• Scaling can be increased in 1% increments.

Orientation
Portrait
Landscape

Set the page orientation for HTML documents.

Note: Portrait is the factory default setting.

Margin Size
8–255 mm

Set the page margin for HTML documents.

Notes:

• 19 mm is the factory default setting.

• Margin size can be increased in 1‑mm increments.

Backgrounds
Do Not Print
Print

Specify whether to print backgrounds on HTML documents.

Note: Print is the factory default setting.

Image menu

Use To

Auto Fit
On
Off

Select the optimal paper size, scaling, and orientation.

Note: On is the factory default setting. It overrides scaling and orientation settings
for some images.

Invert
On
Off

Invert bitonal monochrome images.

Notes:

• Off is the factory default setting.

• This setting does not apply to GIF or JPEG images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scale the image to fit the selected paper size.

Notes:

• Best Fit is the factory default setting.

• When Auto Fit is set to On, Scaling is automatically set to Best Fit.
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Use To

Orientation
Portrait
Landscape
Reverse Portrait
Reverse Landscape

Set the image orientation.

Note: Portrait is the factory default setting.

Help menu
The Help menu consists of a series of Help pages that are stored in the multifunction printer (MFP) as PDF files. They
contain information about using the printer and performing various tasks, including copying, e‑mailing, and scanning.

English, French, German, and Spanish translations are stored in the printer.

Other translations are available on the Lexmark Web site at www.lexmark.com.

Menu item Description

Print All Guides Prints all the guides

Copy Guide Provides information about making copies and changing settings

E‑mail Guide Provides information about sending e‑mails using addresses or shortcut numbers,
and about changing settings

FTP Guide Provides information about scanning documents directly to an FTP server using an
FTP address, or shortcut numbers, and about changing settings

Color Quality Provides information about solving color quality issues

Print Defects Guide Provides help in resolving repeating defects in copies or prints

Information Guide Provides help in locating additional information

Supplies Guide Provides part numbers for ordering supplies
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Saving money and the environment
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

• The Notices chapter

• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

• The Lexmark recycling program at www.lexmark.com/recycle

By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter
outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner
Studies show that as much as 80% of the carbon footprint of a printer is related to paper usage. You can significantly
reduce your carbon footprint by using recycled paper and the following printing suggestions, such as printing on both
sides of the paper and printing multiple pages on one side of a single sheet of paper.

For information on how you can quickly save paper and energy using one printer setting, see “Using Eco‑Mode” on
page 128.

Using recycled paper
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser printers. For more information on recycled papers that work well with your printer, see “Using recycled
paper and other office papers” on page 49.

Conserving supplies
There are a number of ways you can reduce the amount of paper and toner you use when printing. You can:

Use both sides of the paper

If your printer model supports duplex printing, then you can control whether print appears on one or two sides of the
paper by selecting 2‑sided printing from the Print dialog or the Lexmark Toolbar.

Place multiple pages on one sheet of paper

You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper by
selecting a setting from the Multipage printing (N‑Up) section of the Print dialog screen.

Check your first draft for accuracy

Before printing or making multiple copies of a document:

• Use the preview feature, which you can select from the Print dialog or the Lexmark Toolbar, to see what the
document will look like before you print it.

• Print one copy of the document to check its content and format for accuracy.
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Avoid paper jams

Carefully select and load paper to avoid paper jams. For more information, see “Avoiding jams” on page 163.

Saving energy

Using Eco‑Mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Eco‑Mode >  > select the setting you want

Use To

Off Use the factory default settings for all settings associated with Eco‑Mode. This setting supports the
performance specifications for your printer.

Energy Reduce energy use, especially when the printer is idle.

Notes:

• Printer engine motors do not start until a job is ready to print. You may notice a short delay
before the first page is printed.

• The printer enters Sleep mode after one minute of inactivity.

Energy/Paper Use all the settings associated with Energy and Paper modes.

Plain Paper • Enable automatic two‑sided (duplex) printing.

• Turn off print log features.

2 Press .

Reducing printer noise
Enable Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Quiet Mode > 

2 Select a setting.
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Use To

On Reduce printer noise.

Notes:

• Print jobs process at a reduced speed.

• Printer engine motors do not start until a document
is ready to print. There is a short delay before the
first page is printed.

• The alarm control and cartridge alarm sounds are
turned off.

• The printer ignores the Advance Start command.

Off Use factory default settings.

Note: This setting supports the performance
specifications of the printer.

3 Press .

Adjusting Sleep mode
To save energy, decrease the number of minutes before the printer enters Sleep mode. Select from 1 to 120. The factory
default setting is 30 minutes.

Note: The printer still accepts print jobs when in Sleep mode.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Navigate to:

Settings > General Settings > Timeouts

3 In the Sleep Mode field, enter the number of minutes you want the printer to wait before it enters Sleep mode.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Sleep Mode > 

2 In the Sleep Mode field, select the number of minutes you want the printer to wait before it enters Sleep mode.

3 Press .
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Using Hibernate mode
Hibernate is an ultra‑low‑power operating mode. When operating in Hibernate mode, all other systems and devices
are powered down safely.

Notes:

• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long press of
the Sleep button wakes the printer from Hibernate mode.

• If the printer is in Hibernate mode, then the Embedded Web Server is disabled.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If your are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Sleep Button Settings.

3 From the “Press Sleep Button” or “Press and Hold Sleep Button” drop‑down menu, select Hibernate.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings > 

2 Press the arrow buttons until Press Sleep Button or Press and Hold Sleep Button appears, and

then press .

3 Press the arrow buttons until Hibernate appears, and then press .

Notes:

• When Press Sleep Button is set to Hibernate, a short press of the Sleep button sets the printer to Hibernate
mode.

• When Press and Hold Sleep Button is set to Hibernate, a long press of the Sleep button sets the printer to
Hibernate mode.

Setting Hibernate Timeout
Hibernate Timeout lets you set the amount of time the printer waits after a print job is processed before it goes into a
reduced power state.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Timeouts.

3 From the Hibernate Timeout menu, select the number of hours, days, weeks, or months you want for the printer
to wait before it goes into a reduced power state.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Hibernate Timeout > 

2 Select the amount of time the printer waits after a print job is processed before it enters Hibernate mode.

3 Press .

Using Schedule Power Modes
Schedule Power Modes lets you schedule when the printer goes into a reduced power state or into the Ready state.

Note: This feature is available only in network printers or printers connected to print servers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Schedule Power Modes.

3 From the Action menu, select the power mode.

4 From the Time menu, select the time.

5 From the Day(s) menu, select the day or days.

6 Click Add.

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter

• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment

• The Lexmark recycling program at www.lexmark.com/recycle
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Recycling Lexmark products
To return Lexmark products for recycling:

1 Go to www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country or region from the list.

3 Follow the instructions on the computer screen.

Note: Printer supplies and hardware not listed in the Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Recycling Lexmark packaging
Lexmark continually strives to minimize packaging. Less packaging helps to ensure that Lexmark printers are transported
in the most efficient and environmentally sensitive manner and that there is less packaging to dispose of. These
efficiencies result in fewer greenhouse emissions, energy savings, and natural resource savings.

Lexmark cartons are 100% recyclable where corrugated recycling facilities exist. Facilities may not exist in your area.

The foam used in Lexmark packaging is recyclable where foam recycling facilities exist. Facilities may not exist in your
area.

When you return a cartridge to Lexmark, you can reuse the box that the cartridge came in. Lexmark will recycle the
box.

Returning Lexmark cartridges for reuse or recycling
Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it both
easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred percent
of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used to return
the cartridges are also recycled.

To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Go to www.lexmark.com/recycle.

2 From the Toner Cartridges section, select your country or region.

3 Follow the instructions on the computer screen.
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Securing the printer

Using the security lock feature
The printer is equipped with a security lock feature. Attach a security lock compatible with most laptop computers in
the location shown to secure the printer in place.

Statement of Volatility
Your printer contains various types of memory that can store device and network settings, and user data.

Type of memory Description

Volatile memory Your printer uses standard random access memory (RAM) to
temporarily buffer user data during simple print jobs.

Non-volatile memory Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used to
store operating system, device settings, and network
information.

Erase the content of any installed printer memory in the following circumstances:

• The printer is being decommissioned.

• The printer is being moved to a different department or location.

• The printer is being serviced by someone from outside your organization.

• The printer is being removed from your premises for service.

• The printer is being sold to another organization.
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Erasing volatile memory
The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the buffered
data, simply turn off the printer.

Erasing non‑volatile memory
Erase individual settings, device and network settings, security settings, and embedded solutions by following these
steps:

1 Turn off the printer.

2 Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the screen with the
progress bar appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is fully
turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe All Settings appears.

The printer will restart several times during this process.

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the printer
memory.

4 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.

Finding printer security information
In high-security environments, it may be necessary to take additional steps to make sure that confidential data stored
in the printer cannot be accessed by unauthorized persons. For more information, visit the
Lexmark security Web page.

You can also see the Embedded Web Server — Security: Administrator’s Guide for additional information:

1 Go to www.lexmark.com, and then navigate to Support & Downloads > select your printer.

2 Click the Manuals tab, and then select Embedded Web Server — Security: Administrator’s Guide.
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Maintaining the printer
Warning—Potential Damage: Failure to maintain optimum printer performance, or to replace parts and supplies,
may cause damage to your printer.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust

Cleaning printer parts

Cleaning the printer
Note: You may need to perform this task after every few months.

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the printer
warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the printer,
unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

2 Remove paper from the standard bin, multipurpose feeder, and manual feeder.

3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.

4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

5 Make sure all areas of the printer are dry before sending a new print job.
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Cleaning the scanner glass
Clean the scanner glass if you encounter print quality problems, such as streaks on copied or scanned images.

1 Slightly dampen a soft, lint-free cloth or paper towel with water.

2 Open the scanner cover.

3 Clean all the areas shown, and then let them dry.

1 White underside of the ADF cover

2 White underside of the scanner cover

3 Scanner glass

4 ADF glass

4 Close the scanner cover.
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Checking the status of parts and supplies
A message appears on the display when a replacement supply item is needed or when maintenance is required.

Checking the status of parts and supplies on the printer control panel
From the printer control panel, navigate to:

 > Status/Supplies >  View Supplies > 

Checking the status of parts and supplies from the Embedded Web Server
Note: Make sure the computer and printer are connected to the same network.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Device Status > More Details.

Estimated number of remaining pages
The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy may
vary significantly and is dependent on many factors, such as actual document content, print quality settings, and
other printer settings.

The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption is
different from the historical printing consumption. Consider the variable level of accuracy before purchasing or replacing
supplies based on the estimate. Until an adequate print history is obtained on the printer, initial estimates assume
future supplies consumption based on the International Organization for Standardization* test methods and page
content.

* Average continuous black declared cartridge yield in accordance with ISO/IEC 19752.
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Ordering supplies
To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized supplies
dealers in your area. In other countries or regions, visit the Lexmark Web site at www.lexmark.com or contact the
place where you purchased the printer.

Note: All life estimates for printer supplies assume printing on letter‑ or A4‑size plain paper.

Using genuine Lexmark parts and supplies
Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components. Use of third-party
supplies or parts can affect warranty coverage. Damage caused by the use of third-party supplies or parts is not covered
by the warranty. All life indicators are designed to function with Lexmark supplies and parts, and may deliver
unpredictable results if third-party supplies or parts are used. Imaging component usage beyond the intended life may
damage your Lexmark printer or its associated components.

Ordering toner cartridges

Notes:

• The estimated cartridge yield is based on the ISO/IEC 19798 standard.

• Extremely low print coverage for extended periods of time may negatively affect actual yield and may cause
cartridge parts to fail prior to exhaustion of toner.

Item United States and Canada European Union (EU),
European Economic Area

(EEA), and Switzerland

Rest of the world

Return Program toner cartridges

Black 801K 802K 808K

Cyan 801C 802C 808C

Magenta 801M 802M 808M

Yellow 801Y 802Y 808Y

Standard Yield Return Program toner cartridges

Black 801SK 802SK 808SK

Cyan 801SC 802SC 808SC

Magenta 801SM 802SM 808SM

Yellow 801SY 802SY 808SY

For more information on countries located in a region, visit www.lexmark.com/regions.

Item Worldwide

Standard Yield regular toner cartridges

Black 800S1

For more information on countries located in a region, visit www.lexmark.com/regions.
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Item Worldwide

Cyan 800S2

Magenta 800S3

Yellow 800S4

For more information on countries located in a region, visit www.lexmark.com/regions.

Ordering imaging kits

Item All countries and regions

Black imaging kit 700Z1

Color imaging kit 700Z5

Ordering a maintenance kit

Notes:

• Using certain types of paper may require more frequent replacement of the maintenance kit.

• The separator pad, fuser, and transfer module are included in the maintenance kit and can also be individually
ordered and replaced, if necessary. The separator pad is a customer replaceable part.

• To replace the maintenance kit, contact customer support at http://support.lexmark.com or your service
representative.

Part name Type Supply number

Maintenance kit 115 V

220 V

100 V

40X7615

40X7616

40X7617

Item Supply number

Separator pad 40X6247

Ordering a waste toner bottle

Item All countries and regions

Waste toner bottle C540X75G
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Replacing supplies

Replacing the waste toner bottle

1

2

34

1 Top door

2 Waste toner bottle

3 Right side cover

4 Front door

1 Unpack the replacement waste toner bottle.

2 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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3 Open the top door.

4 Remove the right side cover.

5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.
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6 Seal the used waste toner bottle in the enclosed packaging.

For more information, see “Recycling Lexmark products” on page 132.

7 Insert the replacement waste toner bottle.

8 Insert the right side cover.

9 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

1

2
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10 Close the front door.

Replacing a black and color imaging kit
1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Open the top door.
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3 Remove the toner cartridges by lifting the handles, and then gently pulling them away from the imaging kit.

4 Remove the right side cover.

5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.
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6 Lift the blue levers on the imaging kit, and then pull the imaging kit until it stops.

7 Press down the blue lever, and then grasp the green handles on the sides to pull out the imaging kit.

8 Unpack the replacement black and color imaging kit.

Notes:

• The color imaging kit includes the imaging kit and the cyan, magenta, yellow, and black developer units.

• The black imaging kit includes the imaging kit and the black developer unit.

9 Seal the used imaging kit in the bag that the replacement imaging kit came in.
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For more information, see “Recycling Lexmark products” on page 132.

Note: When replacing the black imaging kit, save the cyan, magenta, and yellow developer units. Dispose only
the black developer unit.

10 Gently shake the yellow, cyan, magenta, and black developer units side‑to‑side.

11 Remove the red packing strip and the attached fabric from the developer units.

12 Gently insert the yellow, cyan, magenta, and black developer units.
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Note: Make sure each developer unit is inserted into the matching color slot.

13 Remove the red packing strip from the imaging kit.

Warning—Potential Damage: Do not touch the shiny photoconductor drum under the imaging kit. Doing so may
affect the quality of future print jobs.

14 Align and then insert the imaging kit.
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15 Gently but firmly push the blue levers down until the imaging kit fits into place.

Note: Make sure that the imaging kit is fully seated.

16 Insert the waste toner bottle.

17 Insert the right side cover.
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18 Insert the toner cartridges.

19 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

1

2

20 Close the front door.
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Replacing toner cartridges
Warning—Potential Damage: Damage caused by use of a non‑Lexmark toner cartridge is not covered under
warranty.

Note: A reduced print quality may result from using non‑Lexmark toner cartridges.

1 Open the top door.

2 Remove the toner cartridge by lifting the handle, and then gently pulling it away from the imaging kit.
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3 Unpack the new toner cartridge, and then remove its packaging.

4 Align the new toner cartridge, and then press the cartridge down until it fits into place.

5 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

6 Seal the used toner cartridge in the bag that the replacement toner cartridge came in.

For more information, see “Recycling Lexmark products” on page 132.
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Replacing a developer unit
Replace the developer unit when a print quality defect occurs or when damage occurs to the printer.

1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Open the top door.
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3 Lift the toner cartridge handle, and then gently pull it from the imaging kit.

4 Remove the right side cover.

5 Press the green levers on each side of the waste toner bottle, and then remove the waste toner bottle.
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6 Lift the blue levers on the imaging kit, and then pull the imaging kit until it stops.

7 Press down the blue lever, and then grasp the green handles on the sides to pull out the imaging kit.

Warning—Potential Damage: Do not touch the underside of the imaging kit. Doing so could damage the
imaging kit.

8 Remove the used developer unit.
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9 Gently shake the replacement developer unit side‑to‑side before removing it from its packaging.

10 Remove the red shipping cover from the developer unit.

11 Insert the developer unit.
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12 Align and then insert the imaging kit.

13 Gently but firmly push the blue levers down until the imaging kit fits into place.

Note: Make sure that the imaging kit is fully seated.

14 Replace the waste toner bottle.
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15 Insert the right side cover.

16 Insert the toner cartridges.

17 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

1

2
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18 Close the front door.

19 Seal the used developer unit in the bag that the replacement developer unit came in.

For more information, see “Recycling Lexmark products” on page 132.

Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: The printer weight is greater than 18 kg (40 lb) and requires two or more
trained personnel to lift it safely.

CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off the optional tray, and then set it aside instead of trying to lift the tray and printer at the same
time.

Note: Use the handholds located on both sides of the printer to lift it.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Moving the printer to another location
The printer and its hardware options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer.

• Any cart used to move the hardware options must have a surface able to support the dimensions of the hardware
options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.
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Shipping the printer
When shipping the printer, use the original packaging.
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Managing the printer

Finding advanced networking and administrator information
This chapter covers basic administrative support tasks using the Embedded Web Server. For more advanced system
support tasks, see the Networking Guide on the Software and Documentation CD or the Embedded Web Server —
Security: Administrator's Guide on the Lexmark support Web site at http://support.lexmark.com.

Checking the virtual display
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Check the virtual display that appears at the top left corner of the screen.

The virtual display works as an actual display would work on a printer control panel.

Setting up e‑mail alerts
Configure the printer to send you e‑mail alerts when the supplies are getting low, when the paper needs to be changed
or added, or when there is a paper jam.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings.

3 From the Other Settings menu, click E‑mail Alert Setup.

4 Select the items you want to be notified on, and then type the e‑mail addresses.

5 Click Submit.

Note: For information on setting up the e‑mail server, contact your system support person.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, network, and supplies.

1 Open a Web browser, and then type the printer IP address in the address field.
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Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Reports, and then click the type of report you want to view.

Configuring supply notifications from the Embedded Web
Server
You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end‑of‑life by setting the selectable alerts.

Notes:

• You can select alerts for toner cartridges, imaging kit, maintenance kit, and waste toner bottle.

• All alerts can be set for nearly low, low, and very low supply conditions. Not all alerts can be set for the
end‑of‑life supply condition. E‑mail alert is available for all supply conditions.

• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for some
supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Supply Notifications.

3 From the drop‑down menu for each supply, select one of the following notification options:

Notification Description

Off The normal printer behavior for all supplies occurs.

E‑mail Only The printer generates an e-mail when the supply condition is reached. The status of the
supply appears on the menus page and status page.

Warning The printer shows the warning message and generates an email about the status of the
supply. The printer does not stop when the supply condition is reached.

Continuable Stop1 The printer stops processing jobs when the supply condition is reached. The user needs to
press a button to continue printing.

Non Continuable Stop1,2 The printer stops when the supply condition is reached. The supply must be replaced to
continue printing.

1 The printer generates an e-mail about the status of the supply when supply notification is enabled.
2 The printer stops when some supplies become empty to prevent damage.

4 Click Submit.
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Copying printer settings to other printers
Note: This feature is available only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears as four
sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click the Copy Printer Settings.

3 To change the language, select a language from the drop-down menu, and then click Click here to submit language.

4 Click Printer Settings.

5 Type the IP addresses of the source and target printers in their appropriate fields.

Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.

6 Click Copy Printer Settings.

Restoring factory default settings
If you want to keep a list of the current menu settings for reference, then print a menu settings page before restoring
the factory default settings. For more information, see “Printing a menu settings page” on page 31.

If you want a more comprehensive method of restoring the printer factory default settings, then perform the Wipe All
Settings option. For more information, see “Erasing non‑volatile memory” on page 134.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
settings. Exceptions include the display language, custom sizes and messages, and network/port menu settings. All
downloads stored in the RAM are deleted.

From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Factory Defaults >  > Restore Now > 
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Clearing jams
By carefully selecting paper and specialty media and loading it properly, you should be able to avoid most jams. If jams
occur, then follow the steps outlined in this chapter.

Warning—Potential Damage: Never use any tool to remove a jam. Doing so could permanently damage the fuser.

Avoiding jams

Load paper properly
• Make sure paper lies flat in the tray.

Correct loading of paper Incorrect loading of paper

• Do not remove a tray while the printer is printing.

• Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.

• Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.
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• Do not slide the paper into the tray. Load paper as shown in the illustration.

• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing tightly
against the paper or envelopes.

• Push the tray firmly into the printer after loading paper.

Use recommended paper
• Use only recommended paper or specialty media.

• Do not load wrinkled, creased, damp, bent, or curled paper.

• Flex, fan, and straighten paper before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same tray.

• Make sure the paper size and type are set correctly on the computer or printer control panel.

• Store paper according to manufacturer recommendations.

Understanding jam messages and locations
When a jam occurs, a message indicating the jam location and information to clear the jam appears on the printer
display. Open the doors, covers, and trays indicated on the display to remove the jam.

Note: When Jam Recovery is set to On or Auto, the printer reprints jammed pages. However, Auto does not
guarantee that the page will print.

Clearing jams 164

http://www.manualsbase.com


More user manuals on ManualsBase.com

1 2

3

4

5

6

7

8

Jam location Message on the display What to do

1 Automatic document
feeder (ADF)

[x]‑page jam, open automatic feeder
top cover [28y.xx]

Remove all paper from the ADF tray, and then
remove the jammed paper.

2 Standard bin [x]‑page jam, clear standard
bin [203.xx]

Remove the jammed paper.

3 Fuser [x]‑page jam, open front door to clear
fuser [202.xx]

Open the front door, then pull the tab and hold the
fuser cover down, and then remove the jammed
paper.

4 Front door [x]‑page jam, open front door [20y.xx] Open the front door, and then remove the jammed
paper.

5 Duplex area [x]‑page jam, open front door to clear
duplex [23y.xx]

Open the front door, and then remove the jammed
paper.

6 Tray [x] [x]‑page jam, open tray [x] [24y.xx] Pull out the indicated tray, and then remove the
jammed paper.

7 Multipurpose feeder [x]‑page jam, clear multipurpose
feeder [250.xx]

Push the paper release lever to lift the paper rollers,
and then remove the jammed paper.

8 Manual feeder [x]‑page jam, clear manual
feeder [251.xx]

Remove the jammed paper.
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[x]‑page jam, clear standard bin [203.xx]
1 Open the top door.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

a If there is a jammed paper under the fuser, then firmly grasp the paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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b Pull the green lever to open the fuser cover.

c If there is a jammed paper in the fuser, then hold down the fuser cover, and then remove the paper.

Note: Make sure all paper fragments are removed.
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4 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

1

2

5 Close the front door.

6 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

[x]-page jam, open front door to clear fuser [202.xx]
1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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2 Open the top door.
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3 Pull the green lever to open the fuser cover.

4 Hold down the fuser cover, and then remove the jammed paper.

Note: Make sure all paper fragments are removed.
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5 Slide and hold the release latch on the right side of the printer, and then slowly close the top door.

1

2

6 Close the front door.

7 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

[x]-page jam, open front door [20y.xx]
1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Close the front door.

4 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

[x]‑page jam, open front door to clear duplex [23y.xx]
1 Open the front door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Close the front door.

4 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

[x]‑page jam, open tray [x] [24y.xx]
1 Pull out the tray completely.

Note: The message on the printer display indicates the tray where the jammed paper is located.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.
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3 Insert the tray.

4 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

[x]‑page jam, clear manual feeder [251.xx]
1 Pull out the standard 250-sheet tray (Tray 1) and manual feeder.

2 Firmly grasp the jammed paper on each side, and then gently pull it out.

Note: Make sure all paper fragments are removed.

3 Insert the tray.

4 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next > Clear the jam, press OK, and then press  to confirm.

Clearing jams 175

http://www.manualsbase.com


More user manuals on ManualsBase.com

[x]‑page jam, clear multipurpose feeder [250.xx]
1 Push the paper release lever in the multipurpose feeder to access the jammed paper, and then gently pull out the

paper.

Note: Make sure all paper fragments are removed.

2 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

3 Reload paper into the multipurpose feeder.
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4 Slide the paper guide until it rests lightly against the edge of the paper stack.

1

2

5 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next >  > Clear the jam, press OK > .

[x]‑page jam, open automatic feeder top cover. [28y.xx]
1 Remove all original documents from the ADF tray.

Note: The message is cleared when the pages are removed from the ADF tray.

2 Open the ADF cover.

3 Firmly grasp the jammed paper on each side, and then gently pull it out.
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Note: Make sure all paper fragments are removed.

4 Close the ADF cover.

5 Straighten the edges of the original documents, then load the documents into the ADF, and then adjust the paper
guide.

6 From the printer control panel, touch  to clear the message and continue printing. For non‑touch‑screen printer

models, select Next >  > Clear the jam, press OK > .

Clearing jams 178

http://www.manualsbase.com


More user manuals on ManualsBase.com

Troubleshooting

Understanding the printer messages

Adjusting color
Wait for the process to complete.

Change [paper source] to [custom type name]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then select Finished changing paper on the printer control

panel to clear the message and continue printing. For non‑touch‑screen printer models, press  to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [custom string]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then select Finished changing paper on the printer control

panel to clear the message and continue printing. For non‑touch‑screen printer models, press  to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Change [paper source] to [paper type] [paper size]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then select Finished changing paper on the printer control

panel to clear the message and continue printing. For non‑touch‑screen printer models, press  to confirm.

Note: Make sure the paper size and type are specified in the Paper menu on the printer control panel.

• Cancel the print job.

Close door
Make sure the right side cover is installed, and then close the front and top doors to clear the message.
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Close flatbed cover and load originals if restarting job [2yy.xx]
From the printer control panel, try one or more of the following:

• Select Scan from automatic feeder, and then press  to continue scanning from the ADF immediately after the
last successful scan job.

• Select Scan from flatbed, and then press  to continue scanning from the scanner glass immediately after the
last successful scan job.

• Select Finish job without further scanning, and then press  to end the last successful scan job.

Note: This does not cancel the scan job. All successfully scanned pages will be processed further for copying or
e-mailing.

• Select Restart Job, and then press  to restart the scan job with the same settings from the previous scan job.

• Select Cancel Job, and then press  to clear the message and cancel the scan job.

[Color] cartridge low [88.xy]
You may need to order a toner cartridge. If necessary, select Continue to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

[Color] cartridge nearly low [88.xy]
If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

[Color] cartridge very low, [x] estimated pages remain [88.xy]
You may need to replace the toner cartridge very soon. For more information, see the “Replacing supplies” section of
the User’s Guide.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

Complex page, some data may not have printed [39]
Try one or more of the following:

• From the printer control panel, select Continue to ignore the message and continue printing. For non‑touch‑screen

printer models, press  to confirm.

• Cancel the current print job. For non‑touch‑screen printer models, press  to confirm.

• Install additional printer memory.
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Configuration change, some held jobs were not restored [57]
Held jobs are invalidated because of any of the following possible changes in the printer:

• The printer firmware has been updated.

• The tray for the print job is removed.

• The print job is sent from a flash drive that is no longer attached to the USB port.

• The printer hard disk contains print jobs that were stored when the hard disk was installed in a different printer
model.

Note: The printer hard disk and the flash drive are supported only in select printer models.

From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press 
to confirm.

Defective flash detected [51]
Try one or more of the following:

• Replace the defective flash memory card.

• From the printer control panel, select Continue to ignore the message and continue printing. For non‑touch‑screen

printer models, press  to confirm.

• Cancel the current print job.

Error reading USB drive. Remove USB.
An unsupported USB device is inserted. Remove the USB device, and then insert a supported one.

Error reading USB hub. Remove hub.
An unsupported USB hub has been inserted. Remove the USB hub, and then install a supported one.

Incompatible tray [x] [59]
Remove, and then reinstall the indicated tray to clear the message.

Incorrect paper size, open [paper source] [34]
Note: The paper source can be a tray or a feeder.

Try one or more of the following:

• Load the correct size of paper in the paper source.

• From the printer control panel, select Continue to clear the message and print using a different paper source. For

non‑touch‑screen printer models, press  to confirm.

• Check the length and width guides of the paper source and make sure the paper is loaded properly.

• Make sure the correct paper size and type are specified in the Printing Preferences or in the Print dialog.

• Make sure the paper size and type are specified in the Paper menu on the printer control panel.
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• Make sure that the paper size is correctly set. For example, if Multipurpose Feeder Size is set to Universal, then
make sure the paper is large enough for the data being printed.

• Cancel the print job.

Insert Tray [x]
Insert the indicated tray into the printer.

Insufficient memory for Flash Memory Defragment operation [37]
Try one or more of the following:

• From the printer control panel, select Continue to stop the defragmentation and continue printing. For

non‑touch‑screen printer models, press  to confirm.

• Delete fonts, macros, and other data from the printer memory.

• Install additional printer memory.

Insufficient memory, some Held Jobs were deleted [37]
The printer deleted some held jobs in order to process current jobs.

Select Continue to clear the message. For non-touch-screen printer models, press  to confirm.

Insufficient memory to collate job [37]
Try one or more of the following:

• From the printer control panel, select Continue to print the part of the job already stored and begin collating the

rest of the print job. For non‑touch‑screen printer models, press  to confirm.

• Cancel the current print job.

Insufficient memory to support Resource Save feature [35]
Install additional printer memory or select Continue on the printer control panel to disable Resource Save, clear the

message, and continue printing. For non‑touch‑screen printer models, press  to confirm.

Insufficient memory, some held jobs will not be restored [37]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message. For non-touch-screen printer models, press

 to confirm.

• Delete other held jobs to free up additional printer memory.
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Load [paper source] with [custom type name]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• To use the tray with the correct paper size or type, select Finished loading paper on the printer control panel. For

non‑touch‑screen printer models, press  to confirm.

Note: If the printer detects a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot detect a tray that has the correct paper type and size, then it prints from the default paper
source.

• Cancel the current job.

Load [paper source] with [custom string]
Try one or more of the following:

• Load the indicated tray or feeder with the correct size and type of paper.

• To use the tray with the correct paper size or type, select Finished loading paper on the printer control panel. For

non‑touch‑screen printer models, press  to confirm.

Note: If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the
printer cannot find a tray with the correct paper type and size, then it prints from the default paper source.

• Cancel the current job.

Load [paper source] with [paper size]
Try one or more of the following:

• Load the tray or feeder with the correct size of paper.

• To use the tray or feeder with the correct paper size, select Finished loading paper on the printer control panel.

For non‑touch‑screen printer models, press  to confirm.

Note: If the printer detects a tray that has the correct paper size, then it feeds from that tray. If the printer
cannot detect a tray that has the correct paper size, then it prints from the default paper source.

• Cancel the current job.

Load [paper source] with [paper type] [paper size]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• To use the tray or feeder with the correct paper size and type, select Finished loading paper on the printer control

panel. For non‑touch‑screen printer models, press  to confirm.

Note: If the printer detects a tray that has the correct paper size and type, then it feeds from that tray. If the
printer cannot detect a tray that has the correct paper size and type, then it prints from the default paper
source.

• Cancel the current job.
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Load Manual Feeder with [custom string]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• Depending on your printer model, touch Prompt each page, paper loaded or press  on the printer control panel
to clear the message and continue printing.

• Cancel the current job.

Load Manual Feeder with [custom type name]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• Depending on your printer model, touch Prompt each page, paper loaded or press  on the printer control panel
to clear the message and continue printing.

• Cancel the current job.

Load Manual Feeder with [paper size]
Try one or more of the following:

• Load the feeder with the correct size of paper.

• Depending on your printer model, touch Prompt each page, paper loaded or press  on the printer control panel
to clear the message and continue printing.

• Cancel the current job.

Load Manual Feeder with [paper type] [paper size]
Try one or more of the following:

• Load the feeder with the correct size and type of paper.

• Depending on your printer model, touch Prompt each page, paper loaded or press  on the printer control panel
to clear the message and continue printing.

• Cancel the current job.

Maintenance kit low [80.xy]
You may need to order a maintenance kit. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact customer support, and then report the message.

If necessary, select Continue to clear the message and continue printing. For non‑touch‑screen printer models,

press  to confirm.

Maintenance kit nearly low [80.xy]
For more information, visit the Lexmark support Web site at http://support.lexmark.com or contact customer support,
and then report the message.

Troubleshooting 184

http://support.lexmark.com
http://support.lexmark.com
http://www.manualsbase.com


More user manuals on ManualsBase.com

If necessary, select Continue to clear the message and continue printing. For non‑touch‑screen printer models,

press  to confirm.

Maintenance kit very low, [x] estimated pages remain [80.xy]
You may need to replace the maintenance kit very soon. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact customer support, and then report the message.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

Memory full [38]
Try one or more of the following:

• From the printer control panel, select Cancel job to clear the message. For non‑touch‑screen printer models, press

 to confirm.

• Install additional printer memory.

Network [x] software error [54]
Try one or more of the following:

• From the printer control panel, select Continue to continue printing. For non‑touch‑screen printer models, press

 to confirm.

• Turn off the printer, wait for about 10 seconds, and then turn the printer back on.

• Update the network firmware in the printer or print server. For more information, visit the Lexmark support Web
site at http://support.lexmark.com.

Not enough free space in flash memory for resources [52]
Try one or more of the following:

• From the printer control panel, select Continue to clear the message and continue printing. For non‑touch‑screen

printer models, press  to confirm.

• Delete fonts, macros, and other data stored in the flash memory.

• Upgrade to a larger capacity flash memory card.

Note: Downloaded fonts and macros that are not previously stored in the flash memory are deleted.

Non-Lexmark [color] [supply type], see User's Guide [33.xy]
Note: The supply type can be a toner cartridge or the imaging kit.

The printer has detected a non‑Lexmark supply or part installed in the printer.

Your Lexmark printer is designed to function best with genuine Lexmark supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components.
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All life indicators are designed to function with Lexmark supplies and parts, and may deliver unpredictable results if
third-party supplies or parts are used. Imaging component usage beyond the intended life may damage your Lexmark
printer or its associated components.

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage. Damage caused by
the use of third-party supplies or parts may not be covered by the warranty.

To accept any and all of these risks, and to proceed with the use of non-genuine supplies or parts in your printer, press

and hold  and the # button on the printer control panel simultaneously for 15 seconds.

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and then install
a genuine Lexmark supply or part.

Note: For the list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.lexmark.com.

Reinstall missing or unresponsive [color] cartridge [31.xy]
Try one or more of the following:

• Install the missing toner cartridge. For more information, see the “Replacing supplies” section of the User’s Guide.

• Remove the unresponsive cartridge, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the cartridge may be defective. Replace the
cartridge.

Reinstall missing or unresponsive [type] imaging kit [31.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Try one or more of the following:

• Install the missing imaging kit. For more information, see the “Replacing supplies” section of the User’s Guide.

• Remove the unresponsive imaging kit, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the imaging kit may be defective. Replace the
imaging kit.

Reload printed pages in Tray [x]
Try any of the following:

• From the printer control panel, select Continue to clear the message and continue printing the second side of the

sheet. For non‑touch‑screen printer models, press  to confirm.

• Cancel the print job.

Remove packaging material, [area name]
1 Remove any remaining packing material from the indicated location.

2 From the printer control panel, touch Continue to clear the message. For non‑touch‑screen printer models, press

 to confirm.
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Remove paper from standard output bin
Remove the paper stack from the standard bin.

Replace [color] cartridge, 0 estimated pages remain [88.xy]
Replace the indicated toner cartridge to clear the message and continue printing. For more information, see the
instruction sheet that came with the supply.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace [color] cartridge, printer region mismatch [42.xy]
Install a toner cartridge that matches the region number of the printer. x indicates the value of the printer region. y
indicates the value of the cartridge region. x and y can have the following values:

Region number Region

0 Global

1 United States, Canada

2 European Union (EU), European Economic Area (EEA), Switzerland

8 Rest of the world

9 Invalid

Notes:

• The x and y values represent .xy in the error code that appears on the printer control panel.

• The x and y values must match for printing to continue.

Replace [type] imaging kit, 0 estimated pages remain [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Replace the indicated imaging kit to clear the message and continue printing. For more information, see the instruction
sheet that came with the supply.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace all originals if restarting job.
From the printer control panel, try one or more of the following:

• Select Scan from automatic feeder, and then press  to continue scanning from the ADF immediately after the
last successful scan job.

• Select Scan from flatbed, and then press  to continue scanning from the scanner glass immediately after the
last successful scan job.
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• Select Finish job without further scanning, and then press  to end the last successful scan job.

Note: This does not cancel the scan job. All successfully scanned pages will be processed further for copying or
e-mailing.

• Select Restart Job, and then press  to restart the scan job with the same settings from the previous scan job.

• Select Cancel Job, and then press  to clear the message and cancel the scan job.

Replace defective [type] imaging kit [31.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Replace the defective imaging kit to clear the message and continue printing. For more information, see the instruction
sheet that came with the supply.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace jammed originals if restarting job.
From the printer control panel, try one or more of the following:

• Select Scan from automatic feeder, and then press  to continue scanning from the ADF immediately after the
last successful scan job.

• Select Scan from flatbed, and then press  to continue scanning from the scanner glass immediately after the
last successful scan job.

• Select Finish job without further scanning, and then press  to end the last successful scan job.

Note: This does not cancel the scan job. All successfully scanned pages will be processed further for copying or
e-mailing.

• Select Restart Job, and then press  to restart the scan job with the same settings from the previous scan job.

• Select Cancel Job, and then press  to clear the message and cancel the scan job.

Replace maintenance kit, 0 estimated pages remain [80.xy]
The printer is scheduled for maintenance. For more information, visit the Lexmark support Web site at
http://support.lexmark.com or contact your service representative, and then report the message.

Replace missing [type] imaging kit [31.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Install the indicated imaging kit to clear the message. For more information, see the “Replacing supplies” section of
the User’s Guide.
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Replace missing waste toner bottle [82.xy]
Install the missing waste toner bottle to clear the message. For more information, see the instruction sheet that came
with the supply.

Replace unsupported [color] cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message.

Note: If you do not have a replacement cartridge, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace unsupported [type] imaging kit [32.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

Remove the indicated imaging kit, and then install a supported one to clear the message.

Note: If you do not have a replacement imaging kit, then see the “Ordering supplies” section of the User’s Guide or
visit www.lexmark.com.

Replace waste toner bottle [82.xy]
Replace the waste toner bottle to clear the message.

Scanner automatic feeder cover open
Close the ADF cover.

Scanner disabled by admin [840.01]
Print without the scanner, or contact your system support person.

Scanner disabled. Contact system administrator if problem persists. [840.02]
From the printer control panel, try one or more of the following:

• Select Continue with scanner disabled to return to the home screen, and then contact your system support person.

• Select Reboot and automatically enable scanner to cancel the job.

Note: This attempts to enable the scanner.

• For non‑touch‑screen printer models, press  to confirm.

Scanner jam, remove all originals from the scanner [2yy.xx]
Remove the jammed paper from the scanner.
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Scanner jam, remove jammed originals from the scanner [2yy.xx]
Remove the jammed paper from the scanner.

SMTP server not set up. Contact system administrator.

From the printer control panel, press  to clear the message.

Note: If the message appears again, then contact your system support person.

Standard network software error [54]
Try one or more of the following:

• From the printer control panel, select Continue to continue printing. For non‑touch‑screen printer models, press

 to confirm.

• Turn off the printer and then turn it back on.

• Update the network firmware in the printer or print server. For more information, visit the Lexmark support Web
site at http://support.lexmark.com.

Standard USB port disabled [56]

From the printer control panel, select Continue to clear the message. For non‑touch‑screen printer models, press 
to confirm.

Notes:

• The printer discards any data received through the USB port.

• Make sure the USB Buffer menu is not set to Disabled.

Supply needed to complete job
Try one or more of the following:

• From the printer control panel, touch Prompt for supplies to view all error messages that indicate what supplies

are needed to continue processing the current job. For non‑touch‑screen printer models, press  to clear the
message and continue printing.

1 Order the missing supply immediately.

2 Install the supply. For more information, see the instruction sheet that came with the supply.

• Cancel the print job, then install the missing supply, and then resend the print job.

Too many flash options installed [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra flash memory.
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4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Too many trays attached [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra trays.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

[Type] imaging kit low [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

You may need to order an imaging kit. If necessary, select Continue on the printer control panel to clear the message

and continue printing. For non‑touch‑screen printer models, press  to confirm.

[Type] imaging kit nearly low [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

[Type] imaging kit very low, [x] estimated pages remain [84.xy]
Note: The type can be a black imaging kit, or a black and color imaging kit.

You may need to replace the imaging kit very soon. For more information, see the “Replacing supplies” section of the
User’s Guide.

If necessary, select Continue on the printer control panel to clear the message and continue printing. For

non‑touch‑screen printer models, press  to confirm.

Unformatted flash detected [53]
Try one or more of the following:

• From the printer control, select Continue to stop the defragmentation and continue printing. For non‑touch‑screen

printer models, press  to confirm.

• Format the flash memory.

Note: If the error message remains, then the flash memory may be defective and need to be replaced.
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Waste toner bottle nearly full [82.xy]
You may need to order a waste toner bottle. If necessary, select Continue on the printer control panel to clear the

message and continue printing. For non‑touch‑screen printer models, press  to confirm.

Weblink server not set up. Contact system administrator.

From the printer control panel, press  to clear the message.

Note: If the message appears again, then contact your system support person.

Solving printer problems

Basic printer problems

The printer is not responding

Action Yes No

Step 1

Make sure the printer is turned on.

Is the printer turned on?

Go to step 2. Turn on the printer.

Step 2

Check if the printer is in Sleep mode or Hibernate mode.

Is the printer in Sleep mode or Hibernate mode?

Press the Sleep button
to wake the printer
from Sleep mode or
Hibernate mode.

Go to step 3.

Step 3

Check if one end of the power cord is plugged into the printer and the
other to a properly grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 4. Plug one end of the
power cord into the
printer and the other to
a properly grounded
electrical outlet.

Step 4

Check other electrical equipment plugged into the electrical outlet.

Does other electrical equipment work?

Unplug the other
electrical equipment,
and then turn on the
printer. If the printer
does not work, then
reconnect the other
electrical equipment.

Go to step 5.
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Action Yes No

Step 5

Check if the cables connecting the printer and the computer are inserted
in the correct ports.

Are the cables inserted in the correct ports?

Go to step 6. Make sure to match the
following:

• The USB symbol on
the cable with the
USB symbol on the
printer

• The appropriate
Ethernet cable with
the Ethernet port

Step 6

Make sure the electrical outlet is not turned off by a switch or breaker.

Is the electrical outlet turned off by a switch or breaker?

Turn on the switch or
reset the breaker.

Go to step 7.

Step 7

Check if the printer is plugged into any surge protectors, uninterruptible
power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?

Connect the printer
power cord directly to
a properly grounded
electrical outlet.

Go to step 8.

Step 8

Check if one end of the printer cable is plugged into a port on the printer
and the other to the computer, print server, option, or other network
device.

Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?

Go to step 9. Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Step 9

Make sure to install all hardware options properly and remove any packing
material.

Are all hardware options properly installed and all packing material
removed?

Go to step 10. Turn off the printer,
remove all packing
materials, then
reinstall the hardware
options, and then turn
on the printer.

Step 10

Check if you have selected the correct port settings in the printer driver.

Are the port settings correct?

Go to step 11. Use correct printer
driver settings.

Step 11

Check the installed printer driver.

Is the correct printer driver installed?

Go to step 12. Install the correct
printer driver.

Step 12

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Is the printer working?

The problem is solved. Contact customer
support.
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Printer display is blank

Action Yes No

Step 1

Press the Sleep button on the printer control panel.

Does Ready appear on the printer display?

The problem is solved. Go to step 2.

Step 2

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Do Please wait and Ready appear on the printer display?

The problem is solved. Turn off the printer,
and then contact
customer support.

Option problems

Cannot detect internal option

Action Yes No

Step 1

Turn off the printer, then wait for about 10 seconds, and then turn on the
printer.

Does the internal option operate correctly?

The problem is solved. Go to step 2.

Step 2

Check if the internal option is properly installed in the controller board.

a Turn off the printer using the power switch, and then unplug the power
cord from the electrical outlet.

b Make sure the internal option is installed in the appropriate connector
in the controller board.

c Connect the power cord to the printer, then to a properly grounded
electrical outlet, and then turn on the printer.

Is the internal option properly installed in the controller board?

Go to step 3. Connect the internal
option to the controller
board.

Step 3

Print a menu settings page, and then check to see if the internal option is
listed in the Installed Features list.

Is the internal option listed in the menu settings page?

Go to step 4. Reinstall the internal
option.
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Action Yes No

Step 4

a Check if the internal option is selected.

It may be necessary to manually add the internal option in the printer
driver to make it available for print jobs. For more information, see
“Updating available options in the printer driver” on page 25.

b Resend the print job.

Does the internal option operate correctly?

The problem is solved. Contact customer
support.

Tray problems

Action Yes No

Step 1

a Pull out the tray, and then do one or more of the following:

• Check for paper jams or misfeeds.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• If you are printing on custom‑size paper, then make sure that the
paper guides rest against the edges of the paper.

• Make sure the paper is below the maximum paper fill indicator.

• Make sure paper lies flat in the tray.

b Check if the tray closes properly.

Is the tray working?

The problem is solved. Go to step 2.

Step 2

a Turn off the printer, then wait about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Is the tray working?

The problem is solved. Go to step 3.

Step 3

Check if the tray is installed and recognized by the printer.
Print a menu settings page, and then check if the tray is listed in the
Installed Features list.

Is the tray listed in the menu settings page?

Go to step 4. Reinstall the tray. For
more information, see
the setup
documentation that
came with the tray.

Step 4

Check if the tray is available in the printer driver.

Note: If necessary, manually add the tray in the printer driver to make it
available for print jobs. For more information, see “Updating available
options in the printer driver” on page 25.

Is the tray available in the printer driver?

The problem is solved. Contact customer
support.
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Paper feed problems

Jammed pages are not reprinted

Action Yes No

a Turn on jam recovery.

1 From the printer control panel, navigate to:

Settings > General Settings > Print Recovery > Jam Recovery

2 Select On or Auto.

3 Depending on your printer model, press  or touch Submit.

b Resend the pages that did not print.

Were the jammed pages reprinted?

The problem is solved. Contact customer
support.

Paper frequently jams

Action Yes No

Step 1

a Pull out the tray, and then do one or more of the following:

• Make sure paper lies flat in the tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of the
paper.

• Make sure the paper is below the maximum paper fill indicator.

• Check if you are printing on a recommended paper size and type.

b Insert the tray properly.

If jam recovery is enabled, then the print jobs will reprint
automatically.

Do paper jams still occur frequently?

Go to step 2. The problem is solved.

Step 2

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do paper jams still occur frequently?

Go to step 3. The problem is solved.

Step 3

a Review the tips on avoiding jams. For more information, see “Avoiding
jams” on page 163.

b Follow the recommendations, and then resend the print job.

Do paper jams still occur frequently?

Contact customer
support.

The problem is solved.
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Paper jam message remains after jam is cleared

Action Yes No

a Do either of the following:

• For touch‑screen printer models, touch  or Done.

• For non‑touch‑screen printer models, select Next >  > Clear

the jam, press OK >  .

b Follow the instructions on the printer display.

Does the paper jam message remain?

Contact customer
support.

The problem is solved.
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Solving print problems

Printing problems

Confidential and other held jobs do not print

Note: Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.

Action Yes No

Step 1

Open the held jobs folder on the printer display, and then verify that your
print job is listed.

Is your print job listed in the held jobs folder?

Go to step 2. Select one of the Print
and Hold options, and
then resend the print
job. For more
information, see
“Printing confidential
and other held jobs” on
page 56.

Step 2

The print job may contain a formatting error or invalid data.

• Delete the print job, and then send it again.

• For PDF files, generate a new PDF, and then print it again.

If you are printing from the Internet, then the printer may be reading
multiple job titles as duplicates and deleting all jobs except the first one.

For Windows users

a Open the Print Properties folder.

b From the Print and Hold dialog, select the “Keep duplicate documents”
check box.

c Enter a PIN number.

For Macintosh users

Save each print job, name each job differently, and then send the
individual jobs to the printer.

Does the job print?

The problem is solved. Go to step 3.

Step 3

Free up additional printer memory by deleting some of the held jobs.

Does the job print?

The problem is solved. Add additional printer
memory.
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Incorrect characters print

Action Yes No

Step 1

Make sure the printer is not in Hex Trace mode.

Note: If Ready Hex appears on the printer display, then turn off the
printer, and then turn it back on to deactivate Hex Trace mode.

Is the printer in Hex Trace mode?

Deactivate Hex Trace
mode.

Go to step 2.

Step 2

a From the printer control panel, select Standard Network or
Network [x], and then set SmartSwitch to On.

b Resend the print job.

Do incorrect characters print?

Contact customer
support.

The problem is solved.

Job prints from the wrong tray or on the wrong paper

Action Yes No

Step 1

a Check if you are printing on paper that is supported by the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 2.

Step 2

a From the Paper menu on the printer control panel, set the paper size
and type to match the paper loaded in the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 3.

Step 3

a Depending on your operating system, open Printing Preferences or
the Print dialog, and then specify the paper type.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Go to step 4.

Step 4

a Check if the trays are not linked.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is solved. Contact customer
support.

Troubleshooting 199

http://www.manualsbase.com


More user manuals on ManualsBase.com

Large jobs do not collate

Action Yes No

Step 1

a From the Finishing menu on the printer control panel, set Collate to
(1,2,3) (1,2,3).

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 2.

Step 2

a From the printer software, set Collate to (1,2,3) (1,2,3).

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides the
setting in the Finishing menu.

b Resend the print job.

Did the job print and collate correctly?

The problem is solved. Go to step 3.

Step 3

Reduce the complexity of the print job by eliminating the number and size
of fonts, the number and complexity of images, and the number of pages
in the job.

Did the job print and collate correctly?

The problem is solved. Contact customer
support.

Multiple‑language PDF files do not print

Action Yes No

Step 1

a Check if the print options for the PDF output are set to embed all fonts.

For more information, see the documentation that came with Adobe
Acrobat.

b Generate a new PDF file, and then resend the print job.

Do the files print?

The problem is solved. Go to step 2.

Step 2

a Open the document you want to print in Adobe Acrobat.

b Click File > Print > Advanced > Print As Image > OK > OK.

Do the files print?

The problem is solved. Contact customer
support.
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Print jobs do not print

Action Yes No

Step 1

a From the document you are trying to print, open the Print dialog and
check if you have selected the correct printer.

Note: If the printer is not the default printer, then you must select
the printer for each document that you want to print.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 2.

Step 2

a Check if the printer is plugged in and turned on, and if Ready appears
on the printer display.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 3.

Step 3

If an error message appears on the printer display, then clear the message.

Note: The printer continues to print after clearing the message.

Do the jobs print?

The problem is solved. Go to step 4.

Step 4

a Check if the ports (USB, serial, or Ethernet) are working and if the
cables are securely connected to the computer and the printer.

Note: For more information, see the setup documentation that
came with the printer.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 5.

Step 5

a Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

b Resend the print job.

Do the jobs print?

The problem is solved. Go to step 6.

Step 6

a Remove, and then reinstall the printer software. For more
information, see “Installing the printer software” on page 24.

Note: The printer software is available at
http://support.lexmark.com.

b Resend the print job.

Do the jobs print?

The problem is solved. Contact customer
support.
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Print job takes longer than expected

Action Yes No

Step 1

Change the environmental settings of the printer.

a From the printer control panel, navigate to:

Settings > General Settings

b Select Eco‑Mode or Quiet Mode, and then select Off.

Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.

Did the job print?

The problem is solved. Go to step 2.

Step 2

Reduce the number and size of fonts, the number and complexity of
images, and the number of pages in the print job, and then resend the job

Did the job print?

The problem is solved. Go to step 3.

Step 3

a Remove held jobs stored in the printer memory.

b Resend the print job.

Did the job print?

The problem is solved. Go to step 4.

Step 4

a Disable the Page Protect feature.

From the printer control panel, navigate to:

Settings > General Settings > Print Recovery > Page Protect > Off

b Resend the print job.

Did the job print?

The problem is solved. Go to step 5.

Step 5

a Check if the cable connections to the printer and print server are
secure. For more information, see the setup documentation that came
with the printer.

b Resend the print job.

Did the job print?

The problem is solved. Go to step 6.

Step 6

Install additional printer memory, and then resend the print job.

Did the job print?

The problem is solved. Contact customer
support.
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Repeating defects appear on prints

)

)

)

Action Yes No

Step 1

Measure the distance between the defects.
Check for a distance between the defects that equals:

• 25.1 mm (0.98 in.)

• 29.8 mm (1.17 in.)

• 43.9 mm (1.72 in.)

• 45.5 mm (1.79 in.)

• 94.2 mm (3.70 in.)

Is the distance between defects equal to one of the listed measurements?

Go to step 2. 1 Check if the
distance between
the defects is
equal to one of the
following:

• 37.7 mm
(1.48 in.)

• 78.5 mm
(3.09 in.)

• 95 mm
(3.74 in.)

2 Take note of the
distance, and then
contact customer
support or your
service
representative.

Step 2

Replace the imaging kit, and then resend the print job.

Do the repeating defects still appear?

Contact customer
support.

The problem is solved.

Tray linking does not work

Notes:

• The trays can detect paper length.

• The multipurpose feeder does not automatically detect the paper size. You must set the size from the Paper
Size/Type menu.
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Action Yes No

Step 1

a Open the trays, and then check if they contain paper of the same size
and type.

• Check if the paper guides are in the correct positions for the size
of the paper loaded in each tray.

• Check if the paper size indicators on the paper guides are aligned
with the paper size indicators on the tray.

b Resend the print job.

Do the trays link correctly?

The problem is solved. Go to step 2.

Step 2

a From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the trays to be linked.

Note: The paper size and type must match for trays to be linked.

b Resend the print job.

Do the trays link correctly?

The problem is solved. Contact customer
support.

Unexpected page breaks occur

Action Yes No

Step 1

Adjust the print timeout settings.

a From the printer control panel, navigate to:

Settings > General Settings > Timeouts > Print Timeout

b Select a higher setting and then, depending on your printer model,

select  or Submit.

c Resend the print job.

Did the file print correctly?

The problem is solved. Go to step 2.

Step 2

a Check the original file for manual page breaks.

b Resend the print job.

Did the file print correctly?

The problem is solved. Contact customer
support.
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Print quality problems

Characters have jagged or uneven edges

Action Yes No

Step 1

a Print a font sample list to check if the fonts you are using are supported
by the printer.

1 From the printer control panel, navigate to:

Menus > Reports > Print Fonts

2 Select PCL Fonts or PostScript Fonts.

b Resend the print job.

Are you using fonts that are supported by the printer?

Go to step 2. Select a font that is
supported by the
printer.

Step 2

Check if the fonts installed on the computer are supported by the printer.

Are the fonts installed on the computer supported by the printer?

The problem is solved. Contact customer
support.

Clipped pages or images

Leading edge

Trailing edge

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper loaded.

b Resend the print job.

Is the page or image clipped?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• From the printer
control panel,
change the paper
size to match the
paper loaded in the
tray.

• From the printer
control panel,
change the paper
type to match the
paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Is the page or image clipped?

Go to step 4. The problem is solved.

Step 4

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Is the page or image clipped?

Contact customer
support.

The problem is solved.

Gray background on prints

ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Troubleshooting 206

http://www.manualsbase.com


More user manuals on ManualsBase.com

Action Yes No

Step 1

Reduce the toner darkness.

a From the Quality menu on the printer control panel, reduce the toner
density.

Note: 4 is the factory default setting.

b Resend the print job.

Did the gray background disappear?

The problem is solved. Go to step 2.

Step 2

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Did the gray background disappear?

The problem is solved. Contact customer
support.

Horizontal voids appear on prints

Leading edge

Trailing edge

Action Yes No

Step 1

a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 2. The problem is solved.

Step 2

a Load the specified tray or feeder with a recommended type of paper.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 3. The problem is solved.
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Action Yes No

Step 3

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging kit, and then resend the print job.

Do horizontal voids appear on prints?

Contact customer
support.

The problem is solved.

Incorrect margins on prints

ABCD
ABCD
ABCD

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the paper size loaded.

b Resend the print job.

Are the margins correct?

The problem is solved. Go to step 2.

Step 2

From the printer control panel, set the paper size in the Paper menu to
match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.
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Action Yes No

Step 3

a Depending on your operating system, specify the paper size from
Printing Preferences or from the Print dialog.

b Resend the print job.

Are the margins correct?

The problem is solved. Contact customer
support.

Paper curl

Action Yes No

Step 1

Move the width and length guides in the tray to the correct positions for
the size of the paper loaded.

Are the width and length guides positioned correctly?

Go to step 2. Adjust the width and
length guides.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the paper in
the tray?

Go to step 3. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the paper still curled?

Go to step 4. The problem is solved.

Step 4

a Remove the paper from the tray, and then turn it over.

b Resend the print job.

Is the paper still curled?

Go to step 5. The problem is solved.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the paper still curled?

Contact customer
support.

The problem is solved.
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Print irregularities

) )ABCDE

ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded in the tray.

b Resend the print job.

Do print irregularities still appear?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper size and type in the Paper
menu to match the paper loaded in the tray.

Is the tray set to the size and type of the paper loaded in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
size from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do print irregularities still appear?

Go to step 4. The problem is solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray.

Go to step 5.

Step 5

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do print irregularities still appear?

Go to step 6. The problem is solved.
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Action Yes No

Step 6

Replace the imaging kit, and then resend the print job.

Do print irregularities still appear?

Contact customer
support.

The problem is solved.

Print is too dark

Action Yes No

Step 1

a From the Quality menu on the printer control panel, select Color
Adjust.

b Resend the print job.

Is the print still too dark?

Go to step 2. The problem is solved.

Step 2

a From the Quality menu on the printer control panel, reduce the toner
darkness.

Note: 4 is the factory default setting.

b Resend the print job.

Is the print still too dark?

Go to step 3. The problem is solved.

Step 3

a From the printer control panel, set the paper type, texture, and weight
in the Paper menu to match the paper loaded in the tray.

b Resend the print job.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 4. Change the paper
loaded in the tray to
match the paper type,
texture, and weight
specified in the tray
settings.

Step 4

a Depending on your operating system, specify the paper type, texture
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too dark?

Go to step 5. The problem is solved.

Troubleshooting 211

http://www.manualsbase.com


More user manuals on ManualsBase.com

Action Yes No

Step 5

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded on
the tray.

Go to step 6.

Step 6

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too dark?

Go to step 7. The problem is solved.

Step 7

Replace the imaging kit, and then resend the print job.

Is the print still too dark?

Contact customer
support.

The problem is solved.

Print is too light

Action Yes No

Step 1

a From the Quality menu on the printer control panel, select Color
Adjust.

b Resend the print job.

Is the print still too light?

Go to step 2. The problem is solved.

Step 2

a From the Quality menu on the printer control panel, increase the toner
darkness.

Note: 4 is the factory default setting.

b Resend the print job.

Is the print still too light?

Go to step 3. The problem is solved.
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Action Yes No

Step 3

From the printer control panel, set the paper type, texture, and weight in
the Paper menu to match the paper loaded in the tray.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 4. Specify the paper type,
texture, and weight
from the tray settings
to match the paper
loaded in the tray.

Step 4

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the print still too light?

Go to step 5. The problem is solved.

Step 5

Make sure that the paper has no texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in the
tray

Go to step 5.

Step 6

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Is the print still too light?

Go to step 7. The problem is solved.

Step 7

Replace the imaging kit, and then resend the print job.

Is the print still too light?

Contact customer
support.

The problem is solved.

Printer is printing blank pages
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Action Yes No

Step 1

a Check if there is packing material left on the imaging kit.

1 Remove the imaging kit.

2 Check if the packing material is properly removed from the imaging
kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to
light may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

3 Reinstall the imaging kit.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 2. The problem is solved.

Step 2

Replace the imaging kit, and then resend the print job.

Is the printer still printing blank pages?

Contact customer
support.

The problem is solved.

Printer is printing solid black pages

Action Yes No

Step 1

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Is the printer printing solid black pages?

Go to step 2. The problem is solved.

Step 2

Replace the imaging kit, and then resend the print job.

Is the printer printing solid black pages?

Contact customer
support.

The problem is solved.
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Shadow images appear on prints

ABCD
ABCD
ABCD
ABCD

Leading edge

Trailing edge

Action Yes No

Step 1

Check if the paper loaded in the tray has the correct paper type and weight.

Is paper with the correct paper type and weight loaded in the tray?

Go to step 2. Load paper with the
correct paper type and
weight in the tray.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the printer settings match the type and weight of the paper loaded?

Go to step 3. Change the paper type
and weight to match
the paper loaded in the
tray.

Step 3

a Depending on your operating system, specify the paper type and
weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do shadow images still appear on prints?

Go to step 4. The problem is solved.

Step 4

Replace the imaging kit, and then resend the print job.

Do shadow images still appear on prints?

Contact customer
support.

The problem is solved.

Skewed print

)
)ABCDE

ABCDEABCDE
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Action Yes No

Step 1

a Move the width and length guides in the tray to the correct positions
for the size of the paper loaded.

b Resend the print job.

Is the print still skewed?

Go to step 2. The problem is solved.

Step 2

a Check if you are printing on a paper that is supported by the tray.

b Resend the print job.

Is the print still skewed?

Contact customer
support.

The problem is solved.

Streaked horizontal lines appear on prints

ABCDE
ABCDE
ABCDE

Action Yes No

Step 1

a Depending on your operating system, specify the tray or feeder from
Printing Preferences or the Print dialog.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 2. The problem is solved.

Step 2

From the printer control panel, set the paper type and weight in the Paper
menu to match the paper loaded in the tray.

Do the paper type and weight match the paper in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
type and weight
from the tray
settings to match
the paper loaded in
the tray.

• Change the paper
loaded in the tray
to match the paper
type and weight
specified in the tray
settings.
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Action Yes No

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging kit, and then resend the print job.

Do streaked horizontal lines appear on prints?

Contact customer
support.

The problem is solved.

Streaked vertical lines appear on prints

ABCDE
ABCDE
ABCDE

Leading edge

Trailing edge

Action Yes No

Step 1

a Depending on your operating system, specify the paper type, texture,
and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 2. The problem is solved.
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Action Yes No

Step 2

From the printer control panel, set the paper texture, type, and weight in
the Paper menu to match the paper loaded in the tray.

Do the paper texture, type, and weight match the paper in the tray?

Go to step 3. Do one or more of the
following:

• Specify the paper
texture, type, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the paper
loaded in the tray
to match the paper
size specified in the
tray settings.

Step 3

a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store paper in
its original wrapper until you use it.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 4. The problem is solved.

Step 4

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging kit, and then resend the print job.

Do streaked vertical lines appear on prints?

Contact customer
support.

The problem is solved.

Toner fog or background shading appears on prints

ABCDE

ABCDE
ABCDE
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Action Yes No

Step 1

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Does fog or shading disappear from the prints?

The problem is solved. Go to step 2.

Step 2

Replace the imaging kit, and then resend the print job.

Does fog or shading disappear from the prints?

The problem is solved. Contact customer
support.

Toner rubs off

Leading edge

Trailing edge

ABC

DEF

Action Yes No

Step 1

From the Paper menu on the printer control panel, check the paper type
and weight.

Do the paper type and texture match the paper loaded in the tray?

Go to step 2. Specify the paper type
and weight from the
tray settings to match
the paper loaded in the
tray.

Step 2

Check if you are printing on paper with texture or rough finishes.

Are you printing on textured or rough paper?

From the Paper menu
on the printer control
panel, set the paper
texture.

Contact customer
support.
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Transparency print quality is poor

Action Yes No

Step 1

From the printer control panel, set the paper type in the Paper menu to
match the paper loaded in the tray.

Is the paper type for the tray set to Transparency?

Go to step 2. Set the paper type to
Transparency.

Step 2

a Check if you are using a recommended type of transparency.

b Resend the print job.

Is the print quality still poor?

Contact customer
support.

The problem is solved.

Uneven print density

Action Yes No

Replace the imaging kit, and then resend the print job.

Is the print density uneven?

Contact customer
support.

The problem is solved.

Vertical voids appear on prints

Leading edge

Trailing edge

Action Yes No

Step 1

a Check if your software program is using a correct fill pattern.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 2. The problem is solved.

Troubleshooting 220

http://www.manualsbase.com


More user manuals on ManualsBase.com

Action Yes No

Step 2

a From the Paper Menu on the printer control panel, check the paper
type and paper weight.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 3. The problem is solved.

Step 3

Check if you are using a recommended type of paper.

a Load paper source with a recommended type of paper.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 4. The problem is solved.

Step 4

a Remove, and then reinstall the imaging kit.

Warning—Potential Damage: Do not expose the imaging kit to
direct light for more than 10 minutes. Extended exposure to light
may cause print quality problems.

Warning—Potential Damage: Do not touch the underside of the
imaging kit. This could damage the imaging kit.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 5. The problem is solved.

Step 5

Replace the imaging kit, and then resend the print job.

Do vertical voids appear on prints?

Contact customer
support.

The problem is solved.

Color quality problems

FAQ about color printing

What is RGB color?

Red, green, and blue light can be added together in various amounts to produce a large range of colors observed in
nature. For example, red and green can be combined to create yellow. Televisions and computer monitors create
colors in this manner. RGB color is a method of describing colors by indicating the amount of red, green, or blue
needed to produce a certain color.

What is CMYK color?

Cyan, magenta, yellow, and black inks or toners can be printed in various amounts to produce a large range of colors
observed in nature. For example, cyan and yellow can be combined to create green. Printing presses, inkjet printers,
and color laser printers create colors in this manner. CMYK color is a method of describing colors by indicating the
amount of cyan, magenta, yellow, and black needed to reproduce a particular color.
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How is color specified in a document to be printed?

Software programs typically specify the document color using RGB or CMYK color combinations. Additionally, they
let users modify the color of each object in a document. For more information, see the help information of your
operating system.

How does the printer know what color to print?

When a user prints a document, information describing the type and color of each object is sent to the printer. The
color information is passed through color conversion tables that translate the color into the appropriate amounts of
cyan, magenta, yellow, and black toner needed to produce the color you want. The object information determines
the application of color conversion tables. For example, it is possible to apply one type of color conversion table to
text while applying a different color conversion table to photographic images.

What is manual color correction?

When manual color correction is enabled, the printer employs user‑selected color conversion tables to process
objects. However, Color Correction must be set to Manual, or no user‑defined color conversion will be implemented.
Manual color correction settings are specific to the type of object being printed (text, graphics, or images), and how
the color of the object is specified in the software program (RGB or CMYK combinations).

Notes:

• Manual color correction is not useful if the software program does not specify colors with RGB or CMYK
combinations. It is also not effective in situations in which the software program or the computer operating
system controls the adjustment of colors.

• When Auto Color Correction is selected, the color conversion tables will generate preferred colors used for
the majority of the documents.

To manually apply a different color conversion table, do the following:

1 From the Quality menu on the printer control panel, select Color Correction, and then select Manual.

2 From the Quality menu on the printer control panel, select Manual Color, and then select the appropriate color
conversion table for the affected object type.

Object type Color conversion tables

RGB Image

RGB Text

RGB Graphics

• Vivid—Produces brighter, more saturated colors and may be applied
to all incoming color formats.

• sRGB Display—Produces an output that approximates the colors
displayed on a computer monitor.

Note: Black toner usage is optimized for printing photographs.

• Display—True Black—Produces an output that approximates the
colors displayed on a computer monitor. This uses only black toner
to create all levels of neutral gray.

• sRGB Vivid—Provides an increased color saturation for the sRGB
Display color correction.

Note: Black toner usage is optimized for printing business graphics.

• Off—No color correction is implemented.
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Object type Color conversion tables

CMYK Image

CMYK Text

CMYK Graphics

• US CMYK—Applies color correction to approximate the SWOP
(Specifications for Web Offset Publishing) color output.

• Euro CMYK—Applies color correction to approximate Euroscale
color output.

• Vivid CMYK—Increases the color saturation of the US CMYK color
correction setting.

• Off—No color correction is implemented.

How can I match a particular color (such as a corporate logo)?

Nine types of Color Samples sets are available from the Quality menu on the printer control panel. These are also
available from the Color Samples page of the Embedded Web Server. Selecting any sample set generates a
multiple‑page printout consisting of hundreds of colored boxes. Either a CMYK or RGB combination is located on
each box, depending on the table selected. The observed color of each box is obtained by passing the CMYK or RGB
combination labeled on the box through the selected color conversion table.

By examining Color Samples sets, you can identify the box whose color is the closest to the color you want. The color
combination labeled on the box can then be used for modifying the color of the object in a software program. For
more information, see the help information of your operating system.

Note: Manual color correction may be necessary to utilize the selected color conversion table for the particular
object.

Selecting which Color Samples set to use for a particular color‑matching problem depends on the Color Correction
setting being used , the type of object being printed, and how the color of the object is specified in the software
program. When Color Correction is set to Off, the color is based on the print job information, and no color conversion
is implemented.

Note: The Color Samples pages are not useful if the software program does not specify colors with RGB or CMYK
combinations. Additionally, certain situations exist in which the software program or the computer operating
system adjusts the RGB or CMYK combinations specified in the program through color management. The resulting
printed color may not be an exact match of the Color Samples pages.

Prints on color transparencies appear dark when projected

Note: This problem occurs when projecting transparencies with reflective overhead projectors. To obtain the highest
projected color quality, transmissive overhead projectors are recommended.

Action Yes No

Step 1

From the printer control panel, make sure the paper type setting is set to
Transparency.

Is the paper type setting correct?

Go to step 2. Set the paper type to
Transparency.

Step 2

Reduce the toner darkness, and then resend the print job.

Does the print on the color transparency look lighter?

The problem is solved. Go to step 3.
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Action Yes No

Step 3

Make sure you are using a recommended type of color transparency, and
then resend the print job.

Does the print on the color transparency look lighter?

The problem is solved. Contact customer
support.

The color of the print does not match the color of the original file

Note: The color conversion tables used in Auto Color Correction mode generally approximate the colors of a
standard computer monitor. However, because of technology differences that exist between printers and monitors,
there are many colors that can also be affected by monitor variations and lighting conditions.

Action Yes No

Step 1

a Set Color Correction to Off.

Note: When the printer color correction is disabled, the color is
based on the print job information, and no color conversion is
implemented.

b Resend the print job.

Does the color of the print match the color of the file on the computer
screen?

The problem is solved. Go to step 2.

Step 2

From the Quality menu on the printer control panel, do the following:

a Select Color Correction, and then select Manual.

b Select Manual Color, and then select the appropriate color conversion
table for the affected object type.

c Resend the print job.

Does the color of the print match the color of the file on the computer
screen?

The problem is solved. Contact customer
support.

The print appears tinted

Action Yes No

Adjust the color balance.

a From the Color Balance menu on the printer control panel, increase
or decrease the values for cyan, magenta, yellow, and black.

b Resend the print job.

Does the print still appear tinted?

The problem is solved. Contact customer
support.

Solving copy problems
• “Copier does not respond” on page 225
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• “Scanner unit does not close” on page 225

• “Poor copy quality” on page 226

• “Partial document or photo copies” on page 227

Copier does not respond

Action Yes No

Step 1

Check if an error or status message appears on the display.

Does an error or status message appear?

Clear the error or status
message.

Go to step 2.

Step 2

Check if the power cord is plugged into the printer and a properly
grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 3. Connect the power
cord to the printer and
a properly grounded
electrical outlet.

Step 3

Turn off the printer, then wait for about 10 seconds, and then turn it back
on.

Did Performing Self Test and Ready appear?

The problem is solved. Contact customer
support.

Scanner unit does not close

Action Yes No

Check if there are no obstructions between the scanner unit and the
printer.

a Lift the scanner unit.

b Remove any obstruction that keeps the scanner unit open.

c Lower the scanner unit.

Did the scanner unit close properly?

The problem is solved. Contact customer
support.
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Poor copy quality

Action Yes No

Step 1

Check if an error or status message appears on the display.

Does an error or status message appear?

Clear the error or status
message.

Go to step 2.

Step 2

Check the quality of the original document.

Is the quality of the original document satisfactory?

Go to step 3. Increase the scan
resolution setting for a
higher‑quality output.

Step 3

If dark marks appear on prints, then clean the scanner glass and the ADF
glass using a clean, lint-free cloth dampened with water.

Is the scanner glass clean?

Go to step 4. See “Cleaning the
scanner glass” on
page 136.

Step 4

Send a print job, and then check for print quality problems.

a From the General Settings menu, adjust the Eco‑Mode settings.

b From the Copy menu, adjust the Darkness setting.

c If the print remains faded, then replace the toner cartridge.

Is the print quality satisfactory?

Go to step 5. See “Print quality
problems” on
page 205.

Step 5

Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.

Is the document or photo loaded correctly?

Go to step 6. Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Step 6

Check the copy settings.
From the Copy screen, check if the Content Type and Content Source
settings are correct for the document being scanned.

Are the Content Type and Content Source settings correct for the
document being scanned?

Go to step 7. Change the Content
Type and Content
Source settings to
match the document
being scanned.

Step 7

Check for patterns on print.

a From the printer control panel, navigate to:

Copy > Sharpness > select a lower setting

Note: Make sure no scaling is being selected.

b Resend the copy job.

Do patterns appear on prints?

Go to step 8. The problem is solved.
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Action Yes No

Step 8

Check for missing or faded text on prints.

a From the Copy screen, adjust the settings of the following:

• Sharpness—Increase the sharpness setting.

• Contrast—Increase the contrast setting.

b Resend the copy job.

Do prints have missing or faded text?

Go to step 9. The problem is solved.

Step 9

Check for washed‑out or overexposed output.

a From the Copy screen, adjust the settings of the following:

• Background Removal—Reduce the current setting.

• Darkness—Increase the current setting.

b Resend the copy job.

Do pages show washed‑out or overexposed prints?

Contact customer
support.

The problem is solved.

Partial document or photo copies

Action Yes No

Step 1

Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.

Is the document or photo loaded correctly?

Go to step 2. Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Step 2

Check if the paper size setting matches the size of the paper loaded in the
tray.

From the Paper menu on the printer control panel, check the Paper
Size setting.

Does the paper size setting match the size of the paper loaded in the tray.

Go to step 3. Change the paper size
setting to match the
paper loaded in the
tray, or load the tray
with paper that
matches the paper size
setting.

Step 3

a Specify the paper size. Depending on your operating system, specify
the paper size in Printing Preferences or the Print dialog.

b Resend the print job.

Do copies print properly?

The problem is solved. Contact customer
support.

Solving scanner problems
• “The scanner does not respond” on page 228
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• “Scan job was not successful” on page 229

• “Scanner unit does not close” on page 229

• “Scanning takes too long or freezes the computer” on page 230

• “Poor scanned image quality” on page 230

• “Partial document or photo scans” on page 231

• “Cannot scan from a computer” on page 231

The scanner does not respond

Action Yes No

Step 1

Check if the printer is turned on.

Is the printer turned on?

Go to step 2. Turn on the printer.

Step 2

Check if the printer cable is securely attached to the printer and the
computer, print server, option, or other network device.

Is the printer cable securely attached to the printer and the computer,
print server, option, or other network device?

Go to step 3. Connect the printer
cable securely to the
printer and the
computer, print server,
option, or other
network device.

Step 3

Check if the power cord is plugged into the printer and a properly
grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 4. Connect the power
cord to the printer and
a properly grounded
electrical outlet.

Step 4

Check if the electrical outlet is turned off by a switch or breaker.

Is the electrical outlet turned off by a switch or breaker?

Turn on the switch or
reset the breaker.

Go to step 5.

Step 5

Check if the printer is plugged into any surge protectors, uninterruptible
power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible power
supplies, or extension cords?

Connect the printer
power cord directly to
a properly grounded
electrical outlet.

Go to step 6.

Step 6

Check other electrical equipment plugged into the outlet.

Are the other electrical equipment working?

Unplug the other
electrical equipment
and turn on the printer.
If the printer does not
work, then reconnect
the other electrical
equipment and then go
to step 6.

Go to step 7.
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Action Yes No

Step 7

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Are the printer and scanner working?

The problem is solved. Contact customer
support.

Scan job was not successful

Action Yes No

Step 1

Check the cable connections.
Make sure the Ethernet or USB cable is securely connected to the
computer and the printer.

Are the cables securely connected?

Go to step 2. Connect the cables
properly.

Step 2

Check if the file name is already in use.

Is the file name already in use?

Change the file name. Go to step 3.

Step 3

Check if the document or photo you want to scan is open in another
application or being used by another user.

Is the file you want to scan open by another application or user?

Close the file you are
scanning.

Go to step 4.

Step 4

Check if either the Append time stamp or the Overwrite existing file check
box is selected in the destination configuration settings.

Is the Append time stamp or Overwrite existing file check box selected
in the destination configuration settings?

Contact customer
support.

Select the Append time
stamp or Overwrite
existing file check box
in the destination
configuration settings.

Scanner unit does not close

Action Yes No

Check if there are obstructions in the scanner unit.

a Lift the scanner unit.

b Remove any obstruction keeping the scanner unit open.

c Lower the scanner unit.

Did the scanner unit close correctly?

The problem is solved. Contact customer
support.
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Scanning takes too long or freezes the computer

Action Yes No

Step 1

Check if other applications are interfering with the scan.
Close all applications that are not being used.

Does scanning still take too long or freeze the computer?

Go to step 2. The problem is solved.

Step 2

Select a lower scan resolution.

Does scanning still take too long or freeze the computer?

Contact customer
support.

The problem is solved.

Poor scanned image quality

Action Yes No

Step 1

Check if an error message appears on the display.

Is there an error message on the printer display?

Clear the error
message.

Go to step 2.

Step 2

Check the quality of the original document.

Is the quality of the original document satisfactory?

Go to step 3. Increase the scan
resolution settings for a
higher‑quality output.

Step 3

Clean the scanner glass and the ADF glass using a clean, lint‑free cloth
dampened with water.

Is the scanner glass clean?

Go to step 4. See “Cleaning the
scanner glass” on
page 136.

Step 4

Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.

Is the document or photo loaded correctly?

Go to step 5. Place the document or
photo facedown on the
scanner glass in the
upper left corner.

Step 5

Send a print job, and then check for print quality problems.

• From the General Settings menu, adjust the Eco‑Mode settings.

• From the Copy menu, adjust the Darkness setting.

• When the print becomes faded, replace the toner cartridge.

Is the print quality satisfactory?

Go to step 6. See “Print quality
problems” on
page 205.
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Action Yes No

Step 6

Check the scan settings.
From the Scan screen, make sure the Content Type and Content Source
settings are correct for the document being scanned.

Are the Content Type and Content Source settings correct for the
document being scanned?

Go to step 7. Change the Content
Type and Content
Source settings to
match the document
being scanned.

Step 7

Increase the scan resolution settings for a higher‑quality output.

Did the increased resolution produce a higher‑quality output?

Problem solved. Contact customer
support.

Partial document or photo scans

Action Yes No

Check the placement of the document or photo.
Make sure the document or photo is loaded facedown on the scanner
glass in the upper left corner.

Is the document or photo loaded correctly?

Contact customer
support.

Load the document or
photo facedown on the
scanner glass in the
upper left corner.

Cannot scan from a computer

Action Yes No

Step 1

Make sure the printer is turned on and that Ready appears on the printer
display before scanning a job.

Does Ready appear before scanning the job?

Go to step 3. Go to step 2.

Step 2

Turn off the printer, then wait for about 10 seconds, and then turn the
printer back on.

Is there an error message on the printer display?

Clear the error
message.

Go to step 3.

Step 3

Check the cable connections between the printer and the print server to
make sure they are secure.

For more information, see the setup documentation that came with
the printer.

Are the cable connections between the printer and the print server
secure?

Contact customer
support.

Tighten the cable
connections.
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Embedded Web Server does not open
Action Yes No

Step 1

a Turn on the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 2.

Step 2

Make sure the printer IP address is correct.

a View the printer IP address:

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then
finding the TCP/IP section

Note: An IP address appears as four sets of numbers separated
by periods, such as 123.123.123.123.

b Open a Web browser, and then type the IP address.

Note: Depending on the network settings, you may need to type
“https://” instead of “http://” before the printer IP address
to access the Embedded Web Server.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 3.

Step 3

Check if the network is working.

a Print a network setup page.

b Check the first section of the network setup page and confirm that the
status is Connected.

Note: If the status is Not Connected, then the connection may be
intermittent, or the network cable may be defective. Contact your
system support person for a solution, and then print another
network setup page.

c Open a Web browser, and then type the printer IP address.

d Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 4.

Step 4

Check if the cable connections to the printer and print server are secure.

a Connect the cables properly. For more information, see the setup
documentation that came with the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is solved. Go to step 5.
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Action Yes No

Step 5

Temporarily disable the Web proxy servers.
Proxy servers may block or restrict you from accessing certain Web
sites including the Embedded Web Server.

Does the Embedded Web Server open?

The problem is solved. Contact your system
support person.

Contacting customer support
When you contact customer support, you will need to be able to describe the problem you are experiencing, the message
on the printer display, and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label at the back of the
printer. The serial number is also listed on the menu settings page.

Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:

Tech Library You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.

E-mail You can send an e-mail to the Lexmark team, describing your problem. A service representative will respond
and provide you with information to solve your problem.

Live chat You can chat directly with a service representative. They can work with you to solve your printer problem or
provide assistance through Assisted Service where the service representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit
http://support.lexmark.com.
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Notices

Product information

Product name:

Lexmark CX310n and CX310dn

Machine type:

7527

Model(s):

211, 231

Edition notice

June 2013

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

© 2013 Lexmark International, Inc.

All rights reserved.

GOVERNMENT END USERS

The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.

Notices 234

http://support.lexmark.com
http://www.lexmark.com
http://www.manualsbase.com


More user manuals on ManualsBase.com

Licensing notices

All licensing notices associated with this product can be viewed from the root directory of the installation software CD.

Trademarks

Lexmark, Lexmark with diamond design, MarkNet, and MarkVision are trademarks of Lexmark International, Inc.,
registered in the United States and/or other countries.

Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.

PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.

The following terms are trademarks or registered trademarks of these companies:

Albertus The Monotype Corporation plc

Antique Olive Monsieur Marcel OLIVE

Apple-Chancery Apple Computer, Inc.

Arial The Monotype Corporation plc

CG Times Based on Times New Roman under license from The Monotype Corporation plc, is a product of
Agfa Corporation

Chicago Apple Computer, Inc.

Clarendon Linotype-Hell AG and/or its subsidiaries

Eurostile Nebiolo

Geneva Apple Computer, Inc.

GillSans The Monotype Corporation plc

Helvetica Linotype-Hell AG and/or its subsidiaries

Hoefler Jonathan Hoefler Type Foundry

ITC Avant Garde Gothic International Typeface Corporation

ITC Bookman International Typeface Corporation

ITC Mona Lisa International Typeface Corporation

ITC Zapf Chancery International Typeface Corporation

Joanna The Monotype Corporation plc

Marigold Arthur Baker

Monaco Apple Computer, Inc.

New York Apple Computer, Inc.

Oxford Arthur Baker

Palatino Linotype-Hell AG and/or its subsidiaries

Stempel Garamond Linotype-Hell AG and/or its subsidiaries
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Taffy Agfa Corporation

Times New Roman The Monotype Corporation plc

Univers Linotype-Hell AG and/or its subsidiaries

All other trademarks are the property of their respective owners.

AirPrint and the AirPrint logo are trademarks of Apple, Inc.

Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

Note: Some modes may not apply to your product.

1-meter average sound pressure, dBA

Printing 50 dBA

Scanning 49 dBA

Copying 48 dBA

Ready 16 dBA

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products.

If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local
sales office phone number.

Product disposal

Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities
for disposal and recycling options.
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Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching the
metal frame of the printer.

ENERGY STAR

Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.

Temperature information

Ambient operating temperature 15.6 to 32.2°C (60 to 90°F)

Shipping temperature -40 to 43.3°C (-40 to 110°F)

Storage temperature and relative humidity 1 to 35°C (34 to 95°F)

8 to 80% RH

Laser notice

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class I
(1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label

A laser notice label may be affixed to this printer as shown:
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DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.

PERIGO - Radiação a laser invisível será liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposição aos feixes de laser.

Opasnost - Nevidljivo lasersko zračenje kada su kasete uklonjene i poništena sigurnosna veza. Izbjegavati izlaganje zracima.

NEBEZPEČÍ - Když jsou vyjmuty kazety a je odblokována pojistka, ze zařízení je vysíláno neviditelné laserové záření. Nevystavujte se působení laserového paprsku.

FARE - Usynlig laserstråling, når patroner fjernes, og spærreanordningen er slået fra. Undgå at blive udsat for laserstrålen.

GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.

DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.

VAARA - Näkymätöntä lasersäteilyä on varottava, kun värikasetit on poistettu ja lukitus on auki. Vältä lasersäteelle altistumista.

GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.

ΚΙΝΔΥΝΟΣ - Έκλυση αόρατης ακτινοβολίας laser κατά την αφαίρεση των κασετών και την απασφάλιση της μανδάλωσης. Αποφεύγετε την έκθεση στην ακτινοβολία laser.

VESZÉLY – Nem látható lézersugárzás fordulhat elő a patronok eltávolításakor és a zárószerkezet felbontásakor. Kerülje a lézersugárnak való kitettséget.

PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare l´esposizione al raggio laser.

FARE – Usynlig laserstråling når kassettene tas ut og sperren er satt ut av spill. Unngå eksponering for laserstrålen.

NIEBEZPIECZEŃSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Należy unikać naświetlenia promieniem lasera.

ОПАСНО! Невидимое лазерное излучение при извлеченных картриджах и снятии блокировки. Избегайте воздействия лазерных лучей.

Pozor – Nebezpečenstvo neviditeľného laserového žiarenia pri odobratých kazetách a odblokovanej poistke. Nevystavujte sa lúčom.

PELIGRO: Se producen radiaciones láser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposición al haz de láser.

FARA – Osynlig laserstrålning när patroner tas ur och spärrmekanismen är upphävd. Undvik exponering för laserstrålen.

危险 - 当移除碳粉盒及互锁失效时会产生看不见的激光辐射，请避免暴露在激光光束下。

危險 - 移除碳粉匣與安全連續開關失效時會產生看不見的雷射輻射。請避免曝露在雷射光束下。

危険 - カートリッジが取り外され、内部ロックが無効になると、見えないレーザー光が放射されます。 このレーザー光に当たらないようにしてください。

Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption
(Watts)

Printing The product is generating hard‑copy output from electronic inputs. 500

Copy The product is generating hard‑copy output from hard‑copy original documents. 540

Scan The product is scanning hard‑copy documents. 40

Ready The product is waiting for a print job. 30

Sleep Mode The product is in a high‑level energy‑saving mode. 5

Hibernate The product is in a low‑level energy‑saving mode. 0.5

Off The product is plugged into an electrical outlet, but the power switch is turned off. 0

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.
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Sleep Mode

This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by lowering
power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged after this product
is not used for a specified period of time, called the Sleep Mode Timeout.

Factory default Sleep Mode Timeout for this product (in minutes): 30

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 120 minutes. Setting
the Sleep Mode Timeout to a low value reduces energy consumption, but may increase the response time of the product.
Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more energy.

Hibernate Mode

This product is designed with an ultra‑low power operating mode called Hibernate mode. When operating in Hibernate
Mode, all other systems and devices are powered down safely.

The Hibernate mode can be entered in any of the following methods:

• Using the Hibernate Timeout

• Using the Schedule Power modes

• Using the Sleep/Hibernate button

Factory default Hibernate Timeout for this product in all countries or regions except for EU countries and Switzerland N/A

Factory default value for this product in EU countries or regions and Switzerland 3 days

The amount of time the printer waits after a job is printed before it enters Hibernate mode can be modified between
one hour and one month.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

Regulatory notices for electromagnetic compatibility

This section contains regulatory information pertaining to electromagnetic compatibility.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

Notices 239

http://www.manualsbase.com


More user manuals on ManualsBase.com

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and,
if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.

Avis de conformité aux normes de l’industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

日本の VCCI 規定

製品にこのマークが表示されている場合、次の要件を満たしています。

この装置は、クラス B 情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この
装置がラジオやテレビジョン受信機に近接して使用されると、受信障害を引き起こすことがあります。

取扱説明書に従って正しい取り扱いをしてください。

VCCI-B
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European Community (EC) directives conformity

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2009/125/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energy-
related products.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Regulatory notices for wireless products

This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Modular component notice

This product may contain the following modular component(s):

Lexmark Regulatory Type/Model LEX-M04-005, FCC ID: IYLLEXM01005; IC:2376A-M01005

Exposure to radio frequency radiation

The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.
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Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Notice to users in the European Union

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC,
1999/5/EC, and 2009/125/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits, radio
equipment and telecommunications terminal equipment and on the ecodesign of energy-related products.

Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, 1999/5/EC, and 2009/125/EC on the approximation and harmonization of the
laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use
within certain voltage limits and on radio equipment and telecommunications terminal equipment and on the ecodesign
of energy-related products.

Compliance is indicated by the CE marking.
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Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.

This product may be used in the countries indicated in the table below.

AT BE BG CH CY CZ DE DK EE

EL ES FI FR HR HU IE IS IT

LI LT LU LV MT NL NO PL PT

RO SE SI SK TR UK

Česky Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.
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Malti Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.

Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.

Svenska Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,

LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the country-
specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts

—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).

If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.

If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.
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Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.

To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.

As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest
version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.

Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance

—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF

Notices 245

http://www.manualsbase.com


More user manuals on ManualsBase.com

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

DEVICE PATENT LICENSE

Lexmark reserves the right to discontinue selling these toner cartridges any time after it discontinues service support
for this printer.

IMPORTANT: PLEASE READ BEFORE OPENING: Opening this package, installing the printing device software, or using
the products inside confirms your acceptance of the following licenses/agreements:

License: The patented printer inside is licensed for, and designed to work with only genuine Lexmark toner cartridges
and developer components for the life of the patented printer. You agree to: (1) use only genuine Lexmark toner
cartridges and developer components with this printer except as otherwise provided below, and (2) pass this
license/agreement to any subsequent user of this printer. The patented Lexmark toner cartridges and developer
components inside are licensed subject to a restriction that they may be used only once. Following their initial use, you
agree to return them only to Lexmark for recycling. Lexmark toner cartridges are designed to stop working after
delivering a fixed amount of toner. A variable amount of toner may remain in them when replacement is required. If
you do not accept these terms, return the unopened package to your point of purchase. Replacement toner
cartridge(s) sold without these terms are available through www.lexmark.com, may be refilled by you, or a third party,
as the only cartridge alternative to be used with the licensed printer.

Notices 246

http://www.manualsbase.com


More user manuals on ManualsBase.com

Patent acknowledgment

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.

The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.

The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.
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Index
Numerics
250‑sheet tray 

loading  33
650‑sheet duo tray 

installing  22
loading  33, 37

Symbols
[Color] cartridge low [88.xy]  180
[Color] cartridge nearly low
[88.xy]  180
[Color] cartridge very low, [x]
estimated pages remain
[88.xy]  180
[Type] imaging kit low [84.xy]  191
[Type] imaging kit nearly low
[84.xy]  191
[Type] imaging kit very low, [x]
estimated pages remain
[84.xy]  191
[x]-page jam, open front door
[20y.xx]  172
[x]-page jam, open front door to
clear fuser [202.xx]  169
[x]‑page jam, clear manual feeder
[251.xx]  175
[x]‑page jam, clear multipurpose
feeder [250.xx]  176
[x]‑page jam, clear standard bin
[203.xx]  166
[x]‑page jam, open automatic
feeder top cover. [28y.xx]  177
[x]‑page jam, open front door to
clear duplex [23y.xx]  173
[x]‑page jam, open tray [x]
[24y.xx]  174

A
Active NIC menu  90
ADF 

copying using  60
Adjusting color  179
adjusting Sleep mode  129
adjusting toner darkness  54
administrator settings 

Embedded Web Server  160
AppleTalk menu  95

arrow buttons 
printer control panel  13

attaching cables  23
available internal options  15
avoiding jams  49
avoiding paper jams  163

B
back button 

printer control panel  13
black‑and‑white printing  54
buttons, printer control panel  13

C
cables 

Ethernet  23
USB  23

cancel button 
printer control panel  13

canceling 
print job, from computer  58

canceling a copy job from the
printer control panel  68
canceling a print job 

from a computer  58
from the printer control panel  58

canceling an e-mail  73
cannot open Embedded Web
Server  232
card stock 

loading  38
tips  47

Change [paper source] to [custom
string]  179
Change [paper source] to [custom
type name]  179
Change [paper source] to [paper
type] [paper size]  179
checking an unresponsive
printer  192
checking status of parts and
supplies  137
checking the status of parts and
supplies  137
checking the virtual display 

using the Embedded Web
Server  160

cleaning 
exterior of the printer  135
interior of the printer  135
scanner glass  136

cleaning the printer  135
Close door  179
Close flatbed cover and load
originals if restarting job
[2yy.xx]  180
collate 

copy options  69
collating copies  66
color quality troubleshooting 

color of print and color on
computer screen do not
match  224

prints on color transparencies
appear dark when projected  223

color quality, troubleshooting 
print appears tinted  224

Complex page, some data may not
have printed [39]  180
confidential data 

information on securing  134
confidential jobs 

modifying print settings  57
confidential print jobs  56

printing from a Macintosh
computer  56

printing from Windows  56
Confidential Print menu  98
Configuration change, some held
jobs were not restored [57]  181
configuration information 

wireless network  28
configurations 

printer  10
configuring 

multiple printers  162
supply notifications, imaging

kit  161
supply notifications, maintenance

kit  161
supply notifications, toner

cartridge  161
supply notifications, waste toner

bottle  161
configuring e‑mail settings  71
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configuring supply notifications
from the Embedded Web
Server  161
configuring the Universal paper size
settings  33
connecting to a wireless network 

using PBC, Push Button
Configuration method  30

using PIN, Personal Identification
Number method  30

using the Embedded Web
Server  31

using wireless setup wizard  29
conservation settings 

Eco‑Mode  128
Hibernate mode  130
Hibernate Timeout  130
Quiet mode  128
Schedule Power Modes  131
Sleep mode  129

conserving supplies  127
contacting customer support  233
control panel, printer 

indicator light  13
Sleep button light  13

controller board 
accessing  16

copies 
copy options  68

copy from 
copy options  68

copy job 
canceling  68

copy options 
collate  69
copies  68
copy from  68
copy to  69
darkness  69
overlay  70
paper saver  70
scale  69
separator sheets  70

copy quality 
adjusting  65

copy screen 
content source  69
content type  69
options  70

Copy Settings menu  104
copy to 

copy options  69

copy troubleshooting 
copier does not respond  225
partial document or photo

copies  227
poor copy quality  226
poor scanned image quality  230
scanner unit does not

close  225, 229
copying 

adding an overlay message  67
adjusting quality  65
canceling a copy job from the

printer control panel  68
collating copies  66
enlarging  64
making a copy lighter or darker  64
multiple pages on one sheet  67
on letterhead  62
on transparencies  61
photos  61
placing separator sheets between

copies  66
quick copy  60
reducing  64
selecting a tray  63
to a different size  63
using the ADF  60
using the scanner glass  61

creating an FTP shortcut 
using the Embedded Web

Server  74
custom paper type 

assigning  43
custom paper type name 

creating  42
custom paper type names 

assigning  42
Custom Scan Sizes menu  88
Custom Type [x] 

assigning a paper type  43
Custom Type [x] name 

creating  42
Custom Types menu  88
customer support 

contacting  233

D
darkness 

copy options  69
Default Source menu  80
Defective flash detected [51]  181

developer unit 
replacing  143, 152

device and network settings 
erasing  134

display troubleshooting 
printer display is blank  194

display, printer control panel  13
documents, printing 

from Macintosh  54
from Windows  54

E
Eco‑Mode 

using  128
embedded solutions 

erasing  134
Embedded Web Server  161

administrator settings  160
checking the status of parts  137
checking the status of

supplies  137
copying settings to other

printers  162
creating an FTP shortcut  74
creating e‑mail shortcuts  72
modifying confidential print

settings  57
networking settings  160
problem accessing  232
setting up e‑mail alerts  160

Embedded Web Server — Security:
Administrator's Guide 

where to find  160
Embedded Web Server — Security:
Administrator’s Guide 

where to find  134
emission
notices  236, 239, 240, 241, 242
enlarging a copy  64
envelopes 

loading  36, 38
tips on using  46

environmental settings  127
Eco‑Mode  128
Hibernate mode  130
Hibernate Timeout  130
Quiet mode  128
Schedule Power Modes  131
Sleep mode  129

erasing non‑volatile memory  134
erasing volatile memory  134
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Error reading USB drive. Remove
USB.  181
Error reading USB hub. Remove
hub.  181
Ethernet network 

preparing to set up for Ethernet
printing  26

Ethernet network setup 
using Macintosh  27
using Windows  27

Ethernet networking 
Macintosh  27
Windows  27

Ethernet port  23
Ethernet setup 

preparing for an  26
exterior of the printer 

cleaning  135
e‑mail 

canceling  73
e‑mail alerts 

low supply levels  160
paper jam  160
setting up  160

e‑mail function 
setting up  71

E‑mail Settings menu  108
e‑mail shortcuts, creating 

using the Embedded Web
Server  72

e‑mail, sending 
using a shortcut number  72
using the printer control panel  72

e‑mailing 
configuring e‑mail settings  71
creating shortcuts using the

Embedded Web Server  72
setting up e‑mail function  71
using a shortcut number  72
using the printer control panel  72

F
factory defaults, restoring  162
FAQ about color printing  221
FCC notices  239, 241
finding more information about the
printer  8
Finishing menu  116
firmware cards  15
font sample list 

printing  58
fonts card  15

FTP address, scanning to 
using a shortcut  75

FTP Settings menu  112

G
General Settings menu  100
green settings 

Eco‑Mode  128
Hibernate mode  130
Hibernate Timeout  130
Quiet mode  128
Schedule Power Modes  131

H
held jobs  56

printing from a Macintosh
computer  56

printing from Windows  56
Help menu  126
Hibernate mode 

using  130
Hibernate Timeout 

setting  130
home button 

printer control panel  13
HTML menu  124

I
Image menu  125
imaging kit 

replacing  143
imaging kits 

ordering  139
Incompatible tray [x] [59]  181
Incorrect paper size, open [paper
source] [34]  181
indicator light 

printer control panel  13
individual settings 

erasing  134
Insert Tray [x]  182
installing an optional card  20
installing options 

order of installation  21
installing printer on a network 

Ethernet networking  27
installing printer software 

adding options  25
installing printer software
(Windows)  24

Insufficient memory for Flash
Memory Defragment operation
[37]  182
Insufficient memory to collate job
[37]  182
Insufficient memory to support
Resource Save feature [35]  182
Insufficient memory, some Held
Jobs were deleted [37]  182
Insufficient memory, some held
jobs will not be restored [37]  182
interior of the printer 

cleaning  135
internal options  15
IPv6 menu  93

J
jams 

avoiding  163
locating doors and trays  164
locations  164
messages  164

jams, clearing 
in automatic document feeder top

cover  177
in fuser area  169
in manual feeder  175
in multipurpose feeder  176
in standard bin  166
Tray 1  174
Tray 2  174

K
keypad 

printer control panel  13

L
labels, paper 

tips  46
letterhead 

copying on  62
loading, multipurpose feeder  44
loading, trays  44

linking trays  41
assigning custom paper type

names  42
Load [paper source] with [custom
string]  183
Load [paper source] with [custom
type name]  183
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Load [paper source] with [paper
size]  183
Load [paper source] with [paper
type] [paper size]  183
Load Manual Feeder with [custom
string]  184
Load Manual Feeder with [custom
type name]  184
Load Manual Feeder with [paper
size]  184
Load Manual Feeder with [paper
type] [paper size]  184
loading 

250‑sheet tray  33
650‑sheet duo tray  33, 37
card stock  38
envelopes  36, 38
manual feeder  36
multipurpose feeder  38
transparencies  38

loading letterhead 
paper orientation  44

lock, security  133

M
maintenance kit 

ordering  139
Maintenance kit low [80.xy]  184
Maintenance kit nearly low
[80.xy]  184
Maintenance kit very low, [x]
estimated pages remain
[80.xy]  185
manual feeder 

loading  36
Max Speed and Max Yield 

using  55
memory 

types installed on printer  133
memory card  15

installing  18
Memory full [38]  185
menu settings 

loading on multiple printers  162
menu settings page 

printing  31
menus 

Active NIC  90
AppleTalk  95
Confidential Print  98
Copy Settings  104
Custom Scan Sizes  88

Custom Types  88
Default Source  80
E‑mail Settings  108
Finishing  116
FTP Settings  112
General Settings  100
Help  126
HTML  124
Image  125
IPv6  93
list of  78
Network [x]  90
Network Card  92
Network Reports  91
Paper Loading  86
Paper Size/Type  80
Paper Texture  83
Paper Weight  85
PCL Emul  122
PDF  121
PostScript  121
Quality  118
Reports  89
Security Audit Log  98
Set Date and Time  99
Setup  115
SMTP Setup menu  97
Standard Network  90
Standard USB  95
Substitute Size  83
Supplies  79
TCP/IP  92
Universal Setup  88
Utilities  121
Wireless  94
XPS  121

menus list  78
mobile device 

printing from  55
moving the printer  9, 158
multiple pages on one sheet  67
multipurpose feeder 

loading  38

N
Network [x] menu  90
Network [x] software error
[54]  185
Network Card menu  92
Network Reports menu  91
network settings 

Embedded Web Server  160

network setup page 
printing  32

Networking Guide 
where to find  160

noise emission levels  236
noise, printer 

reducing  128
Non-Lexmark [color] [supply type],
see User's Guide [33.xy]  185
non‑volatile memory  133

erasing  134
Not enough free space in flash
memory for resources [52]  185
notices  235, 236, 237, 238, 239, 
240, 241, 242, 243
number of remaining pages 

estimate  137

O
optional card 

installing  20
options 

650‑sheet duo tray  22
firmware cards  15
fonts card  15
memory card  15, 18
updating in printer driver  25

options, touch‑screen 
copy  70

ordering 
imaging kits  139
maintenance kit  139
toner cartridges  138
waste toner bottle  139

overlay 
copy options  70

overlay message, adding 
copying  67

P
paper 

characteristics  47
letterhead  49
preprinted forms  49
recycled  49, 127
selecting  48
setting size  33
setting type  33
storing  49
unacceptable  48
Universal size setting  33
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paper feed troubleshooting 
message remains after jam is

cleared  197
paper jams 

avoiding  163
paper jams, clearing 

[x]-page jam, open front door
[20y.xx]  172

[x]-page jam, open front door to
clear fuser [202.xx]  169

[x]‑page jam, open front door to
clear duplex [23y.xx]  173

in automatic document feeder top
cover  177

in fuser area  169
in manual feeder  175
in multipurpose feeder  176
in standard bin  166
Tray 1  174
Tray 2  174

Paper Loading menu  86
paper saver 

copy options  70
Paper Size/Type menu  80
paper sizes 

supported by the printer  50
Paper Texture menu  83
paper types 

supported by printer  52
where to load  52

Paper Weight menu  85
paper weights 

supported by printer  52
parts 

checking status  137
checking, using the Embedded

Web Server  137
using genuine Lexmark  138

parts and supplies, status of 
checking, on printer control

panel  137
PCL Emul menu  122
PDF menu  121
Personal Identification Number
method 

using  30
photos 

copying  61
placing separator sheets between
copies  66
PostScript menu  121
power cord socket  23

preparing to set up the printer on
an Ethernet network  26
print irregularities  210
print job 

canceling from the printer control
panel  58

canceling, from computer  58
print quality 

cleaning the scanner glass  136
replacing a developer unit  152
replacing imaging kit  143
replacing the waste toner

bottle  140
print quality troubleshooting 

blank pages  213
characters have jagged edges  205
clipped pages or images  205
gray background on prints  206
horizontal voids appear on

prints  207
print irregularities  210
print is too dark  211
print is too light  212
printer is printing solid black

pages  214
repeating print defects  203
shadow images appear on

prints  215
skewed print  215
streaked horizontal lines appear

on prints  216
streaked vertical lines appear on

prints  217
toner fog or background shading

appears on prints  218
toner rubs off  219
transparency print quality is

poor  220
uneven print density  220
vertical voids appear on

prints  220
print troubleshooting 

held jobs do not print  198
incorrect characters print  199
incorrect margins on prints  208
jammed pages are not

reprinted  196
job prints from wrong tray  199
job prints on wrong paper  199
jobs do not print  201
Large jobs do not collate  200

multiple‑language PDF files do not
print  200

paper curl  209
paper frequently jams  196
print job takes longer than

expected  202
tray linking does not work  203
unexpected page breaks

occur  204
printer 

configurations  10
minimum clearances  9
models  10
moving  9, 158
selecting a location  9
shipping  159

printer control panel 
factory defaults, restoring  162
indicator light  13
parts  13
Sleep button light  13
using  13

printer control panel, virtual
display 

using the Embedded Web
Server  160

printer information 
where to find  8

printer is printing blank pages  213
printer messages 

[Color] cartridge low [88.xy]  180
[Color] cartridge nearly low

[88.xy]  180
[Color] cartridge very low, [x]

estimated pages remain
[88.xy]  180

[Type] imaging kit low [84.xy]  191
[Type] imaging kit nearly low

[84.xy]  191
[Type] imaging kit very low, [x]

estimated pages remain
[84.xy]  191

[x]‑page jam, clear manual feeder
[251.xx]  175

[x]‑page jam, clear multipurpose
feeder [250.xx]  176

[x]‑page jam, clear standard bin
[203.xx]  166

[x]‑page jam, open automatic
feeder top cover. [28y.xx]  177

[x]‑page jam, open tray [x]
[24y.xx]  174
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Adjusting color  179
Change [paper source] to [custom

string]  179
Change [paper source] to [custom

type name]  179
Change [paper source] to [paper

type] [paper size]  179
Close door  179
Close flatbed cover and load

originals if restarting job
[2yy.xx]  180

Complex page, some data may not
have printed [39]  180

Configuration change, some held
jobs were not restored [57]  181

Defective flash detected [51]  181
Error reading USB drive. Remove

USB.  181
Error reading USB hub. Remove

hub.  181
Incompatible tray [x] [59]  181
Incorrect paper size, open [paper

source] [34]  181
Insert Tray [x]  182
Insufficient memory for Flash

Memory Defragment operation
[37]  182

Insufficient memory to collate job
[37]  182

Insufficient memory to support
Resource Save feature [35]  182

Insufficient memory, some Held
Jobs were deleted [37]  182

Insufficient memory, some held
jobs will not be restored
[37]  182

Load [paper source] with [custom
string]  183

Load [paper source] with [custom
type name]  183

Load [paper source] with [paper
size]  183

Load [paper source] with [paper
type] [paper size]  183

Load Manual Feeder with [custom
string]  184

Load Manual Feeder with [custom
type name]  184

Load Manual Feeder with [paper
size]  184

Load Manual Feeder with [paper
type] [paper size]  184

Maintenance kit low [80.xy]  184
Maintenance kit nearly low

[80.xy]  184
Maintenance kit very low, [x]

estimated pages remain
[80.xy]  185

Memory full [38]  185
Network [x] software error

[54]  185
Non-Lexmark [color] [supply type],

see User's Guide [33.xy]  185
Not enough free space in flash

memory for resources [52]  185
Reinstall missing or unresponsive

[color] cartridge [31.xy]  186
Reload printed pages in Tray

[x]  186
Remove packaging material, [area

name]  186
Remove paper from standard

output bin  187
Replace [color] cartridge, 0

estimated pages remain
[88.xy]  187

Replace [color] cartridge, printer
region mismatch [42.xy]  187

Replace [type] imaging kit, 0
estimated pages remain
[84.xy]  187

Replace all originals if restarting
job.  187

Replace defective [type] imaging
kit [31.xy]  188

Replace jammed originals if
restarting job.  188

Replace maintenance kit, 0
estimated pages remain
[80.xy]  188

Replace missing [type] imaging kit
[31.xy]  188

Replace missing or unresponsive
[type] imaging kit [31.xy]  186

Replace missing waste toner
bottle [82.xy]  189

Replace unsupported [color]
cartridge [32.xy]  189

Replace unsupported [type]
imaging kit [32.xy]  189

Replace waste toner bottle
[82.xy]  189

Scanner automatic feeder cover
open  189

Scanner disabled by admin
[840.01]  189

Scanner disabled. Contact system
administrator if problem persists.
[840.02]  189

Scanner jam, remove all originals
from the scanner [2yy.xx]  189

Scanner jam, remove jammed
originals from the scanner
[2yy.xx]  190

SMTP server not set up. Contact
system administrator.  190

Standard network software error
[54]  190

Standard USB port disabled
[56]  190

Supply needed to complete
job  190

Too many flash options installed
[58]  190

Too many trays attached [58]  191
Unformatted flash detected

[53]  191
Unsupported USB hub, please

remove  181
Waste toner bottle nearly full

[82.xy]  192
Weblink server not set up. Contact

system administrator.  192
printer options troubleshooting 

internal option is not
detected  194

tray problems  195
printer problems, solving basic  192
printer security 

information on  134
printer software, installing
(Windows)  24
printing 

black‑and‑white  54
faster speed vs. higher yield  55
font sample list  58
from a mobile device  55
from Macintosh  54
from Windows  54
Max Speed and Max Yield  55
menu settings page  31
network setup page  32

printing a document  54
printing a network setup page  32
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printing confidential and other held
jobs 

from a Macintosh computer  56
from Windows  56

printing from a mobile device  55
printing in black and white  54
publications 
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